Dear Customer,

Thank you for purchasing MassARRAY Typer from SEQUENOM®. This software was created specifically for use with the MassARRAY™ system and has been quality control tested to provide the most state-of-the-art algorithms to assist you in your research efforts.

Please use this manual as a guide to assist you in mastering the features and tools of this software package. If for any reason you need assistance in using the features of the software or your MassARRAY system, please contact your SEQUENOM Customer Support Scientist by phone or email.

Your institution's use of this software is governed by a Terms of Use clause. Please refer to this clause on page 171 of this manual to understand your institution's rights and responsibilities.

At SEQUENOM, we are continually focused on developing the best products to increase the research success of our family of customers.

SEQUENOM, Inc.
San Diego, California

"SEQUENOM's mission is to be the leading provider of genomic systems and knowledge for personalized medicine and the life science industry."

Copyright 2002. All rights reserved. No part of this publication may be reproduced, distributed, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, or stored in a database or retrieval system, for any reason other than a licensee’s internal use without the prior written permission of SEQUENOM.

Printed in the United States of America.
TRADEMARKS
SEQUENOM and SpectroCHIP are registered trademarks of SEQUENOM, Inc.
MassARRAY, MassARRAY 20K, MassARRAY 200K, RealSNP, RealSNP.com, SNPCredits, and MassEXTEND are trademarks of SEQUENOM, Inc.
Autoflex is a registered trademark of Bruker.
MS DOS, Windows, and Microsoft are registered trademarks of Microsoft Corporation.
UNIX is a registered trademark of UNIX System Laboratories.
This page is intentionally blank.
## Contents

### Chapter 1
**Introduction**
- MassARRAY System .................................................. 1
- System Administrator ................................................. 2
- Procedure Overview .................................................. 3

### Chapter 2
**Getting Started**
- Starting Typer .......................................................... 5
  - To start Typer ....................................................... 5
  - To start a module .................................................. 5
  - To quit Typer ......................................................... 5
- Connect to the Database .............................................. 6
  - To connect to the database ....................................... 6
- The Basics ............................................................ 6
  - To Do Steps .......................................................... 6
- Menu Bar ............................................................... 6
  - Menu Items .......................................................... 7
  - Keyboard Access Keys ............................................ 7
  - To print using access keys ....................................... 7
  - To open a plate ..................................................... 7
  - Keyboard Keys ....................................................... 8
  - To select a control with the keyboard ......................... 8
- Toolbar Buttons ...................................................... 8
  - To print .............................................................. 8
- Tabs ........................................................................ 8
  - To select a tab ....................................................... 8
- Message Bar ............................................................ 9
- Tree Control ............................................................ 9

### Chapter 3
**Defining Assays**
- Introduction ........................................................... 11
  - Uniplex and Multiplex .............................................. 11
  - Assay Database Hierarchy ........................................ 11
- AssayEditor Basics ................................................... 12
  - Opening AssayEditor ............................................... 12
    - To open the AssayEditor window .......................... 12
  - Exiting AssayEditor ............................................... 12
    - To exit AssayEditor ........................................... 12
- Navigating AssayEditor ............................................. 13
  - The Navigation Tree .............................................. 13
  - Assay Group tab .................................................... 13
  - To view items on the Assay Group tab ....................... 13
  - To rename items on the Assay Group tab .................... 13
The Work Window ......................................................... 14
Details tab .............................................................. 14
Edit Assay tab .......................................................... 14
Edit Group tab .......................................................... 14

Importing Assays ......................................................... 14
To import assays ......................................................... 14

Searching for Assays ..................................................... 15
To search for assays ..................................................... 15

Creating and Editing Assays ............................................... 16
Creating Assays .......................................................... 16
To create a new assay .................................................. 16
To edit description text ................................................ 17
Editing Assays ........................................................... 17
To edit assays ........................................................... 17
Adding Items to the Expected Peaks Grid .............................. 18
To add probe, sequence, and sequence mass .......................... 18
To add analytes ......................................................... 18
To add contaminants ................................................... 19
Copying and Pasting Items in the Expected Peaks Grid ............. 19
Deleting Items from the Expected Peaks Grid ......................... 19
Adding Genotype Calls .................................................. 19
To specify homozygous calls .......................................... 19
To specify heterozygous calls ......................................... 19
Viewing Grid Colors ..................................................... 20
To turn off visual aid colors ............................................ 20
Copying Assays ........................................................... 20
Copying Assays for Editing ............................................. 20
To edit assays associated with a design .............................. 20
Deleting Assays .......................................................... 21
To delete an assay ....................................................... 21
To view design summary ................................................. 21

Editing Assay Groups .................................................... 21
To edit a group ........................................................ 21
Plexes with Numeric Names ............................................. 23
To reassign numeric plex names ...................................... 23

Managing Assay Projects ................................................ 23
Adding Assay Projects ................................................ 23
To add assay projects ................................................ 23
Emptying and Deleting Assay Projects ................................ 24
To empty assay projects .............................................. 24
To delete assay projects .............................................. 24

Managing SNPs .......................................................... 25
Opening SNP Manager ................................................ 25
To open SNP Manager ................................................ 25
Selecting SNPs .......................................................... 26
To select a SNP from the navigation tree ............................ 26
To select a SNP from the Members list ........................................ 26
To select a SNP using Locate .................................................. 26

SNP Groups ................................................................. 26
Creating SNP Groups ......................................................... 27
To create a SNP group ......................................................... 27
Adding SNPs to SNP Groups ............................................... 27
To add SNPs to a SNP group ................................................. 27
Removing SNPs from SNP Groups ...................................... 28
To remove a SNP from a SNP group ..................................... 28

SNPs ................................................................. 28
Creating New SNPs ........................................................ 28
To create a new SNP by modifying an existing SNP .............. 28
To create a new SNP ......................................................... 28
Associating SNPs with Assays ............................................. 29
To associate a SNP with an assay ........................................ 29
Exporting SNPs ........................................................... 30
To export SNPs ............................................................ 30
Deleting SNP Groups ......................................................... 30
To remove a SNP ........................................................... 30
To delete a SNP group ....................................................... 30

Moving, Copying, and Deleting Groups ................................. 30
Moving Groups ............................................................. 30
To move a group ............................................................ 30
Copying Groups ............................................................. 30
Deleting Groups ............................................................. 31
To delete assay groups ...................................................... 31
To delete locked definition assay groups ............................ 31
To delete SNP groups ....................................................... 31

Exporting Groups .......................................................... 32
To export a group ........................................................... 32

Chapter 4
Defining Plates

Introduction ................................................................. 35
Physical Plate ............................................................... 35
Plate Database Hierarchy .................................................. 35

PlateEditor Basics ........................................................ 35
Opening the PlateEditor .................................................. 35
To open the PlateEditor ................................................... 35
Closing the PlateEditor ...................................................... 35

PlateEditor Overview ...................................................... 36
PlateEditor Window ........................................................ 36
Menu Bar and Toolbar .................................................... 36
Message Bar ................................................................. 36
Status Bar ................................................................. 36
Plate tab ................................................................. 36
Assay Groups tab ........................................................ 36
Samples tab .............................................................. 37
List Items tab .................................................. 37
Plate Grid ..................................................... 37
Right-Click Menu ............................................. 37

Selecting Plates ............................................. 38
To select a plate ........................................... 38
To select an individual well ............................. 38
To select an entire row or column ..................... 38
To select a contiguous group of wells ................. 38
To select a non-contiguous group of wells .......... 38

Creating Plates ............................................. 39
Creating Plates with the New Plate Dialog Box .... 39
To create a new plate .................................... 39
Creating Plates using Templates ....................... 40
Creating Templates ........................................ 40
Creating Plates Using Templates ....................... 42
To create a plate using a template .................... 42
Creating Plates Using an Input Text File ............. 43
Creating Input Text Files ................................ 43
Creating Plates Using an Input Text File ............. 43
To create plates using an input text file ............. 43
Creating Plates via Assay Groups ...................... 44
To create plates via assay groups ..................... 44

Creating Samples .......................................... 45
To create a new sample group .......................... 45
Sample Order and Applying Sample Groups ........ 48
Sample Order ................................................ 48
Empty Row .................................................... 49
Repeated Samples ......................................... 49
Pasting Sample Names and Descriptions from Microsoft® Excel .... 50
To copy and paste sample names and descriptions from Microsoft Excel .................................. 50
Importing Sample Names and Descriptions from a File .... 52
To import sample names and descriptions from a file .... 52

Finding Which Plates Contain a Sample Group ........ 54
To view a list of plates to which a sample group is assigned .......... 54

Renaming a Sample Group ................................. 54
To rename a sample group ................................ 54

Adding a Sample to a Sample Group ................... 55

Renaming or Editing Samples ............................. 55

Editing a Sample Group .................................... 55
To edit a sample group ..................................... 55

Deleting a Sample Group ................................... 57
To delete a sample group ................................... 57
Applying Assays and Samples to Wells ................................................. 58
  Assay and Sample Tree .................................................................. 58
  To apply assays and samples to wells ............................................ 58
  To apply samples to a region .......................................................... 60

Applying Assays by Pasting from Microsoft® Excel ............................... 61
  To paste assays from Excel .............................................................. 61

Applying Sample Groups ................................................................. 63
  To apply a sample group to a plate ................................................. 63

Applying Sample Groups Using 4(96) to 1(384) Mapping .................... 64
  To apply a sample group using the 4(96) to 1(384) mapping .............. 65

Viewing Applied Assays and Samples ................................................. 67
  To view where the assays and samples are applied ......................... 67

Checking Assay Masses .................................................................... 68
  To check assay masses .................................................................. 68

Working with Plates .......................................................................... 68
  Clearing Wells .............................................................................. 68
  To clear a well ............................................................................. 68
  Opening Plates ............................................................................ 69
  To open a plate ........................................................................... 69
  Copying Plates ............................................................................ 69
  To copy a plate ........................................................................... 69
  Deleting Plates ............................................................................ 70
  To delete a plate .......................................................................... 70
  Using the Plate Assistant ............................................................... 70
  To create multiple plates using Plate Assistant .............................. 70
  Projects ...................................................................................... 71
  To create a new project .................................................................. 71
  To edit an existing project ............................................................. 71
  Customers ................................................................................... 72
  To create a new customer .............................................................. 72
  To edit an existing customer ........................................................ 72

Changing the Display Options ................................................................. 72
  Hiding Plex Numbers .................................................................... 72
  To hide plex numbers .................................................................. 72
  To show plex numbers ................................................................ 72
  Setting Multiplex Colors ............................................................... 73
  To change the multiplex colors ..................................................... 73

Creating Oligo Files .......................................................................... 74
  To create oligo files ..................................................................... 74
Chapter 5
Acquiring Spectra

Introduction ................................................................. 75
Overview of Acquiring Spectra ............................................ 75
Starting ACQUIRE ............................................................ 76
To start ACQUIRE .......................................................... 76
Selecting a Geometry File .................................................. 79
To select a geometry file .................................................. 80
Using Chip Linker to Associate Chips with Experiments .......... 81
Opening Chip Linker ......................................................... 81
To open Chip Linker ......................................................... 81
Associating SpectroCHIPS and Experiments ......................... 81
To associate SpectroCHIPS and experiments ......................... 81
Removing Plates from the Selection Table ............................ 82
To remove a plate from the selection table ............................ 82
Changing Plate Entries ...................................................... 82
To change plate entries ..................................................... 82
Loading SpectroCHIPS ....................................................... 83
To load SpectroCHIPS ....................................................... 83
Selecting the Number of Shots and Rastering Options ............... 87
To select the number of shots and rastering options ............... 87
Acquisition Parameters Values .......................................... 88
Turning on the High Voltage ................................................ 89
To turn on the high voltage ................................................ 89
To automatically turn off the high voltage after the last SpectroCHIP ... 89
Setting SpectroCHIP Geometry Options ............................... 89
To set SpectroCHIP geometry options ................................ 89
Starting an Automatic Run .................................................. 90
To start an automatic run .................................................. 90
Unloading SpectroCHIPS ................................................... 94
To unload SpectroCHIPS ................................................... 94
Stopping an Automatic Run ............................................... 96
To stop an automatic run .................................................. 96
Saving Current Settings .................................................... 97
To save current settings ................................................... 97
Recalling Plate Data ....................................................... 97
To recall plate data ......................................................... 97
Autoteaching ................................................................. 98
Chapter 6  
Reviewing Processed Data with TyperAnalyzer

Introduction .......................................................... 101  
Screen Resolution .................................................. 101  
Genotyping ............................................................. 101  
Allelotyping ............................................................ 102  
Starting TyperAnalyzer ............................................. 103  
To start TyperAnalyzer .............................................. 103  
Selecting an Experiment ............................................ 103  
To select an experiment by project .............................. 104  
To select a chip by assay ........................................... 104  
To select a chip by date ............................................. 104  
Color Codes (Genotyping) .......................................... 105  
Selecting Which Assays Are Shown ............................... 105  
Color Codes (Allelotyping) ......................................... 106  
Viewing a Results Table (Genotyping) ......................... 107  
To view all calls ...................................................... 107  
Viewing a Results Table (Allelotyping) ......................... 108  
To view all well information (allelotyping) .................... 108  
Viewing Spectra ....................................................... 110  
Viewing the Spectrum from a Well .............................. 110  
To view a spectrum showing all assays for a well ............ 111  
To view the spectrum for one assay (genotyping) ............ 111  
Using the Spectrum Display Cross-Hairs ....................... 112  
Zooming the spectrum display ................................... 112  
To zoom the spectrum display ................................... 112  
To un-zoom the spectrum display ................................. 113  
Viewing Calibrant Spectrum ....................................... 113  
To view calibrant spectrum ...................................... 113  
Adjusting Spectrum Display ...................................... 113  
To adjust spectrum display ..................................... 113  
Printing a Spectrum ............................................... 114  
To print a spectrum in color ..................................... 114  
To print the spectrum in monochrome .......................... 114  
Exporting a Spectrum .............................................. 114  
To copy a spectrum to the Clipboard ............................ 114  
To save the spectrum to a file .................................. 115  
To export spectrum graph data points ......................... 116

Saving Parameters .................................................. 99  
To save parameters ................................................ 99  
Tools Menu ............................................................ 99  
Quitting ACQUIRE .................................................. 99  
To quit ACQUIRE .................................................... 99
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MultiRow Options</td>
<td>116</td>
</tr>
<tr>
<td>Manually Calling a Genotype (Genotyping)</td>
<td>116</td>
</tr>
<tr>
<td>To manually call a genotype in the results table</td>
<td>116</td>
</tr>
<tr>
<td>Copying the Grid</td>
<td>117</td>
</tr>
<tr>
<td>To copy the grid</td>
<td>117</td>
</tr>
<tr>
<td>Viewing Assay Details for a Well</td>
<td>117</td>
</tr>
<tr>
<td>ASSAYINFO</td>
<td>118</td>
</tr>
<tr>
<td>CALLINFO</td>
<td>119</td>
</tr>
<tr>
<td>PEAKINFO</td>
<td>119</td>
</tr>
<tr>
<td>AREAINFO (Genotype+Area and Allelotyping only)</td>
<td>120</td>
</tr>
<tr>
<td>FREQUENCYINFO (Allelotyping only)</td>
<td>121</td>
</tr>
<tr>
<td>Generating Reports</td>
<td>122</td>
</tr>
<tr>
<td>To generate a report</td>
<td>122</td>
</tr>
<tr>
<td>Recalling Plate Data</td>
<td>125</td>
</tr>
<tr>
<td>Quitting TyperAnalyzer</td>
<td>125</td>
</tr>
<tr>
<td>To quit TyperAnalyzer</td>
<td>125</td>
</tr>
<tr>
<td><strong>Chapter 7</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reviewing Processed Data with Genotype Analyzer</strong></td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>127</td>
</tr>
<tr>
<td>Starting Genotype Analyzer</td>
<td>128</td>
</tr>
<tr>
<td>To start Genotype Analyzer</td>
<td>128</td>
</tr>
<tr>
<td>Finding and Selecting Data</td>
<td>128</td>
</tr>
<tr>
<td>By Project</td>
<td>128</td>
</tr>
<tr>
<td>By Test</td>
<td>129</td>
</tr>
<tr>
<td>By Date</td>
<td>129</td>
</tr>
<tr>
<td>Selecting Data in the Tree</td>
<td>129</td>
</tr>
<tr>
<td>Using the Results Table (Genotyping)</td>
<td>130</td>
</tr>
<tr>
<td>Color-Coding</td>
<td>130</td>
</tr>
<tr>
<td>Genotypes and Peaks</td>
<td>131</td>
</tr>
<tr>
<td>To view only the calls</td>
<td>132</td>
</tr>
<tr>
<td>To view the calls for all experiments on a plate</td>
<td>132</td>
</tr>
<tr>
<td>To view only the best call from the experiments on a plate</td>
<td>133</td>
</tr>
<tr>
<td>To view only the no calls</td>
<td>133</td>
</tr>
<tr>
<td>To view the no calls for all experiments on a plate</td>
<td>134</td>
</tr>
<tr>
<td>To sort the results table</td>
<td>134</td>
</tr>
<tr>
<td>To view information about a call</td>
<td>134</td>
</tr>
<tr>
<td>To view a history of calls</td>
<td>135</td>
</tr>
<tr>
<td>To view calibration and mass shift information</td>
<td>135</td>
</tr>
<tr>
<td>To hide calibration and mass shift information:</td>
<td>135</td>
</tr>
<tr>
<td>Using the Results Table (Genotype+Area)</td>
<td>136</td>
</tr>
<tr>
<td>Using the Results Table (Allelotyping)</td>
<td>136</td>
</tr>
<tr>
<td>Color-Coding</td>
<td>136</td>
</tr>
<tr>
<td>Data Columns</td>
<td>136</td>
</tr>
<tr>
<td>Viewing Bad Spectrum Rows</td>
<td>138</td>
</tr>
</tbody>
</table>
Viewing Data for all Experiments on a Plate ................................. 138
To view data for all experiments on a plate ................................. 138
Viewing Detailed Assay Results ............................................. 138
To view detailed assay results ............................................. 138

Filtering the Results Table ................................................. 140
To hide or show columns ................................................. 140

Printing the Results Table ................................................. 141
To print an entire table .................................................. 141
To print from the Print Preview window ............................... 141
To print one row and the spectrum .................................... 142

Viewing Spectra ............................................................. 143
Splitting the Screen ....................................................... 143
To split the screen ....................................................... 143
Unsplitting the Screen .................................................... 144
To unsplit the screen .................................................... 144
Zooming .......................................................... 144
To vertical zoom in ..................................................... 144
To vertical zoom out ..................................................... 144
To horizontally zoom in on an area .................................... 144
To revert to the default size ........................................... 144
Setting an Absolute Y-Axis Maximum .................................... 144
To set a y-axis maximum for the spectrum display .............. 144

Viewing the Calibration Spectrum ...................................... 145
To view the calibration spectrum ...................................... 145

Viewing All Spectra ........................................................ 145
To view all spectra in succession ...................................... 145

Generating Reports ......................................................... 146
To generate a report ...................................................... 147

Manually Calling a Genotype .............................................. 150
To manually call a genotype in the table ......................... 150

Viewing a Pie Chart ......................................................... 150
To view a pie chart of selected data .................................. 150

Recalling Plate Data ........................................................ 151

Appendix A
Oligo Mass Calculator Algorithm ....................................... 153
### Appendix B
**Reports**

<table>
<thead>
<tr>
<th>Report</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelotype Report</td>
<td>155</td>
</tr>
<tr>
<td>Allelotype Correction Report</td>
<td>156</td>
</tr>
<tr>
<td>Assay Type Count Report</td>
<td>157</td>
</tr>
<tr>
<td>Best Call Probability Report</td>
<td>157</td>
</tr>
<tr>
<td>Call Probability Report</td>
<td>157</td>
</tr>
<tr>
<td>Description Count Report</td>
<td>157</td>
</tr>
<tr>
<td>Gene Expression Report</td>
<td>158</td>
</tr>
<tr>
<td>Genotype Area Report</td>
<td>158</td>
</tr>
<tr>
<td>Creating a Skew Correction File</td>
<td>159</td>
</tr>
<tr>
<td>Skew Correction File</td>
<td>159</td>
</tr>
<tr>
<td>Genotype Cluster Report</td>
<td>159</td>
</tr>
<tr>
<td>Plate Definition Report</td>
<td>160</td>
</tr>
<tr>
<td>Plate Result Report</td>
<td>160</td>
</tr>
<tr>
<td>Primer Adjustment Report</td>
<td>160</td>
</tr>
<tr>
<td>Adjusting MassEXTEND Primer Mixes</td>
<td>160</td>
</tr>
<tr>
<td>To adjust MassEXTEND primer mixes</td>
<td>161</td>
</tr>
</tbody>
</table>

### Appendix C
**Deleting and Changing Database Items**

<table>
<thead>
<tr>
<th>Role</th>
<th>Can</th>
<th>Cannot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordinary Users</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Database Administrators</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Appendix D
**MassARRAY Nanodispenser Plate-to-SpectroCHIP Mappings**

<table>
<thead>
<tr>
<th>Mapping</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>384-Well Plate to 384-Well SpectroCHIP</td>
<td>165</td>
</tr>
</tbody>
</table>
Chapter 1

Introduction

MassARRAY™ Typer (Typer) is software for analyzing spectral data acquired from SpectroCHIPs. Typer analyzes each spectrum based on the assay or assays applied to it. An assay establishes where mass peaks are expected in a spectrum and how to interpret the presence of each peak. Based on the peaks present in a spectrum, Typer automatically identifies the genotype in genotyping experiments or estimates the relative frequencies of alleles in allelotyping experiments.

The following illustration shows how computers and instruments in the MassARRAY system are networked. An instrument (i.e. liquid handler, nanodispenser, and analyzer or analyzer compact) is represented by the computer that directly controls it. All computers are networked using TCP/IP.

There are three types of the Typer software: Server, Workstation, and Client (referred to as Typer Server, Typer Workstation, and Typer Client, respectively). Each type runs on a separate computer and serves different purposes. The computers themselves are identified as Typer Server, Typer Workstation, or Typer Client depending on which Typer software is installed.
A **Typer Server** is the informational “heart” of the MassARRAY system. It contains the MassARRAY database (an Oracle relational database management system). All data generated by the MassARRAY system is stored in this database. Additionally, if you have MassARRAY Tracking, tracking information is stored in this database.

A **Typer Workstation** controls the operation of the analyzer to acquire spectra from SpectroCHIPs. As indicated in the preceding illustration, a Typer Workstation serves as an intermediary between a Typer Server and the computer directly connected (and controlling) the analyzer. The Typer Workstation controls the operation of the analyzer by communicating with the computer directly connected to the analyzer. Spectral data is sent from the directly connected computer to the Typer Workstation which then processes the data and sends it to the Typer Server.

A **Typer Client** is used to set up experiments (e.g. create a plate definition specifying the samples in a physical microplate and the assays to be applied to those samples). It is also used to view and analyze spectral data. Any computer that is networked to a Typer Server (via TCP/IP) may be set up to be a Typer Client. For example, the computer at your desk may be set up as a Typer Client. You could then set up experiments and view data on your computer.

At least one person at your facility or company is designated as the MassARRAY **system administrator**. This person is trained and has the computer-access privileges to maintain the MassARRAY system and perform installations and upgrades. For questions about the MassARRAY system, especially issues relating to user IDs/passwords and installing Typer Clients, see your MassARRAY system administrator.

The MassARRAY Typer System Administration Guide contains instructions for many of the functions typically carried out by the MassARRAY system administrator.
The following table is a very brief outline of the main steps in using the MassARRAY system to process samples.

Table 1: Processing Samples

<table>
<thead>
<tr>
<th>Step</th>
<th>Computer or Instrument</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define assays</td>
<td>Use the Assay Editor module of Typer. An assay definition specifies the mass peaks you expect to see in spectra and how to interpret those peaks. See “Chapter 3 Defining Assays” on page 11.</td>
</tr>
<tr>
<td>2</td>
<td>Create a plate definition</td>
<td>Use the Plate Editor module of Typer. A plate definition consists of a representation of the physical microplate of samples you intend to process plus assays you want applied to each sample. See “Chapter 4 Defining Plates” on page 35.</td>
</tr>
<tr>
<td>3</td>
<td>Amplify samples</td>
<td>Use your established amplification methods to amplify your samples. For PCR guidelines, see MassARRAY Liquid Handler User’s Guide.</td>
</tr>
<tr>
<td>4</td>
<td>Process the MassEXTEND reaction</td>
<td>Use the MassARRAY liquid handler to add MassEXTEND reagents to your amplified samples and process the MassEXTEND reaction. See MassARRAY Liquid Handler User’s Guide.</td>
</tr>
<tr>
<td>5</td>
<td>Transfer MassEXTEND reaction products to a SpectroCHIP</td>
<td>Use the MassARRAY nanodispenser, or piezodispenser, to transfer your samples—which have been processed through the MassEXTEND reaction—to a SpectroCHIP. See MassARRAY Nanodispenser User’s Guide or SpectroJET User’s Guide (piezodispenser).</td>
</tr>
<tr>
<td>6</td>
<td>Acquire spectra</td>
<td>Acquire spectra from the SpectroCHIP containing your processed samples. Spectral data is automatically sent to the MassARRAY Typer Server. Use the SpectroACQUIRE module of Typer to operate the analyzer. (The SpectroACQUIRE module is available only on a Typer Workstation.) See “Chapter 5 Acquiring Spectra” on page 75.</td>
</tr>
</tbody>
</table>
Analyze data

<table>
<thead>
<tr>
<th>Step</th>
<th>Computer or Instrument</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Analyze data</td>
<td>Use the TyperAnalyzer or Genotype Analyzer modules of Typer. You can view spectra and genotype calls. You can also generate reports on the data. See &quot;Chapter 6 Reviewing Processed Data with TyperAnalyzer&quot; on page 101 or &quot;Chapter 7 Reviewing Processed Data with Genotype Analyzer&quot; on page 127.</td>
</tr>
</tbody>
</table>
Chapter 2
Getting Started

MassARRAY Typer (Typer) is composed of modules, which are used to perform different setup and analysis operations. On the client computer, modules are accessed from a main Typer window that contains buttons for the modules.

![MassARRAY Typer window]

On the MassARRAY RT Workstation computer, use the RT-Workstation folder to launch modules such as ACQUIRE and CALLER. (“Chapter 5 Acquiring Spectra” on page 75 provides instructions for opening and using these modules.)

This chapter provides information on how to start Typer, log onto the MassARRAY database, and quit Typer. It also provides a general overview of what you will see when working with the different modules (such as the menu bar, toolbar, and tabs), and generally how to perform basic functions (such as select commands using a variety of methods, select a specific tab, and view a specific window).

Starting Typer

**To start Typer**

1. On the Windows desktop, open the MassARRAY folder.

2. Open the Typer 3.1 folder, and then double-click the Typer icon. The MassARRAY Typer window appears.

**To start a module**

- Click the button for the module you want. The modules are:
  - **Assay Editor**: To define assays.
  - **Plate Editor**: To define or import samples; to apply assays and samples to wells in a plate.
  - **TyperAnalyzer**: To view and analyze the results.
  - **Genotype Analyzer**: To view, analyze, and edit the results; and to generate reports listing the results.

**To quit Typer**

- On the File menu of the Typer window, select Exit.
Connect to the Database

It is necessary to establish a connection with the MassARRAY database to work with the various modules in Typer. The first time you select one of the Typer modules, the Connect to Database dialog box appears in which you enter logon information. You need log on to the database only once each Typer session (a “session” lasts from the time you start Typer until you quit Typer). After logging on, you may start any of the modules without having to log on again to the database.

To connect to the database

1. From the Typer window, click the module you want. (If you are already connected to a database and want to log on to a different one, on the File menu, select Connect.) The Connect to Database dialog box appears.

2. Type your User ID.
3. Type your Password.
4. In Data Source Name, type the name of the database to which you want to connect. This is the name of your MassARRAY database.
5. Click Connect.
The appropriate window opens.

Enter your user name, your password (it appears as asterisks), and the database name.

To establish a connection click the Connect button.
To close without connecting, click the Cancel button.

The Basics

This section provides general instructions for how to use the various user interface components found in the various Typer modules.

For fundamental instructions on techniques such as “click and drag,” see your Microsoft® Windows® online Help.

To Do Steps

Instructions in this manual are titled To Do procedures (for example, “To start Typer”). Numbered steps should be followed in sequence. Bulleted lists indicate that you can pick one of the bulleted methods or do the bulleted steps in any order.

Menu Bar

The menu bar includes the menu items which contain commands. Select a menu to open its list of commands. The more frequently used commands are also included as
toolbar buttons. The following illustration shows the type of menu and toolbar found in the Plate Editor (the Genotype Analyzer is similar).

![Plate Editor module (partial view)](image)

**Menu Items** View the commands in a menu by clicking on the menu name or by using the keyboard access keys. Unavailable menu commands appear dimmed.

**Keyboard Access Keys** You can use access keys when a letter is underlined in a menu, command, or button.

To access a button, press [Alt] plus the underlined letter in the button. To access a menu command, press [Alt] plus the underlined letter in the menu name, then press the underlined letter in the menu command. The following example tells how to use access keys to print something.

**To print using access keys**

1. To open the **Action menu**, press and hold down both the [Alt] keyboard key and the [A] keyboard key. The menu drops down.
2. **Release** the keys. The menu remains open. Notice that the Print command has the P underlined.

**Example**

1. Notice that on the **File menu**, Ctrl + O indicates the shortcut key combination for the Open command.
2. Press the keyboard [Ctrl] + [O] keys at the same time. The Open Plate dialog box opens.

**Example**
**Keyboard Keys** You can use the keyboard keys to move around a dialog box or window without using the mouse. For example, press [Tab] to move the focus (active control).

The focus is identified by a small border around a control's label. To choose the active command, press [Enter]. Fields with the focus (active fields) are areas where you type information or select something from a drop-down list. They are identified by a flashing pointer.

In this manual, a keyboard key is identified by the brackets on either side of the key's label.

**To select a control with the keyboard**

1. Press [Tab] until the control you want is active.
   - Active buttons have a border
   - Active options have a border.
   - Active fields show the cursor blinking.
2. Press [Enter].

**Toolbar Buttons**

The toolbar includes buttons for the more frequently used menu commands. To quickly select a command, click on the appropriate toolbar button. Buttons that are unavailable appear dimmed.

**To print**

• Click the Print toolbar button.

You can see what the button does by hovering the cursor over it. A tool tip opens with the button’s command written in it.

**Tabs**

Various windows include tabs. Tabs can be at the top or bottom of the screen, but in either case, to make a tab active for use, click on it. Once selected it appears on top of the other tabs and its information shows in the window.

**To select a tab**

• Click on the tab.

![Tabs in the Genotype Analyzer](image)
Message Bar

The lower part of the screen has a message bar that displays messages regarding the current state of the program. For example, when you save a plate, the message bar indicates the progress of the save process.

Tree Control

In various parts of Typer, you will see tree controls.

- Sample Tables
  - sample
    - SampleGroupOne
    - SampleGroupTwo
    - test

Sample tree control

Click a plus symbol (+) next to a node to expand it. Click a minus symbol (-) next to a node to collapse it.

Also, you can use certain keyboard keys to expand or collapse the whole tree or parts of the tree. See the following table.

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
</table>
| * (asterisk) | Expands all nodes of the entire tree  
(Note: the top node of the tree must be selected; otherwise, pressing the * key has no effect) |
| + (plus) | Expands the currently selected node  
(Note: Only the direct child nodes of the selected node are shown; that is, the currently selected node is expanded only one level down) |
| - (minus) | Collapses the currently selected node |

Note: Use the *, +, and - keys on the numeric keypad, not those along the top of the keyboard.
Chapter 3
Defining Assays

Introduction

The AssayEditor module is used to define assays and store them in a SEQUENOM database. In addition to manual editing of assays, AssayEditor allows for the importing and exporting of assay groups along with the associated SNP sequences and design parameters in accordance with the MassARRAY Assay Design Software (Assay Design) file formats. AssayEditor also allows for the manual creation of subsets of (multiplexed) assays, called reference assay groups.

This chapter covers the following information:

- Basics of AssayEditor (See “Uniplex and Multiplex” on page 11 through “Exiting AssayEditor” on page 12 for information.)
- Working with Assays (See “Searching for Assays” on page 15 through “Deleting Assays” on page 21 for information.)
- Working with SNPs (See “Managing SNPs” on page 25 through “Deleting SNP Groups” on page 30 for information.)
- Working with groups (See “Moving, Copying, and Deleting Groups” on page 30 through “Exporting Groups” on page 32 for information.)

Uniplex and Multiplex

An Assay is defined as the procedure that yields a single genotype outcome. Assays can be run together in the same reaction well to allow DNA sequences to be analyzed for multiple genotype determination, but each assay is still defined individually. Assays that are designed to be run together are referred to as multiplexed assays. A run of a single assay is referred to as a uniplex assay. Generally, multiplexed assays may be separated into smaller multiplexes or uniplexes using AssayEditor or Plate Editor, but uniplex assays may not be multiplexed together without considering potential interactions of the reactants and peak overlaps in the resulting mass spectra.

Assay Database Hierarchy

In the MassARRAY Server database hierarchy, each Assay belongs to a Plex, which belongs to an Assay Group. Assay Groups and SNP Groups are stored in Assay Projects, which are the top level of the hierarchy. There are three types of assay group, as shown below.
**Defining Assays**

**AssayEditor Basics**

**Opening AssayEditor**

* To **open the AssayEditor window**
  1. In the MassARRAY Typer window, click the **AssayEditor** button.
  2. If you have not yet connected to the database, the **Connect to Database** dialog box opens. Enter the appropriate information.

Once connected, the **AssayEditor** appears.

**Exiting AssayEditor**

* To **exit AssayEditor**
  - On the File menu, choose **Exit**.
The Navigation Tree

The left pane of the AssayEditor window contains the navigation tree for the Assay Group tab. Navigate to assay projects, assay groups, plexes, and assays using the navigation tree.

**Note:** The general term "assay group" is used in this chapter to refer to any type of assays grouped together in AssayEditor. When necessary, specific terms are used instead; these terms are "definition assay group," "locked definition assay group," and "reference assay group." These specific terms are described below.

**Assay Group tab** The Assay Group tab lists definition assay groups, locked definition assay groups, and reference assay groups. These items are described as follows:

- A **Definition Assay Group** is a set of assays not associated with any design parameters. An assay in an assay group may not be edited or deleted from the group if the assay has already been run. New assays may be added to an assay group.

- A **Locked Definition Assay Group** is a set of assays associated with a set of design parameters and with a Locked SNP Group. Assays within a Locked Assay Definition Group may not be edited or deleted.

- A **Reference Assay Group** is a group of references to assays stored in the database. Assays deleted from Reference Assay Groups are not deleted from the database; they are merely deleted from the group.

**To view items on the Assay Group tab**

- Click the plus symbol [+] beside any item on the Assay Group tab navigation tree to display its contents.

**To rename items on the Assay Group tab**

1. Click a project, assay group, plex, or assay on the Assay Group tab so it becomes highlighted. Then, click it again so a blinking cursor appears at the end of the item’s name.
2. Type a new name, and then press the **Enter** key.
A message appears, asking you to confirm the name change.

3. Click **OK** to confirm the name change or **Cancel** to maintain the original name.

**The Work Window**

The right pane of the AssayEditor window lists details or task options for whatever item is currently selected in the navigation tree; any work to be performed (editing, creating new items, etc.) is done in this window pane. The right pane provides three tabs, which are described in the following sections.

**Details tab** The Details tab displays information about the currently selected item in the navigation tree. This information may be copied and pasted into another application. The description text displayed for certain items may be edited. (See “To edit description text” on page 17 for details.) For assays and assay groups that have associated design parameters, you may view the associated Design Summary file. (See “To view design summary” on page 21 for details.)

**Edit Assay tab** The Edit Assay tab displays editable information for the assay currently selected in the navigation tree. If the assay is part of a locked definition assay group or has been associated with experimental data, some information may not be available for editing.

**Edit Group tab** On the Edit Group tab, reference assay groups may be viewed, edited, or created. Assays, plexes, and assay groups from the Assay Group tab may be dragged into the Edit Group tab to become part of the currently selected reference assay group.

**Importing Assays**

Assays can be directly imported into the database using AssayEditor, as long as they follow the Assay Design software Assay group file format. (See the MassARRAY Assay Design Software User’s Guide for information on assay group files.) Typically, SNP sequences that these assays were designed against and the parameters used in the design would be imported at the same time from a SNP Group file and Design Summary file in the same directory. However, assay groups may be imported without a design summary file, and SNP groups may be imported independently.

**To import assays**

1. On the File menu, choose **Import Assay Group**.
   Or, on the Assay Group tab, right-click a project and choose **Import Assay Group**.
Defining Assays

Searching for Assays

The **Import Assay/SNP Groups** dialog box appears.

![Assay Editor: Import Assay/SNP Groups dialog box in AssayEditor](image)

2. Click the check box of any item you want to import. Selecting one of the file types will generally cause all three file types to be specified, if these files were produced as a result of a Assay Design run.
3. Click **Browse** to locate the Design Summary (.trs file), Assay Group, or SNP Group you want to import.
4. If desired, type or update the name in the **New Assay Group ID** box. By default, the ID for the imported assay group is the same as the name of the local assay group file. If the selected group ID conflicts with an existing ID in the database, a message appears prompting you to enter a different ID.
5. On the **Import to Assay Project** drop-down list, select the Assay Project where the imported items will be stored.
6. If desired, click **View** to preview the Design Summary file to ensure you have selected the correct set of assay design files for importing.
7. Click **Import**. The selected files are imported into the database.

**Note:** Importing large assay groups into the database may take some time. It is recommended that assay groups contain no more than 10,000 assays. Working with larger assay or SNP groups may hamper performance when opening items in the database navigation trees and could possibly result in an *out-of-memory* problem on smaller systems.

8. Click **Close** to exit the **Import Assay/SNP Groups** dialog box.

**Searching for Assays**

You can search for any assay name listed on the **Assay Group** tab. You cannot search for an assay project name or an assay group name.

**To search for assays**

1. Type an assay name in the **Search** box.
Use a percentage sign (%) as a wildcard to find one or more characters in the assay name. For example, searching on the name **MyAssay%** will return an assay named MyAssay, as well as MyAssays, MyAssays1, MyAssays2, etc.

2. Click **Go** to start the search.
   The search results are listed in the navigation tree.

3. Click **Go** again to find the next occurrence of an assay name matching the search query.

Create and edit assays using the **Edit Assay** tab.

**Creating Assays**

New assays may be created "from scratch" or by copying an existing assay and modifying its contents.

» **To create a new assay**

1. In the right pane, click the **Edit Assay** tab.

   - **Assay Group**: LCR_59-plex
   - **Assay ID**: 101S-2
   - **Description**:
   - **Terminator Mix**: ACT
   - **SNP Strand**: SNPR
   - **5' Amp Primer**: GCACTCACATTAAACAGCTB
   - **3' Amp Primer**: TCACTTTGACTCAGGAGG
   - **Expected Peaks**:
     - **Probe**: 101S-2-P
     - **Contaminant**: ATACAGACTCTCTCAGATGCT
     - **Analyte C**: ATACAGACTCTCTCAGATGTA
     - **Analyte T**: ATACAGACTCTCTCAGATGTA

   - **Genotype Calls**:
     - **C**: ✔  ✔  ✔  ✔
     - **T**: ✔

2. Click **New**.
3. On the **Assay Group** drop-down list, select an assay group into which the new assay will be added.
4. In the **Assay ID** box, type a name for the new assay.
5. Type a description for the assay.
6. Specify the contents of the assay.
   (See “Adding Items to the Expected Peaks Grid” on page 18 and “Adding Genotype Calls” on page 19 for instructions.)

7. Click **SAVE** to save the assay.
   If the **SAVE** button is unavailable, it means either no changes have been made to the assay or certain required data is missing. Review the **Edit Assay** tab and make the necessary changes.

**To edit description text**

1. On the **Details** tab, click **Edit Description**.
   The **Edit Description** dialog box appears.

   ![Edit Description dialog box](image)

2. Type a new description, and then click **SAVE**.

**Editing Assays**

You may edit existing assays (those already in the left pane navigation tree) or new assays on the **Edit Assay** tab.

**Note:** If an assay has already been associated with a design or if it has already been run, you may not edit it. Instead, you must copy the assay (or assays) to a new assay group, and then edit the assay. See “Copying Assays for Editing” on page 20 for details.

**To edit assays**

1. On the **Assay Group** tab, click an assay to select it.
2. In the right pane, click the **Edit Assay** tab, which displays the assay definition for the assay you just selected.
3. Make changes to the assay as needed.
   The **Assay Group** box cannot be changed when editing an existing assay. Other fields may not be editable if the currently selected assay belongs to a locked definition assay group or if it has experimental data associated with it.
4. Click **SNP Manager** to associate the assay with a SNP sequence.
   The **SNP Manager** dialog box appears. See “Managing SNPs” on page 25 for details on using this dialog box.
   Once you associate a SNP with the assay, the SNP ID and SUSID appear in the **SNP Strand** box.
5. If the SNP sequence has multiple SNPs defined, click the SNP# drop-down list and select the particular SNP to associate with the assay.

6. Continue specifying the contents of the assay.
   (See “Adding Items to the Expected Peaks Grid” on page 18 and “Adding Genotype Calls” on page 19 for instructions.)

7. Click SAVE to save the assay.
   If the SAVE button is unavailable, it means either no changes have been made to the assay or certain required data is missing. Review the Edit Assay tab and make the necessary changes.

Adding Items to the Expected Peaks Grid

Review the information in this section to add a probe sequence, analytes, contaminants, sequence, and sequence mass to the Expected Peaks grid.

<table>
<thead>
<tr>
<th>Expected Peaks</th>
<th>NAME</th>
<th>SEQUENCE</th>
<th>MASS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Probe</td>
<td>probe</td>
<td>CGCA0CGATA0CGA0G0C</td>
<td>4587.0</td>
</tr>
<tr>
<td>Contaminant</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyte</td>
<td>A-ANALYTE</td>
<td>CGCA0CGATA0CGA0G0A</td>
<td>4900.2</td>
</tr>
<tr>
<td>Analyte</td>
<td>G-ANALYTE</td>
<td>CGCA0CGATA0CGA0G0G</td>
<td>4916.2</td>
</tr>
</tbody>
</table>

Analyte peaks on the Expected Peaks grid

In the example illustration above, the analyte masses are colored pink. This is a warning that their masses are close together (<= 50 Da) and may not be well resolved (with respect to MassEXTEND chemistry). If a particular grid cell value is missing or invalid, its background color is red. Or, if the masses between two analytes are closer than 5 Da, the grid cell is colored red.

To add probe, sequence, and sequence mass

1. On the Edit Assay tab, double-click inside the Expected Peaks grid, and then type the appropriate values for probe, sequence, and sequence mass.
   An assay must have at least a probe sequence defined, with an ID, sequence, and sequence mass.
   When you tab away from editing a sequence, its value is tested for syntax and the mass of the sequence is calculated in the Sequence Mass Calculator dialog box.

2. If you do not plan to specify a DNA sequence, you must type the mass value in the Mass cell.

To add analytes

1. On the Edit Assay tab, double-click inside the Expected Peaks grid, and then type the appropriate value for the first analyte.
   You should name the analyte with the SNP sequence to which it corresponds.

2. To add additional analytes, right-click the existing analyte and choose Add New Analyte.
To add contaminants

1. On the Edit Assay tab, double-click inside the Expected Peaks grid, and then type the appropriate value for the contaminant.
2. To add another contaminant, right-click the existing contaminant and choose Insert New Contaminant.
3. Type the value for the contaminant.

Copying and Pasting Items in the Expected Peaks Grid

1. Right-click an item in the Expected Peaks grid, and choose Copy.
2. Right-click inside another cell of the grid, and then choose Paste.
   The selected item is pasted into the cell.

Deleting Items from the Expected Peaks Grid

- Right-click an item in the grid, and choose Delete.

Adding Genotype Calls

When an analyte is added to the Expected Peaks grid, a row is added to the Genotype Calls grid. (See “To add analytes” on page 18 for instructions on adding analytes.) The rows of the Genotype Calls grid represent the analytes associated with a particular genotype call. The columns of this grid are where you specify what combination of observed analyte peaks lead to a particular genotype call. After defining two analytes, you should specify the corresponding homozygous calls for each of those peaks.

To specify homozygous calls

1. Type the analyte peak combination call name (the genotype).
2. Click the check boxes to associate calls with the analyte peaks.
   Now, the Genotype Calls grid looks similar to the illustration below:

```
<table>
<thead>
<tr>
<th>A</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>A-ANALYTE</td>
<td></td>
</tr>
<tr>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>G-ANALYTE</td>
<td>✔</td>
</tr>
</tbody>
</table>
```

Example of Genotype Calls

To specify heterozygous calls

1. In the Genotype Calls grid, right-click an existing genotype and choose Add New Genotype.
   (If you have not yet added a genotype, see “To specify homozygous calls” for instructions.)
2. Type a name for the heterozygous genotype.
3. Select the checkboxes for the analyte peaks that would result in this call.
Now, the **Genotype Calls** grid appears similar to the illustration below:

![Genotype Calls Grid Example](image)

**Viewing Grid Colors**

As you define genotype calls, some cells, rows, or columns of the grid may be colored red. This indicates errors such as a missing genotype ID or multiple genotypes specified by the same combination of analyte peaks. If you click a genotype call ID, its column is colored green, indicating the item is selected. The analytes involved in the selected genotype call also become colored green in the **Expected Peaks** grid. These colors are intended to be used as a visual aid. If you prefer, you may turn off this visual aid.

➢ **To turn off visual aid colors**

- Click the empty cell above the analyte names in the **Genotype Calls** grid.

You can define assays with more than two analytes by continuing the process detailed under “To add analytes” on page 18. As an example, the **Genotype Calls** grid for a tri-allelic SNP would look similar to the illustration below.

![Genotype Calls Grid Example for tri-allelic SNP](image)

**Copying Assays**

You can copy and paste an assay into another assay group on the **Edit Assay** tab. The steps for copying the contents of an assay are the same as those for editing assays already associated with a design run. See the section below for instructions.

**Copying Assays for Editing**

You may not change the definition of assays that are associated with designs or that have been run. The only way to edit assays associated with a design or that have been run is to copy these assays to a new assay group and modify them.

➢ **To edit assays associated with a design**

1. On the **Edit Assay** tab, click **Copy**.
   A copy of the currently selected assay is created. The copy (unlike the original) is available for editing.
2. If you plan to save this copied assay to the same assay group as its original, you must change the **Assay ID** to a new name.
Or, if you plan to save this copied assay to a different assay group than its original, select an assay group from the **Assay Group** drop-down list.
3. Make changes to the assay as needed.
   (See “Adding Items to the Expected Peaks Grid” on page 18 and “Adding Genotype Calls” on page 19 for instructions.)
4. Click **SAVE** to save the assay.
   If the **SAVE** button is unavailable, it means either no changes have been made to the assay or certain required data is missing. Review the **Edit Assay** tab and make the necessary changes.

### Deleting Assays

**To delete an assay**

1. On the **Assay Group** tab, click an assay to select it.
2. Right-click the selected assay, and choose **Delete Assay**.

**To view design summary**

1. On the **Assay Group** tab, select an assay or assay group by clicking it.
2. In the right pane, click the **Details** tab if it is not already selected.
3. On the **Details** tab, click **View Design Summary**.
   If there is a Design Summary file associated with the currently selected assay or assay group, the file is displayed.

You can add or delete assays stored in a group, or you can create a new assay group and assign assays to it.

**To edit a group**

1. On the **Assay Group** tab, right-click a reference assay group (green icon) and choose **Edit Assay Group**.
The **Edit Group** tab appears (on the right side of the AssayEditor window), displaying the selected assay group.

2. To add to the group, drag and drop assays, plexes, or assay groups from the **Assay Group** tab into the **Edit Group** tab navigation tree. (Assays must be added to an existing plex in the assay group currently selected for editing.)

3. Click **Add Plex** to add a new, empty plex to the assay group.

4. Drag and drop to add assays to the new plex. As assays are added to a plex, the **Selected Plex** box provides information about the termination mixes and the minimum peak separation between any assay analyte and any other expected assay mass peak in the multiplex. A multiplex is invalid if there is more than one common terminator mix for the assays or the minimum separation is too small relative to resolving the mass peaks for MassEXTEND spectra. In this case, an exclamation point ("!") appears next to the display, indicating the multiplexing of the assays may be invalid.

5. To remove an assay from a plex, select it in the navigation tree, and then click **Remove Assay**.

6. To remove a single plex, select it in the navigation tree, and then click **Remove Plex**.

7. To remove all the plexes from the currently selected assay group, click **Empty**.
8. Type the name of the assay group in the **Edit Assay Group ID** box, or select an assay project from the **to Assay Project** drop-down list.

   The assay group will be saved to the selected assay project.

9. To check for multiple terminator mixes and minimum peak separation, check the **Validate Plexes Before Saving** option.

   If any plex is found to be invalid, the Save process is canceled.

   **Note:** Selecting this option may cause the save process to take more time. Do not check this option if you want to save time or if you want to save the assay group as it is currently defined.

10. Click **SAVE**.

    The assay group is saved to the selected assay project with the given ID. If an assay group with this name already exists in the selected assay project, a message box appears prompting you to either overwrite the existing assay group or not.

### Plexes with Numeric Names

When you drag and drop assay groups into the **Edit Group** tab, duplicate numeric plex names are appended with a number to indicate which duplicate it is. For example, a plex named "5" with two duplicates would appear as "5," "5(1)," and "5(2)" in the **Edit Group** tab to distinguish the three different plexes.

You can automatically reassign numeric plex names to remove duplicate names.

**To reassign numeric plex names**

- On the **Edit Group** tab, select the **Auto re-assign numeric plex IDs** option so a check mark appears in the box.

   ![Auto re-assign numeric plex IDs](image)

   All duplicate numeric plex names are reassigned. Duplicate naming is removed, and duplicate plex names are assigned new numeric names.

### Managing Assay Projects

You may add or delete entire assay projects in the database. Before you can delete an assay project, it must first be emptied. (See “Emptying and Deleting Assay Projects” on page 24 for instructions.)

### Adding Assay Projects

**To add assay projects**

1. On the File menu, choose **Project Administrator**.
The **Assay Project Administrator** dialog box appears.

2. Type a name for a new assay project, and then click **Add**.
3. Click **Close** to exit the dialog box.

### Emptying and Deleting Assay Projects

An assay project must be emptied of its contents (assays, assay groups, and SNP groups) before it can be deleted from the database. Only assays or assay groups that have not been associated with experimental data may be deleted.

You may move an assay group or SNP group into another assay project, which removes it from its original assay project. See “Moving Groups” on page 30 for information.

#### To empty assay projects

1. On the **Assay Group** tab, select an assay group. Then, right-click the selected assay group and choose **Delete Assay Group**.
   Or, select an individual assay, and then right-click it and choose **Delete Assay**.
2. In the message box that appears, click **Yes** to confirm the deletion.

#### To delete assay projects

1. On the File menu, choose **Project Administrator**.
   The **Assay Project Administrator** dialog box appears.
2. Select a name from the **Change Assay Project** drop-down list.
3. Click **Delete** to delete the selected assay project.
4. Click **Close** to exit the dialog box.
Managing SNPs

Use the **SNP Manager** dialog box to work with SNPs in AssayEditor. In the **SNP Manager** dialog box, you can manually create and edit SNP sequences and SNP groups, and you can locate SNPs and associate them with assays.

AssayEditor stores raw SNP sequences to the database to complete the information associated with an assay design. Every SNP stored in the database has a SNP_ID, a DNA sequence, and a SUSID (Sequenom Unique SNP ID). Each SNP must belong to at least one SNP group. Typically, a SNP group is imported into the database with a definition assay group. A new SNP is stored in the database only if it has a unique combination of sequence and SNP_ID. Hence, several SNPs in the database may have the same SNP_ID, e.g. “rs128986,” if they have different sequences. Alternatively, two SNPs may have the same sequence but a different SNP_ID. Otherwise, a SNP is identified as already existing in the database.

Opening SNP Manager

To open **SNP Manager**

- On the **View** menu, choose **SNP Manager**.
- Or, if you are on the **Edit Assay** tab, click **SNP Manager** to open the **SNP Manager** dialog box.

The **SNP Manager** dialog box appears.
Selecting SNPs

SNPs may be selected for viewing in any of the following ways:

- By clicking them in the navigation tree
- By clicking them in the Members box
- By searching for them with the Locate button

Once a SNP is selected, its SUSID and sequence appear. If the SNP is in the SNP group currently selected for editing, then the SNP is also selected in the Members box.

To select a SNP from the navigation tree

- In the SNP Manager dialog box, click a SNP_ID in the navigation tree.
  The SNP becomes highlighted, indicating it is selected.

To select a SNP from the Members list

- In the Members box, click a SNP_ID.
  The SNP becomes highlighted, indicating it is selected.

To select a SNP using Locate

1. Type a SNP_ID in the SNP_ID box.

Note: The Locate function requires the exact name of the SNP_ID to locate a SNP. Partial names and the wildcard character (%) may not be used.

2. Click Locate.
   If the located SNP is a member of the SNP group currently selected for editing, its entry in the Members box becomes highlighted.
   Otherwise, the SNP is searched for in the database, and the assay project and SNP group containing the SNP are opened with the SNP selected. If the SNP_ID was associated with more than one SNP (having different sequences), then the SUSID box contains multiple values from which to select.
   If the SNP_ID was not located in any SNP group in the database, then the SUSID box contains the value <New>, and the current sequence becomes editable.

3. Click Locate again if you want the search to continue from the currently selected SNP.
   If the same SNP is a member of more than one SNP group, these occurrences are highlighted in the navigation tree as they are located.

4. If the SNP_ID is associated with multiple DNA sequences, click the SUSID drop-down list and select an individual SNP.

SNP Groups

SNPs must belong to at least one SNP group. New SNPs cannot be saved to the database until they are assigned to a SNP group. While you are creating a new SNP or editing an existing SNP, you can create and/or edit a SNP group in the SNP Manager dialog box. (See “Creating New SNPs” on page 28 for instructions on creating SNPs from scratch or by modifying an existing SNP.)
Creating SNP Groups

Create a new SNP group while creating or editing a SNP.

To create a SNP group

1. Select an existing SNP.
   (See “Selecting SNPs” on page 26 for instructions.)
   Information for the selected SNP is loaded into the right side of the SNP Manager dialog box.
2. In the SNP Grp box, type a name for the new SNP group.
3. To add the currently selected SNP to the new SNP group, click Add SNP to Group.
4. To add other SNPs to the SNP group, drag and drop SNPs from the SNP Manager dialog box navigation tree into the Members box.
5. Select an assay project from the Assay Project drop-down list.
   The new SNP group will be saved to the selected assay project.
6. Once the current SNP group contains all the SNPs you want, click SAVE to save it to the database.

Adding SNPs to SNP Groups

While creating or editing a SNP, you can add SNPs to the current SNP group.

To add SNPs to a SNP group

1. Select an existing SNP.
   (See “Selecting SNPs” on page 26 for instructions.)
   Or, create a new SNP.
   (See “Creating New SNPs” on page 28 for instructions.)
   Information for the selected SNP is loaded into the right side of the SNP Manager dialog box.
2. To add SNPs to the current SNP group, do either of the following:
   • Click Add SNP to Group to add the selected SNP to the SNP group currently being edited.
   • Or, drag and drop SNPs from the SNP Manager dialog box navigation tree into the Members box.
3. Click SAVE to save your changes.
Removing SNPs from SNP Groups

To remove a SNP from a SNP group
1. In the Members box, select a SNP_ID.
   The Add SNP to Group button changes to the Remove SNP from Group button.
2. Click Remove SNP from Group.
3. To remove all SNPs from the Members box, click Empty.
4. Click SAVE to save your changes.
You may not save an empty SNP group to the database. Add SNPs to the SNP group if it is currently empty. Then, click SAVE.

Creating New SNPs

New SNPs may be created by updating existing SNPs or "from scratch."

To create a new SNP by modifying an existing SNP
1. Select an existing SNP.
   (See “Selecting SNPs” on page 26 for instructions.)
2. In the SUSID drop-down list, select <New>.
3. In the SNP_ID box, type a new SNP_ID.
   Or, leave the SNP_ID as it appears for the selected SNP. Then, modify the sequence in the Sequence box.
4. Click Test to test the DNA sequence for sequence, (maximum) strand length, and the number of SNPs to be reported.
   If any errors are found, a message box appears. Make any necessary corrections to the sequence.
5. Click Add SNP to Group to add the SNP to the SNP group currently being edited.
   The new SNP cannot be saved to the database until it belongs to a SNP group.
   The SNP_ID is added to the Members box, and it is assigned a temporary value in the SUSID box. (The SUSID will be updated once the SNP is saved to the database.)

   Note: Once a SNP has been added to a SNP group, the SNP may no longer be edited. Instead, you must make a copy of it; the copied SNP may be edited. Also, if any assays were associated with the original SNP, they must be re-associated with another SNP before the original SNP can be deleted.
6. Click SAVE to save your changes.

To create a new SNP
1. Type the ID for the new SNP in the SNP_ID box.
2. Click Locate.
   If the SNP_ID does not yet exist in the database, the SUSID box displays <New>, indicating a new SNP is being created.
If a SNP (or SNPs) already exist in the database with this same SNP_ID, it is selected. To create a new SNP with this same SNP_ID, select <New> from the SUSID box, and then modify the Sequence value.

3. Type or paste the sequence into the Sequence box.

4. Click Test to test the syntax of the SNP sequence you entered.

   If the SNP syntax is valid, then the total SNP sequence length and number of SNPs are reported below the sequence.

   If any errors are detected during Test, a message box appears.

5. In the SNP Grp box, type the name of the SNP group where the SNP will be stored.

   A new SNP cannot be saved to the database until it belongs to a SNP group.

6. Click Add SNP to Group to add the new SNP to the currently selected SNP group.

   A temporary value (indicated by "*") appears in the SUSID box. This value gets updated once the currently selected SNP group is saved to the database.

7. If you want to add additional SNPs to the SNP group, click and drag them from the navigation tree into the Members box. Repeat this step to add other new SNPs to the group or to add other existing SNPs to the group. (See “Adding SNPs to SNP Groups” on page 27 for details.)

8. Select an assay project from the Assay Project drop-down list.

   The new SNP and its SNP group will be saved to the selected assay project.

9. Once the current SNP group contains all the copied, edited, and/or new SNPs you want, click SAVE to save it to the database.

### Associating SNPs with Assays

Note: The Associate with Assay button is only available if you opened the SNP Manager dialog box by clicking SNP Manager on the Edit Assay tab.

New or existing SNPs may be associated with assays. Before a new SNP may be associated with an assay, it must first be added to a SNP group and saved to the database. (See “To create a new SNP by modifying an existing SNP” on page 28 for instructions.)

To associate a SNP with an assay

1. With an editable assay loaded in the Edit Assay tab, click SNP Manager.

   The SNP Manager dialog box appears.

2. Select a SNP.

   (See “Selecting SNPs” on page 26 for instructions.)

3. Click Associate with Assay to associate the selected SNP with the assay being edited.

   The SNP Manager dialog box closes. In the main AssayEditor window, the SNP_ID and SUSID for the SNP appear in the SNP Strand box.
Exporting SNPs

SNPs and SNP groups may be exported to an Assay Design file.

To export SNPs

• In the navigation tree, right-click a SNP group or SNP_ID, and then choose Export.

Deleting SNP Groups

SNPs may not be deleted; you may only delete the SNP groups that contain them. (SNPs may be removed from a SNP group, but they are not deleted from the database.)

The SNP group that contains the last reference to a particular SNP may not be deleted. Such a SNP group may only be deleted after its associated assays have been deleted. (See “Deleting Assays” on page 21 for instructions.)

To remove a SNP

• See “Removing SNPs from SNP Groups” on page 28 for instructions.

To delete a SNP group

1. In the SNP Manager dialog box navigation tree, select a SNP group.  
2. Right-click the selected SNP group and choose Delete SNP Group.  
The selected SNP group is deleted.

Moving Groups

You can move assay groups from one project to another by simply dragging them within the navigation tree on the Assay Group tab. Projects, plexes, and individual assays may not be moved in this way. In the SNP Manager dialog box, you may move SNP groups by dragging them to a new location on the navigation tree. You may not move individual SNPs this way.

To move a group

• On the navigation tree, click and drag a group into its new location.

Copying Groups

In order to limit the number of copies of particular assays in the database, it is not possible to copy definition assay groups or locked definition assay groups using the drag and drop method. However, any assay group may be dropped into the navigation tree of the Edit Group tab view to create a reference assay group.

You may copy individual assays to different groups using the Copy button on the Edit Assay tab, but this is intended for creating new assays based on modifications to existing assays. (See “Copying Assays for Editing” on page 20 for instructions.) SNP groups may be copied by opening them for editing and saving them back to the database with a different ID or into a different project.
Deleting Groups

Review information in this section for instructions on deleting assay groups or SNP groups.

You cannot delete an assay or locked definition assay group if any of the assays in the group have been associated with an experiment plate. An assay group that does not have design settings associated may be deleted as described below.

To delete assay groups


   A confirmation dialog box appears.

2. To delete the assay group, click Yes.

   For instructions on deleting assays, see “Deleting Assays” on page 21.

To delete locked definition assay groups

1. On the Assay Group tab, right-click a locked definition assay group (blue padlock icon) and choose Delete Assay Group.

   Individual assays in a locked definition assay group may not be deleted.

2. If a confirmation dialog box appears, click Yes to delete the locked definition assay group.

   Note: A locked SNP group becomes unlocked once its associated locked assay definition assay group has been deleted.

If the locked definition assay group cannot be deleted, the following message box appears.

3. Click OK to close the message box. The selected locked definition assay group is not deleted.

   Note: After deleting a locked definition assay group, the associated Design Summary data is also deleted, but an associated SNP group is not deleted. The SNP group may be deleted separately (in the SNP Manager dialog box), if it is not associated with any other locked definition assay groups. (See “Deleting SNP Groups” on page 30.)

To delete SNP groups

• For instructions, see “Deleting SNP Groups” on page 30.
Assay groups and SNP groups may be exported to local files. Plexes may not be exported directly. To export a plex, add it to a definition assay group or reference assay group, and then export the assay group.

**To export a group**

1. In the navigation tree, right-click a group and choose **Export**.

   The navigation tree may vary, depending upon the type of group you are selecting. For example, if you are exporting a SNP group, you must be in the **SNP Manager** dialog box navigation tree.

   The **Export** dialog box appears.

2. Select export options by clicking the checkboxes.

   Up to three export files are created during export, depending upon the type of group selected for export and the export options selected. The **Export Options** are as follows:

   - **Design Parameters** writes the design parameters for an assay group to a text file that has a .trs file name extension. Typically, this file is a MassARRAY Assay Design Software (Assay Design) format file that describes the full set of parameters used to design a set of assays previously imported in to the database via AssayEditor. More generally, this is any text file that was imported with an assay group that serves as a description of how those assays were designed or collected together.

   - **Assay Group** writes the set of selected assays out to an Assay Design assay group format file, which is a tab-delimited text file that has a .xls file name extension. This option is available whenever any assay group or individual assay is selected for exporting.

   - **SNP Group** writes out a complete SNP group to an Assay Design SNP group format file, which is a tab-delimited text file with a .txt file name extension. This option will be available when a SNP group, individual SNP, or locked definition assay group is selected for exporting. For locked definition assay groups, the whole SNP group associated with the locked definition assay group is exported even though this group may contain SNPs that are not associated with individual assays.
• **Assay SNPs** writes a SNP group file for only those assays in the assay group or for the individual assay selected for exporting. This is the only SNP group export option available for assays that were not associated with a design.

• **Undesigned SNPs** writes a SNP group file for a set of SNPs within a SNP group that is not associated with assays. This option is only available when exporting a locked definition assay group associated with a SNP group. This option is equivalent to exporting the SNPs in the group that failed to be designed by Assay Design.

3. Type the file name for the exported file in the **File name prefix** box.
   By default the **file name prefix** uses the name of the group or individual assay or SNP you are exporting.

4. For the **Export Directory**, type or browse to select the path for the exported files.

5. Click **Export**.
   The selected assays, SNPs, and design settings are saved and exported to the specified directory.

6. Click **Close** to exit the **Export** dialog box.
Notes:
Chapter 4
Defining Plates

Introduction

The PlateEditor module is used to define samples and plates and to apply samples and assays to a plate's wells.

This chapter explains how to use the PlateEditor by providing an overview of what you will see followed by sections on how to perform specific tasks, such as: select a plate, create a plate, define samples, apply assays and samples to wells, create an assay group, and edit plates.

Physical Plate

A Plate in the MassARRAY Server database (database) represents the physical microtiter plate that is spotted onto the SpectroCHIP. Since the Plate layout (96 wells or 384 wells) also mirrors the SpectroCHIP layout, in a sense the definition of the Plate also serves as a definition for the SpectroCHIP. Each well contains a single Sample (which can be a pooled sample) and one or more Assays that are run simultaneously on that Sample. Assays which are run simultaneously are called multiplexed assays.

Plate Database Hierarchy

The Plate exists within a hierarchy in the database. As defined in the database hierarchy, a Customer has Projects, and a Project has Plates associated with it. A Plate must exist within a single Project. The Plate hierarchy can be used to associate Plates in any manner that is useful to you; that is, the hierarchies do not need to actually be Customers and Projects, but can reflect some other organization of similar form (e.g. Project and Subproject).

PlateEditor Basics

Opening the PlateEditor

To open the PlateEditor

1. From the MassARRAY Typer window, click PlateEditor.

2. Enter the appropriate information, and then click OK.

3. Select the plate you want to work on, and then assign assays and samples.

Closing the PlateEditor

• On the File menu, select Exit.
PlateEditor Overview

This section provides a general overview of where features are located on the PlateEditor window and instructions for more commonly used tasks.

The PlateEditor includes a menu bar, toolbar, tree tabs, and a plate grid. To view all of these, the first step is to select a plate. Plates are defined in the PlateEditor. Once the plate is open, it shows graphically in the window. Each well is identified by the grid cell. If there is nothing assigned to a well, the well appears white. The color of each well depends upon the type of multiplex in it. (See “Changing the Display Options” on page 72 for details.)

PlateEditor Window

The main areas that you work with in the PlateEditor are explained below.

**Menu Bar and Toolbar** Apply commands from the menu items. The more frequently used commands are also represented in toolbar buttons.

**Message Bar** This area is located in the lower part of the window. It displays messages regarding the current state of the program.

**Status Bar** When opening or saving a plate, the status bar indicates the progress. Do not do anything until the task is completed.

**Plate tab** Click the Plate tab to show all the plates in the database, organized by customer and project. Select and highlight a Plate ID and right-click the mouse. A popup menu of options appears.

**Assay Groups tab** Click the tab to make its information accessible. The Assay Groups tab includes all the assays defined using the Assay Editor. Assay projects are organized into assay groups, and within the assay groups are plexes and assays. Highlight the assay that you want to apply to selected wells. Select **Apply** from the
Plate menu. (See “Assay and Sample Tree” on page 58.) One or more assays can be applied to the same well.

**Samples tab**  Click the tab to make its information accessible. The Samples tab shows all defined samples.

**List Items tab**  Click the tab to make its information accessible. The List Items tab includes all the assays and samples defined on the selected plate. Click a specific assay or sample and its location is identified by a color change in the plate grid. Wells with the selected sample turn green whereas the selected assay turns red.

**Plate Grid**  This area displays the selected plate with each well identified by the grid. Highlight one or more wells that you want to select. This can be a single well, a contiguous group of wells, or a non-contiguous group of wells. Once wells are selected, choose an assay or sample and apply it.

**Right-Click Menu**  Right-click the mouse on one or more selected wells to open a menu of commands. (This menu is the same as the Plate menu.) Point to the command you want. This is a quick method to apply assays and samples to wells, clear wells, and save a plate.
Selecting Plates

The first step in using PlateEditor is to select a plate. This can be a blank plate that needs assays and samples applied to its wells, or a plate that already has assays and samples applied to its wells.

After a plate’s data is transferred and used in the Genotype Analyzer, the plate can be opened, copied, or viewed, but not edited. The title bar will include the words Read Only.

To select a plate
1. On the Plate tab, select and expand the Customer\Project\Plate tree. Continue down the tree to select the plate you want.

To select an individual well
- Click it.

To select an entire row or column
- Click the row or column header.

To select a contiguous group of wells
1. Click the first well, and hold down the left mouse button.
2. Drag the cursor across and down to cover the wells you want to select.
   As you drag, the selected wells turn dark blue.
3. Release the left mouse button.
   The wells remain selected.

To select a non-contiguous group of wells
1. Select the first well or group as explained in the preceding To Do instructions.
2. Press and hold down the [Ctrl] keyboard key.
3. Click additional wells.
   You can also click and drag to select more than one additional well.
4. Once all the wells are selected, release the [Ctrl] key and left mouse button.
Creating Plates

There are four ways to create plates:

- Using the New Plate Dialog box (See “Creating Plates with the New Plate Dialog Box” below for instructions.)
- From a template file (See “Creating Plates using Templates” on page 40 for instructions.)
- From an input text file (See “Creating Plates Using an Input Text File” on page 43 for instructions.)
- By selecting an assay group (See “Creating Plates via Assay Groups” on page 44 for instructions.)

Creating Plates with the New Plate Dialog Box

To create a new plate

1. On the Plate tab, select the customer and project in which the new plate will be stored.
2. Right-click a project name, and choose New Plate from the menu that appears. The Create a New Plate dialog box appears.
3. Type the Plate ID using any combination of alpha or numeric characters.
4. Click the option for 96 Wells or 384 Wells.
5. Choose Vertical or Horizontal for the default direction in which the sample groups are applied.
6. Click Create Plate.
The PlateEditor confirmation dialog box opens.

Confirm that all the information is correct for the plate record that you are creating.

If the information is not accurate, click No, and fix the error when returned to the Create A New Plate dialog box.

7. Read the information to confirm that it is correct. If it is, click Yes.

The new blank plate opens.

Creating Plates using Templates

Creating Templates A plate template is a tab-delimited text file that specifies the layout of a plate. The text file may be created in Microsoft Notepad or Microsoft Excel, as long as it is saved as a tab-delimited file. Templates are used to create plates in PlateEditor. The syntax of a plate template file is as follows:

Well Number P Pool Number

Type one well of data per line, and separate each data entry (well number, P, pool number) by pressing the Tab key.

Example plate template files are shown in Figure 1 below through Figure 3 on page 41.

Figure 1: Template file defining quadrants on a 384-well plate

This example defines quadrants on a 384-well plate. Quadrant regions are indicated by the third data column ("1" in this example); only a portion of the first quadrant is shown in this example.
### Figure 2: Template file defining column layout on a 96-well plate

<table>
<thead>
<tr>
<th></th>
<th>A01</th>
<th>P</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A02</td>
<td>P</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>A03</td>
<td>P</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>A04</td>
<td>P</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>A05</td>
<td>P</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>A06</td>
<td>P</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>A07</td>
<td>P</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>A08</td>
<td>P</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>A09</td>
<td>P</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>A10</td>
<td>P</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>A11</td>
<td>P</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>A12</td>
<td>P</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>B01</td>
<td>P</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>B02</td>
<td>P</td>
<td>2</td>
</tr>
<tr>
<td>15</td>
<td>B03</td>
<td>P</td>
<td>3</td>
</tr>
</tbody>
</table>

Well numbers | Pool numbers
---|---

### Figure 3: Template file defining one plex per well on a 96-well plate

<table>
<thead>
<tr>
<th></th>
<th>A01</th>
<th>P</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A02</td>
<td>P</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>A03</td>
<td>P</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>A04</td>
<td>P</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>A05</td>
<td>P</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>A06</td>
<td>P</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>A07</td>
<td>P</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>A08</td>
<td>P</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>A09</td>
<td>P</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>A10</td>
<td>P</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>A11</td>
<td>P</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>A12</td>
<td>P</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>B01</td>
<td>P</td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td>B02</td>
<td>P</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>B03</td>
<td>P</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>B04</td>
<td>P</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>B05</td>
<td>P</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>B06</td>
<td>P</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>B07</td>
<td>P</td>
<td>19</td>
</tr>
<tr>
<td>20</td>
<td>B08</td>
<td>P</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>B09</td>
<td>P</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>B10</td>
<td>P</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>B11</td>
<td>P</td>
<td>23</td>
</tr>
<tr>
<td>24</td>
<td>B12</td>
<td>P</td>
<td>24</td>
</tr>
</tbody>
</table>

In this example, template file, each well of the 96-well plate contains a different plex (indicated by the third data column, which contains pool numbers).
**Creating Plates Using Templates** Once you have created a template file, you can use it to create a plate.

**To create a plate using a template**

1. On the **Assay Groups** tab, right-click an assay group and choose **Create Plates with Template**.
   
   The **Create Plates** dialog box appears.

2. On the **Customer\Project\Plate** tree, select a project to which the new plate will be added.
3. Type names in the **Customer** and **Project** boxes.
4. Click the **Template Browse** button.
   
   A **Browse for File** dialog box appears.
5. Select a properly formatted template file, and then click **OK**.
6. Select a plate size.
7. Under **Plate Name**, type only a plate prefix in the first box. Or, type a plate prefix in the first box and a plate number in the second box.
8. Then, check the **Term Suffix** box if you want to include the terminator at the end of the plate name.
9. Click **OK**.

---

**Template File**

Create a template file in Microsoft Excel or Notepad. The tab-delimited file must be formatted with three tab-delimited columns: well, the letter "P," and the pool number. For details, see “Creating Templates” on page 40.
Creating Plates Using an Input Text File

Creating Input Text Files  The input text file is a tab-delimited file that must contain certain data columns. The required columns are as follows:

- Plate_ID
- Well_Position
- Assay_ID
- Test_ID
- Assay_Project_ID
- Sample_ID
- Group_ID

An example of an input text file created in Microsoft Excel is shown below.

Creating Plates Using an Input Text File  Once you have created an input text file in Microsoft Excel, you can use it to create a plate.

To create plates using an input text file

1. On the Plate tab, select Customer\Project\Plate (the root level of the navigation tree) to highlight it.
2. Right-click the selected root level, and choose Create Plates.
The **Create Plates: using input text file** dialog box appears.

![Create Plates: using input text file dialog box](image)

3. On the Customer\Project\Plate tree, select a project to which the new plate will be added.
4. Type names in the **Customer** and **Project** boxes.
5. Click the **Input Browse** button.
6. Select a properly formatted input text file, and then click **OK**.
7. Select a plate size.
8. Click **OK**.

### Creating Plates via Assay Groups

You can create plates from the **Assay Groups** tab.

**To create plates via assay groups**

1. On the **Assay Groups** tab, select an assay group.
2. Right-click the selected assay group, and choose **Create Plates**.
The Create Plates: using Assay Group dialog box appears.

3. On the Customer\Project\Plate tree, select a project to which the new plate will be added.
4. Type names in the Customer and Project boxes.
5. Select a plate size.
6. Click Well Exclude to select wells not to be included on the plate.
7. Under Shape Definition, type the number of columns and rows on the plate.
8. Choose Horizontal or Vertical for the direction in which the samples are applied.
9. To use hydra mapping, select the Hydra option.
   Hydra mapping applies samples to every other row and column on the plate. This mapping is used to map four 96-well plates to one 384-well plate.
10. Type a plate name and plate number.
11. Select the Term Suffix option to include the terminator at the end of the plate name.
12. Click OK to create the plate.

Creating Samples

The samples in Typer relate to your physical samples. For each physical sample, you should create a sample in Typer. In Typer, there are only two items of information associated with a sample: its name and an optional, short description.

A sample cannot be created by itself. It must belong to a sample group.

There are two ways to create a new sample. Either it is created as part of a new sample group or it is added to an existing sample group. For instructions, see the following:

- To create a new sample group, see “To create a new sample group” below.
- To add a sample to an existing sample group, see “Adding a Sample to a Sample Group” on page 55.

To create a new sample group

1. If it is not currently running, start the PlateEditor.
   (For instructions on starting the PlateEditor, see “Opening the PlateEditor” on page 35.)
2. In the PlateEditor, click the **Samples** tab.

3. Click the plus (+) symbol next to **Sample Tables**. **Sample** appears under Sample Tables.

4. Click **sample** to highlight it.

5. Right-click **sample**, and choose **New Sample Group**. The **New Sample Group** dialog box appears.

6. In the **Group** box, type a name for the sample group.
   This name appears in the tree-list of the PlateEditor to identify the sample group.
   Sample group names can have a maximum of 20 characters and must not contain any single quote marks.

7. For each sample in the sample group, type a name (in the **SampleID** column) and an optional description (in the **Description** column). Use one row for each sample.
   When you apply an entire sample group to a plate, the order of the samples determines to which well each sample is applied. The samples are applied in the order in which they appear in the sample group. For more information see “Sample Order and Applying Sample Groups” on page 48.
Note: You can copy and paste sample names and descriptions from Microsoft Excel, or you can import them from a file. See "Pasting Sample Names and Descriptions from Microsoft® Excel" on page 50 or "Importing Sample Names and Descriptions from a File" on page 52.

8. Click Save & Exit.

The sample group is saved and you are returned to the PlateEditor window. Click the plus symbol (+) next to sample. Under sample, the name of the new sample group you created appears.

Note: If you want to return to the PlateEditor window without saving the sample group, click Exit.
Sample Order and Applying Sample Groups

The order in which samples are entered in a sample group determines how they are applied to a plate. For information about applying sample groups to a plate, see “Applying Sample Groups” on page 63.

**Note**: You can individually apply any sample to any well. The information in this section describes how sample order affects the application of an entire sample group to a plate.

**Sample Order** When you apply an entire sample group to a plate, the order of the samples in the sample group determines the order in which they are applied to the wells of the plate. See the following illustration.

Note: This illustration depicts a sample group being applied vertically. You can also apply a sample group horizontally. In that case, the samples would be applied across the rows, not down the columns as shown here. For information about choosing whether samples are applied vertically or horizontally see “Applying Sample Groups” on page 63.
Empty Row  When entering the samples of a sample group, you can leave a row empty. When the sample group is applied to a plate, the well that corresponds to the empty row will not have a sample applied to it. See the following illustration.

Repeated Samples  When entering the samples of a sample group, you can enter the same sample name (SampleID) multiple times. When you apply the entire sample
group to a plate, multiple wells on the plate have the same sample applied to it. See the following illustration.

Pasting Sample Names and Descriptions from Microsoft® Excel

You can copy sample names and descriptions from Microsoft® Excel and paste them into the New Sample Group dialog box.

This feature is very useful in two situations:

- You want to prepare sample names and descriptions in Microsoft Excel and quickly copy and paste them to Typer.
- You already have a Microsoft Excel file containing the sample names and descriptions, but you do not want to use the import process which requires saving the file in delimited text format (for more information about importing, see “Importing Sample Names and Descriptions from a File” on page 52).

To copy and paste sample names and descriptions from Microsoft Excel

Note: It is assumed you are currently at the New Sample Group dialog box. If you are not, see the steps under “To create a new sample group” on page 45.

1. Start Microsoft Excel.
2. If you already have a Microsoft Excel file containing the sample names and descriptions, open it.
   If you do not have an existing file containing the sample names and descriptions, enter them on a new worksheet.
3. Select the cells containing the sample names you want to copy and paste to Typer.
Select an entire column or a group of cells in the same column.

4. On the Edit menu, select **Copy**.

5. In Typer, in the **New Sample Group** dialog box, click the box in the SampleID column for the row at which you want to start pasting the sample names.
   For example if you want to start pasting the names at row 5, click its SampleID box. The sample names will be pasted starting at row 5, continuing down the rows from there.

6. Right-click the box in the SampleID column again for the row at which you want to start pasting and select **Paste**.
   The sample names are copied to the **New Sample Group** dialog box.

7. (Optional) If you also have sample descriptions, repeat these steps, starting at step 3, for the column in the Microsoft Excel file containing the descriptions. Paste the descriptions to the Description column in the **New Sample Group** dialog box.

**Note:** For more information about using Microsoft Excel, refer to its documentation or online Help system.
Importing Sample Names and Descriptions from a File

When creating a new sample group, you can import the sample names and descriptions from a file rather than type the information yourself. The file must be a delimited text file.

Delimited text files contain information in plain text format. The items of information are separated, or delimited, by a certain character or space. The file from which you want to import sample names and descriptions must use one of the following characters as a separator (or delimiter):

- Comma (,)
- Colon (:)
- Semi-Colon (;)
- Tab

The following is an example of the contents of a comma-delimited file which could be imported into the PlateEditor:

```
Sample1,This is sample one
Sample2,This is sample two
Sample3,This is sample three
```

The first column contains the name of each sample (“Sample1,” “Sample2,” and “Sample3”). The second column contains a description for each sample. The two columns are separated by a comma.

Spaces before or after an item of information are automatically removed when the information is imported. For example if the sample names had three spaces before them, the sample names would be imported without the spaces.

You can import sample names and descriptions from any program that can save files in a plain text format. For example, if you have a Microsoft Excel file containing the sample names and (optional) descriptions, if you save the file as a delimited text file you can import the information into Typer. See your Microsoft Excel documentation for information on saving, or exporting, to delimited text files.

**Note:** You can import sample names and descriptions from a file only when creating a new sample group. You cannot import sample names and descriptions into an existing sample group.

**Important:** If you have already typed sample names and descriptions (in the New Sample Group dialog box), importing sample names and descriptions from a file will overwrite the existing information you have typed. If you want a combination of information you enter yourself and information imported from a file, import the information from the file first. Then, modify or add to the imported information.

**To import sample names and descriptions from a file**

**Note:** It is assumed you are currently at the New Sample Group dialog box. If you are not, see the steps under "To create a new sample group" on page 45.

1. In the New Sample Group dialog box, click Import.
The **Import Sample Group** dialog box appears.

2. Click **Browse**.
   
   An **Open** dialog box appears.

3. Select the file containing the sample names and descriptions, and then click **Open**.

4. You are returned to the **Import Sample Group** dialog box. The name of the file you selected appears in the **File Name for Import Sample Group** box.

5. Under **Field Name and Column Position Number**, select the types of information you want to import and type the column number in which the information is located. See the following illustration.

6. Under **Field Delimiters**, select the type of character used to separate the items of information in the file.

7. Click **OK**.
   
   The sample names and descriptions (if you chose to import them) from the file appears in the **New Sample Group** dialog box.

8. In the **Group** box, type a name for the group of samples.
   
   This is the name that will appear in the tree-list of the PlateEditor.

9. (Optional) If you want to edit any of the imported sample information or add samples to the imported sample group, do so now.

10. Click **Save & Exit**.
The sample group is saved and you are returned to the **PlateEditor** window. Click the plus symbol (\(+\)) next to **sample**. Under **sample**, the name of the new sample group you created appears.

You can select a sample group and view a list of the plates to which it has been assigned. Plates in the list do not have to contain the whole sample group—a plate appears in the list if it contains at least one of the samples from the sample group.

**To view a list of plates to which a sample group is assigned**

1. In the PlateEditor, click the **Samples tab**.
2. If necessary, expand the tree-list to find the sample group you want. Click the plus symbol (\(+\)) next to a node to view its contents.
3. Click the sample group to highlight it. Then, right-click the sample group and choose **Sample Group Info**.

The **Sample Group Info** dialog box appears.

The **Sample Group Info** dialog box indicates the number of plates containing samples from the sample group. It also lists the customer, project, and name for each plate containing samples from the sample group.

4. Click **OK** to close the **Sample Group Info** dialog box.

**To rename a sample group**

1. In the PlateEditor, click the **Samples tab**.
2. If necessary, expand the tree-list to find the sample group you want. Click the plus symbol (\(+\)) next to a node to view its contents.
3. Click the sample group to highlight it. Then, right-click the sample group and choose **Rename Sample Group**.
Defining Plates
Adding a Sample to a Sample Group

The **Rename Sample Group** dialog box appears.

![Rename Sample Group dialog box](image)

4. In the **To** box, type the new name you want for the sample group. Sample group names can have a maximum of 20 characters and must not contain single quote marks.

5. Click **Rename**. You are returned to the PlateEditor window. The sample group you selected now has the new name you entered.

### Adding a Sample to a Sample Group

You can add a new sample to an existing sample group. To do so, you must edit the sample group to which you want to add the new sample. See “Editing a Sample Group” below.

### Renaming or Editing Samples

You can change the name and description of a sample. To do so, you must edit the sample group to which the sample belongs. See “Editing a Sample Group” below.

### Editing a Sample Group

You can edit the samples in an existing sample group. You can:

- Rename a sample
- Change or add a sample’s description
- Add a new sample
- (To rename the sample group itself, see “Renaming a Sample Group” on page 54)

**Note:** You can edit a sample group only if none of its samples has been assigned to a plate. If any plate uses samples from the sample group, you must first clear those samples from the plates. To find out which plates use the sample group, see “Finding Which Plates Contain a Sample Group” on page 54. To clear samples from a plate, see “Clearing Wells” on page 68.

**To edit a sample group**

1. In the PlateEditor, click the **Samples** tab.
2. If necessary, expand the tree-list to find the sample group you want. Click the plus symbol (+) next to a node to view its contents.
3. Click the sample group to highlight it. Then, right-click the sample group and choose **Edit Sample Group**.

The **Edit Sample Group** dialog box appears.

![Edit Sample Group dialog box](image)

If a message similar to the following appears, click **OK** to dismiss it.

![Warning message](image)

The message appears because at least one plate uses samples from the sample group you want to edit. You cannot edit the samples in a sample group if a plate currently uses samples from that group. You must clear those samples from the plates before you can edit the sample group.

When you click **OK** to dismiss the message, the **View Sample Group** dialog box appears. Click **Exit** to close the **View Sample Group** dialog box. Find the plates that use samples from the sample group and then clear those samples from the plates. See “Finding Which Plates Contain a Sample Group” on page 54.

After clearing the samples from the plates, you can repeat this procedure to edit samples. For information about clearing samples from plates, see “Clearing Wells” on page 68.

4. Make the changes you want to the samples.

   To change a name (SampleID) or description, double-click it and make the changes you want.

   To add a new sample, enter its name and (optional) description in a blank row.
5. When you are done making changes, click **Save**.

---

**Note**: If you do not want to save the changes you made, click **Exit** to close the **Edit Sample Group** dialog box and return to the **PlateEditor** window.

6. Click **Exit**.
7. You are returned to the **PlateEditor** window.

---

**Deleting a Sample Group**

You can delete a sample group only if none of its samples are currently assigned to a plate. If a plate uses any of the sample group's samples, you must clear those samples from the plate before deleting the sample group. To find out which plates use samples from the sample group, see “Finding Which Plates Contain a Sample Group” on page 54. To clear samples from a plate, see “Clearing Wells” on page 68.

---

**Note**: You must be logged in with database privileges in order to delete a sample group. Contact your database administrator for information.

---

**To delete a sample group**

1. In the **PlateEditor**, click the **Samples** tab.
2. If necessary, expand the tree-list to find the sample group you want. Click the plus symbol (+) next to a node to view its contents.
3. Click the sample group to highlight it. Then, right-click the sample group and choose **Delete Sample Group**.
4. If the following message appears, click **OK** to dismiss it. (If this message does not appear, skip to the next step now.)

---

This message appears because there are plates that use samples from the sample group you want to delete. To delete the sample group, you must first clear its samples from any plates using them. To find out which plates use samples from the sample group, see “Finding Which Plates Contain a Sample Group” on page 54. To clear samples from a plate, see “Clearing Wells” on page 68. After you have cleared its samples from plates, repeat this procedure to delete the sample group.

5. You are asked if you are sure you want to delete the sample group. Click **Yes**. The sample group is deleted.
With a plate selected, apply plexes (or individual assays) and samples to the wells by highlighting the specific plexes, assays, and samples that you want applied to specific wells. More than one assay can be applied to a single well. After applied, use the List Items tab to show what exactly is applied to the plate. Click a sample or assay in the tree and its location is identified graphically in the plate grid by a change in color.

Assay and Sample Tree

When working with the information in the trees on these tabs, click a plus symbol (+) to expand a node. A minus symbol (-) means that the node is open. When a tree is open all the way down to the assay or sample level, there are no plus or minus symbols, just the name of the assay or sample.

To apply plexes, assays, and samples to wells

1. On the Plate tab, select and highlight the plate you want. The plate opens automatically. Empty wells are colored white.
2. Click the Assay Groups tab to make it active.
3. Apply selected plexes or individual assays to the appropriate wells. More than one assay can be applied to the same well.

**Note:** To apply a plex or an assay to the entire plate, select all the wells, and apply the plex or assay.

- In the navigation tree, locate the plex or individual assay that you want to apply to one or more wells, and click it.
- Highlight the target wells.
- From the View menu, select **Apply**.
  OR
  Right-click the selected wells, and choose **Apply**.

The selected plex or individual assay is applied to the wells, and the wells appear light blue.

**Note:** You can select either wells before the plex (or assay) or the plex (or assay) before the wells. Either order will work. The main idea is to highlight your choices. Once both are highlighted, select **Apply**.

4. Click the **Samples** tab to make it active.
5. Apply selected samples to the appropriate wells.
   - In the tree, locate the sample that you want to apply to one or more wells, and click it.
   - Highlight the target wells.
   - From the View menu, select **Apply**.
   OR
   Right-click the selected wells, and choose **Apply**.

Once the Apply command is selected, the sample name will appear in these wells.
The sample is applied to the wells. Once applied, the name of the sample appears in the wells.

6. From the File menu, choose **Save**.
   OR
   Click the **Save** toolbar button.
   OR
   Right-click the selected wells and choose **Save Plate**.

The status bar indicates the progress.

Samples may also be applied to a specific region on the plate. You can click and drag to select a region of wells, and then apply samples only to those selected wells.

**To apply samples to a region**

1. On the **Samples** tab, select the samples you want to apply.
2. On the Options menu, choose **Sample Group - Stay in Select Region**.
3. On the plate layout, click a well, and then drag the cursor across a region of the plate.
   The selected region becomes highlighted.
4. Right-click the selected region, and choose **Apply**.
   The samples are applied to the region, as shown in the illustration below.

![Samples tab](attachment:image.png)

The dark blue wells indicate the selected region, which contains the applied samples.
Applying Assays by Pasting from Microsoft® Excel

Assays can be pasted from a Microsoft® Excel worksheet to a plate. Pasting assays to a plate applies each assay to its designated well in the plate. It has the same effect as moving to the Assay Groups tab and applying each assay individually. (See “Applying Assays and Samples to Wells” on page 58 for more information about applying assays individually.)

In order to paste assays to a plate, your Excel worksheet must specify the following in each row:

- Well number
- Assay name
- Assay Group name
- Assay Project name

**Important**: The assay and assay group names in the Excel worksheet must be the exact names of existing assays, assay groups, and assay projects. The assay, assay group, and assay project names are case-sensitive—whether a letter is capitalized or lowercase makes a difference.

**To paste assays from Excel**

1. In Excel, select the group of cells containing the assays you want to copy. Each row in your selection must be comprised of: a well number, an assay name, an assay group name, and an assay project name (in that order).
2. On the Edit menu, select Copy. (Or, press Ctrl + c on the keyboard.)
3. In PlateEditor, click the Assay Groups tab and select the plate to which you want to paste the assay information. For more information, see “Selecting Plates” on page 38.
4. Make sure the plate you have selected is not read-only. Plates for which data have been processed cannot be modified—they are “read-only.” To check whether the selected plate is read-only, look at the title bar of the PlateEditor window. The plate is listed at the end. If “(Read-Only)” appears after the plate name, then it is read-only. You cannot paste assay information to the plate. If you want to apply your assays to the sample plate of samples, then create a copy of the plate and recall the data for it. (See “Recalling Plate Data” on page 97 for information.)
5. Click the plate you want, and then right-click it again and select Plate Content. The Plate Content dialog box appears.
6. Insert rows if necessary.
Make sure there is enough room in the grid for the assays you want to paste. If you choose to paste to rows already containing assays, the existing rows will be overwritten with the pasted information. If you do not want to overwrite the existing rows, you must insert rows.

To insert rows, right-click the row at which you want to insert new rows, and then select either Insert 1 or Insert 100. (Insert 1 inserts a single row, Insert 100 inserts 100 rows.)

**Note:** When you insert rows, the row numbers at the left may appear out of order. This does not affect the assay information or how it is applied to the plate.

**Note:** If you are pasting to a plate that already has assays assigned to its wells, there may not be enough rows to accommodate the pasting of additional assays. For a plate that already has assays applied, the Plate Content dialog box shows only one more row in the grid than the number of assays. For example, if a plate has only ten assays applied to it, the Plate Content dialog box shows only eleven rows, the last being blank. You must insert enough rows to fit the number of rows you will paste. Rows are not automatically added to fit what is pasted into the grid.

7. In the Well column, right-click the cell in which you want to start pasting and select Paste.

   ![Plate Content dialog box]

The assays you copied from the Excel worksheet are pasted into the grid, beginning at the cell you right-clicked.

**Note:** If there are not enough rows in the grid to fit all the pasted assays, then only those assays fitting the rows in the grid are pasted. Any remaining assays past the number of rows in the grid are not pasted.

8. Click OK.

The assays are applied to the plate.
If a message appears indicating a well ID is illegal, then the row listed in the message has a well number that is not valid for the plate format (either 96- or 384-well). Click OK and correct the well number.

If a message appears indicating a problem with an assay or assay group, then the row listed in the message has an invalid assay name or assay group name. Most likely, the assay or assay group name is misspelled, or it does not exist. Click OK and correct the assay or assay group name.

**Applying Sample Groups**

If you have samples in a group, you can quickly apply the entire group to a plate. In the tree select the group, then right-click a well in the plate and point to apply. If Horizontal Sample Group is selected on the Option menu, the samples fill each well in order of left to right in the first selected row, then left to right in the second row, and continues until the plate is filled or the sample group ends. If you prefer to fill the wells vertically, then from the Options menu select Vertical Sample Group. This will apply the samples in the group from top to bottom in the first column, then top to bottom in the second column until the plate is filled or the sample group ends.

**Note:**
The Option menu has a check mark next to the method by which the sample group will fill the wells. If you want to use the other method, select it.

**To apply a sample group to a plate**

1. Open a plate.
2. Select the Samples tab.
3. In the navigation tree, highlight the sample group you want to apply.
4. In the plate grid, right-click a well and choose Apply.
   The samples apply to each well, left to right, row by row, or top to bottom, column by column. (The order in which the samples are applied depends on the method checked in the Option menu.)
5. From the File menu, choose Save.
   OR, click the Save toolbar button.
   OR, right-click a well and choose Save Plate.
   The status bar indicates the progress.
Applying Sample Groups Using 4(96) to 1(384) Mapping

The 4(96) to 1(384) mapping option applies a sample group to the wells of a plate in the same way that certain automated pipettors transfer material from four 96-well plates to a single 384-well plate. This transfer scheme is illustrated below.

The wells of each 96-well plate are mapped “horizontally” across the 384-well plate (to illustrate, the mapping of wells A1, A2, and A3 of 96-well plate 1 are indicated here by arrows).

The wells of the 96-well plates are mapped to every other well in every other row. The mapping of wells for 96-well plate 1 begins with well A1 of the 384-well plate. The mapping for 96-well plate 2 begins with well A2. The mapping for 96-well plate 3 begins with well B1. And the mapping for 96-well plate 4 begins with well B2.

Note: The 96-well plates and 384-well plate are not shown to scale. The 96-well plates are depicted smaller, relative to the size of the 384-well plate, for illustrative purposes.

In Typer, you can apply samples to a plate in the manner depicted above by having a separate sample group represent each of the 96-well plates and then applying the sample groups using the 4(96) to 1(384) mapping option. See the following instructions.
To apply a sample group using the 4(96) to 1(384) mapping

Note: The 4(96) to 1(384) mapping should be used only with sample groups containing 96 samples. Additionally, the samples should be applied to only 384-well plates.

1. In the Plate tab, select a plate.
   For more information about selecting a plate, see “Selecting Plates” on page 38.
2. Click the Samples tab.
3. In the Samples tables tree, click the sample group you want to apply.
   - Sample Tables
   - SampleGroupLine
   - SampleGroupTwo
   - test

Sample Samples tables tree

4. On the Options menu, select Horizontal Sample Group.

Note: If a check mark already appears next to Horizontal Sample Group, do not select it. It is already selected—selecting it again would de-select it.

5. On the Options menu, select 4(96)--> 1(384) Map Sample Group.

Note: If a check mark already appears next to 4(96)--> 1(384) Map Sample Group, do not select it. It is already selected—selecting it again would de-select it.

6. Determine from which well you want to start applying the samples.
   You should start from well A1, A2, B1, or B2. See the following illustration.

Starting from well A1, samples would be applied as shown here (the numbers are sample names)

Note
Samples are applied in the order in which they appear in the sample group. In the illustration to the right, "1" is the first sample in the sample group, "2" is the second, "3" is the third, and so on.
7. In the plate diagram, right-click the well from which you want to start applying the samples and choose Apply.
The samples are applied to the plate wells.

8. To apply additional sample groups to the current plate, repeat these steps (from step 3).

**Viewing Applied Assays and Samples**

Use the **List Items** tab to identify the assays and samples that are applied to the plate. Expand the tree nodes and click a specific item that you want to locate on the plate. Once selected, its location is indicated by a color change in the plate grid. Assays appear red and samples appear green.

**To view where the assays and samples are applied**

1. Select the **List Items** tab.
2. Click the plus symbol (+) to expand the tree.

3. Click a tree item, and its corresponding locations appear in the grid.
   - Assays appear red.
   - Samples appear green.

**Note:** In the tree, an assay’s group name is shown in parentheses next to it. Similarly, a sample’s group name is shown in parentheses next to it.

4. If the plate needs editing, return to the **Assay Groups** tab or **Samples** tab and make the edits.

5. To save the plate, from the **Plate** menu, select **Save**.
   Or, click the **Save** toolbar button.
   Or, right-click the plate grid and choose **Save Plate**.
   The status bar indicates the progress.
Defining Plates
Checking Assay Masses

Checking Assay Masses

Use the Check Assay Masses option to check for mass conflicts when multiplexing.

To check assay masses

1. On the Options menu, select Check Assay Masses.

The Check Assay Masses dialog box appears.

The Check Assay Masses dialog box lists:
- Assays that are within 50 Da of each other.
- Assays that are within 5 Da of each other.

Note: There are no duplicate entries between the two boxes. That is, if multiplexed assays are within 5 Da of each other, they appear only in the box listing conflicts within 5 Da. They do not appear in the box listing conflicts within 50 Da.

Important: You must correct any conflicts within 5 Da. Typer cannot resolve mass peaks within 5 Da of each other.

2. When you are done viewing mass conflicts, click Close.

Working with Plates

Clearing Wells

You can remove the assays or samples that are currently applied to wells. If you want to change what is applied to a well, clear the well before applying the proper assay or sample. If an existing plate can be used to create a new plate, make a copy.

To clear a well

1. On the navigation tree, select the plate whose wells you want cleared.
2. On the plate grid, highlight the wells you want cleared.
3. On the Plate menu, select Clear. OR, right-click the selected wells, and then choose Clear.
The assays or samples are removed from the selected wells.

**Opening Plates**

The Plate tab shows all the plates present in the database in a navigation tree organized by Customer and Project.

- **To open a plate**
  1. On the Plate tab navigation tree, select a plate.
  2. The contents of the plate are displayed in the plate grid.

**Copying Plates**

If you want to create a copy of an existing plate, use the Copy to new plate command. See the following steps.

- **To copy a plate**
  1. On the Plate tab, select the plate you want to copy from the Customer\Project\Plate navigation tree.
  2. Right-click the selected plate, and choose Copy to new plate.
  3. The Copy To New Plate dialog box appears.
  4. Enter a name for the new plate.
  5. If the plate does not require further editing, select the Save New Plate Automatically option.
  6. Click OK to create the plate or Cancel to discontinue the operation.
  7. If you did not choose to save the plate initially, you must now save the plate manually. To do so, select Save on the File menu.
Deleting Plates

**Note:** If a plate has data in it, you must have database administrator privileges to delete the plate.

### To delete a plate

1. On the **Plate** tab, select the plate to be deleted on the **Customer\Project\Plate** navigation tree.
2. Right-click the selected plate, and choose **Delete Plate**.
3. In the confirmation dialog box that appears, click **OK** to delete the plate or **Cancel** to discontinue.

### Using the Plate Assistant

The Plate Assistant is designed to allow you to create many similar plates easily. The Plate Assistant is limited to plates containing a single, same assay in all wells (that is, not multiplexed).

### To create multiple plates using Plate Assistant

1. On the **Plate** menu, select **Plate Assistant**.
   
   The **Plate Assistant** dialog box appears.

   ![Plate Assistant dialog box]

   **Plate Assistant** dialog box

2. Select a Customer and Project from the upper navigation tree.
3. Type a plate name in the **Plate** box.
4. Select an assay from the Assay Project/Assay Group/Assay navigation tree.
5. (optional) Select a sample from the Sample navigation tree.
6. Verify the **Plate Type** and **Sample Group** options are correct.
7. Click **Create Plate** to create the plate.
8. Click **Exit** to close the dialog box.

### Projects

**To create a new project**

1. On the **Plate** tab, select an existing customer.
2. Right-click the selected customer, and choose **New Project**. The **New Project** dialog box appears.

   ![New Project dialog box]

3. Type a name in the **Project ID** box.
4. The remaining boxes are optional. Type values in these boxes if desired.
5. Click **OK** to save the project or **Cancel** to discontinue.

**Tip: Rename Project**

It is possible to change the name of a project without using the **Project** dialog box. In the navigation tree, click the project name in the tree to highlight it, and click again so a cursor appears. Type a different name, and then press the <Enter> key. A confirmation dialog box appears; click **Yes** to change the name or **No** to discontinue.

**To edit an existing project**

1. On the **Plate** tab, select a project.
2. Right-click the selected project, and choose **Edit Project**. The **Project** dialog box appears.
3. Make any changes you want.
4. Click **OK** to save the changes or **Cancel** to discontinue.
Customers

To create a new customer
1. On the Plate tab, select the root of the Plate tree labelled Customer\Project\Plate (the root level of the navigation tree) to highlight it.
2. Right-click the root level, and choose New Customer. The New Customer dialog box appears.
3. Fill in the required fields and any optional fields you want.
4. Click OK to save the customer or Cancel to discontinue.

To edit an existing customer
1. On the Plate tab, select an existing Customer to highlight it.
2. Right-click the selected customer, and choose Edit Customer. The Customer dialog box appears.
3. Make any changes you want.
4. Click OK to save changes or Cancel to discontinue.

Hiding Plex Numbers

If you have assays from previous versions of Typer, they are imported as uniplexes into the current version of Typer. As a result, you may prefer to view the navigation tree without plex numbers.

To hide plex numbers
1. On the Options menu, select Hide Plex Groups so a check mark appears. (The option is "on" when the check mark appears.)
   The navigation tree is updated to display assays without grouping them into plexes.

To show plex numbers
1. On the Options menu, select Hide Plex Groups so the check mark disappears.
   The navigation tree is updated to display assays grouped into plexes.
Setting Multiplex Colors

Multiplexes (multiple assays run in a well) are distinguished by the color of the well shown in the PlateEditor grid. There are eleven default colors (one for empty wells and ten for multiplexes) provided with PlateEditor. You may change any of these colors settings using the Color Preferences menu option.

To change the multiplex colors

1. On the Options menu, choose Color Preferences. The Color Preferences dialog box appears.

2. For any multiplex type, choose a new color by selecting it from the drop-down list of colors.
3. To reset the colors to their original default settings, click Defaults.
4. Click Apply to save your color changes.

Tip: Choosing Colors
The illustration to the right shows the default colors selected in the Color Preferences dialog box. You may want to change the colors so they better correspond to the number of plexes in a well. For example, set the colors from lighter to darker shades (from 1-plex to 10-plex). This way, higher plexes stand out as wells with darker colors.
Creating Oligo Files

Use PlateEditor to create text files for use with your oligonucleotide vendor.

**To create oligo files**

1. On the **Plate** tab, select a plate or project.
2. Right-click the selected plate or project, and choose Make Oligo File.
   The *Create Oligo Files from Project* dialog box appears.

   ![Create Oligo Files from Project dialog box](image)

3. Click the **Browse** button.
   The *Browse for Folder* dialog box appears.
4. Select a file, and then click **OK**.
5. In the **Extension** box, type the file extension type of the selected file.
6. Click **OK**.
Chapter 5

Acquiring Spectra

Introduction

The ACQUIRE module of Typer controls a MassARRAY analyzer (analyzer, also referred to as a Biflex) to acquire spectra from SpectroCHIPs. As each SpectroCHIP is processed by the analyzer, the spectral data is automatically processed and saved to the MassARRAY database (which resides on a MassARRAY Typer Server).

There are two computers connected to an analyzer. There is a computer that directly connects to and controls the analyzer (referred to as a Sun workstation). Additionally, there is a MassARRAY Typer Workstation (Typer Workstation) connected to the Sun workstation. The Typer Workstation is used to operate the analyzer. The Typer Workstation communicates with the Sun workstation, which directly controls the analyzer. Spectral data acquired from SpectroCHIPs is sent back to the Typer Workstation which processes it and in turn sends the data to the Typer Server where it is stored in the MassARRAY database.

Note: ACQUIRE is available only on a Typer Workstation. It is not available on a Typer Server or on Typer Clients.

This chapter covers the basic use of Typer to acquire spectra from SpectroCHIPs. Two Typer modules are used: ACQUIRE and Plate Editor. In addition, some operations must be performed on the Sun workstation.

Note: It is assumed that you already have plates defined for the SpectroCHIPs you will run—that is, you have defined assays and samples, and applied them to plates. You must have plates defined before following the instructions in this chapter. For information about defining assays, samples, and plates, see “Chapter 3 Defining Assays” on page 11 and “Chapter 4 Defining Plates” on page 35.

Overview of Acquiring Spectra

This section provides an overview of the main steps involved in acquiring spectra from SpectroCHIPs and saving the spectral data to the MassARRAY database.

The main steps are:

1. Start ACQUIRE (only if it is not already running).
2. Select a geometry file in the XACQ software. (only if the appropriate one is not currently selected)
3. Load SpectroCHIPs.
4. Use Chip Linker to associate SpectroCHIPs and experiments. (if you have MassARRAY Tracking, this is not necessary)
5. Select the number of shots and raster positions.
6. Turn on the high voltage.
7. Set SpectroCHIP geometry options.
8. Start the automatic run.
9. Unload SpectroCHIPs.
Starting ACQUIRE

The remaining sections in this chapter cover each of these main steps in detail. Follow the instructions in the sections, in the order in which they appear.

The ACQUIRE module of Typer controls the analyzer to acquire spectra from SpectroCHIPs.

ACQUIRE should be running already. If it is not running, start it. See the following instructions.

Caution: Before you start ACQUIRE, make sure it is not already running. Do not attempt to start ACQUIRE if it is already running.

To start ACQUIRE

1. On the Sun workstation, start the ServerControl.tcl program.

   ![File Manager window on the Sun workstation]

   When you double-click ServerControl.tcl you are asked if you want to run the application in a Shell Tool or without one. Select No Shell Tool.

   Double-click ServerControl.tcl to start the program

2. On the Sun workstation, if it is not already running, start the XACQ software.

   To start the XACQ software, right-click anywhere on the Sun workstation desktop. On the menu that appears, right-click TOF. Next, right-click XACQ 4.0. Then, left-click Start.
The XACQ software windows appear. See the following illustration.

3. On the Typer workstation, make sure the CALLER program is currently running. See the following illustrations.

CALLER
A program that runs in the background. It calls genotypes as spectral data are acquired.

CALLER icon
If CALLER is currently running, the CALLER icon appears in the system tray

System tray on the Windows taskbar (lower right of screen)

If CALLER is not currently running, double-click the CALLER icon on the Windows desktop

CALLER desktop icon

4. On the Windows desktop, double-click the MassARRAY folder open it. Then, double-click the RT-Workstation folder.

Caution: Do not start or quit ACQUIRE while the Automatic Probe Introduction program on the Sun workstation is in the process of loading or unloading a SCOUT plate. At any other time, you can start or quit ACQUIRE. For more information about the Automatic Probe Introduction program see “Loading SpectroCHIPS” on page 83.
5. Double-click the ACQUIRE icon.

The ACQUIRE window appears.

If the following message appears, you must start the ServerControl.tcl program on the Sun workstation.

If this message appears, click Yes to this message.

If this message appears, start the ServerControl.tcl program on the Sun workstation (see step 1) and then click Yes to this message.

If this message appears, click OK and start the XACQ software on the Sun workstation (see step 2). Then, on the Typer Workstation, click the ACQUIRE button again.

If this message appears, click Yes to this message.
On the Sun workstation, in the XACQ software, the geometry file for the type of SpectroCHIPs you are running must be selected. A geometry file specifies the format and nominal well locations of a SpectroCHIP (i.e. whether it has 96 or 384 wells and how many calibrant wells it has). Typically, the correct geometry file will already be selected.

On the Sun workstation, you can see which geometry file is currently selected by looking for the geometry file window. See the following illustration.

Geometry file window on the Sun workstation

The geometry file window should show **384_epad_tzz** for 384-well SpectroCHIPs.

**Note:** You may only process barcoded, 384-well SpectroCHIPs with Typer 3.1.

If the geometry file window does not show the correct file for the type of SpectroCHIPs you use (or if there is no geometry file window at all), complete the following steps to choose the correct file.
To select a geometry file

1. On the Sun workstation, in the XACQ window, left-click the AutoX menu.

   ![XACQ window on the Sun workstation]

   Left-click AutoX

2. On the AutoX menu, left-click Load ProbeGeometry.

   The Geometry Files dialog box appears.

3. Click 384_epad_tzz for 384-well SpectroCHIPS.

   **Note:** You may only process barcoded, 384-well SpectroCHIPS with Typer 3.1.
Use the Chip Linker module to associate SpectroCHIPs with experiments to be processed. This module generates the input files required by MassARRAY Typer RT Workstation for processing the SpectroCHIPs.

**Opening Chip Linker**

1. In the MassARRAY folder on the Windows desktop, double-click the Typer 3.1 folder or the RT-Workstation folder to open it. (Open either folder. Each one contains a copy of the Chip Linker shortcut icon.)

2. Double-click the Chip Linker shortcut icon to open the application.

   The Database Info dialog box appears.

3. Type a user name and password.

4. Select a server from the DB Host drop-down list.

5. Click Enter.

   The MassARRAY Typer Chip Linker window appears.

**Associating SpectroCHIPs and Experiments**

1. In the MassARRAY Typer Chip Linker window, select a plate from the navigation tree.
2. Select Genotype, Genotype + Area, or Allelotype from the **Process Method** drop-down list.

3. Select the nanodispenser used to dispense to the SpectroCHIPS from the **Dispenser** drop-down list.

   "Nanodispenser R" indicates a Robodesign pintool; "Nanodispenser S" indicates a Samsung pintool.

4. Type a name for the group of SpectroCHIPS in the **Experiment Name** box.

   For example, allelotyping requires the use of four SpectroCHIPS. The Experiment Name is the name for this group of four SpectroCHIPS.

5. In the **Chip Barcode** box, type a name for the chip.

   After typing the name, copy it to the Windows clipboard. Later, in **ACQUIRE**, you will paste this name into the **Plate** box.

6. Click **Add** to add the plate to the selection table.

7. Continue to add plates as needed. (Follow Steps 1-6 above.)

8. After you have added all plates to be included in the **ACQUIRE** run, click **Create** to create the input files used by the MassARRAY Typer RT Workstation.

   The selection table is cleared after the input files are created.

### Removing Plates from the Selection Table

You can remove plates from those listed in the selection table.

**To remove a plate from the selection table**

1. In the **MassARRAY Typer Chip Linker** window, click a plate in the selection table.

   A plate is selected when its row in the selection table becomes highlighted.

2. Click **Remove**.

   The selected plate is removed from the selection table. This plate will not be included when you create input files for the MassARRAY Typer RT Workstation.

### Changing Plate Entries

After a plate has been added to the selection table, you can change the information associated with it.

**To change plate entries**

1. In the **MassARRAY Typer Chip Linker** window, click a plate in the selection window.
A plate is selected when its row in the selection table becomes highlighted.

2. Click **Change**.

Details for the selected plate appear in the boxes on the top-right of the **MassARRAY Typer Chip Linker** window.

3. Change the plate information as needed.

4. Click **Add** to add the updated plate to the selection table.

Place the SpectroCHIPs from which you want to acquire spectra into the SCOUT plate. In ACQUIRE (on the Typer Workstation), name each SpectroCHIP. Use the Automatic Probe Introduction program on the Sun workstation to load the SCOUT plate. See the following for more detailed instructions.

**Important**: Use only the SCOUT plate supplied with the analyzer. Do not use any other SCOUT plate (for example, from the MassARRAY nanodispenser).

**To load SpectroCHIPs**

- **Note**: If the SCOUT plate is currently in the analyzer, you must first unload it before following this procedure. See “Unloading SpectroCHIPs” on page 94.

1. Insert the SpectroCHIPs into the SCOUT plate.

Orient each SpectroCHIP so the SEQUENOM logo is at the bottom. Also, make sure each SpectroCHIP is seated flush to the lower-left corner of its chip well in the SCOUT plate.
Caution: To perform allelotyping analysis, you must use allelotyping SpectroCHIPs. You can identify allelotyping SpectroCHIPs by the bar code imprinted on them. A “datamatrix” code is imprinted on the lower left corner. Above the datamatrix code is the alphanumeric translation of the code—this should begin with the letter “A.” The bar code of an allelotyping SpectroCHIP always begins with the letter “A.”

2. On the Typer Workstation, if it is not already running, start ACQUIRE.

For information on starting ACQUIRE, see “Starting ACQUIRE” on page 76.

Caution: If ACQUIRE is already running, do not click the ACQUIRE button (in the MassARRAY Typer Workstation window).

3. Click the Auto Run Set Up tab.

4. In the Plate box, type the name of the first plate (as specified in the Chip Barcode box in Chip Linker). Then, click Get Plate.

The chip names are automatically inserted into the Chip boxes.

The name you type in the Plate box must be the same as the name given to the chip in Chip Linker. (For information on using Chip Linker, see “Using Chip Linker to Associate Chips with Experiments” on page 81.)
(If you have MassARRAY Tracking, do not type names; see the MassARRAY Tracking note below.)

Each Chip box above corresponds to a position in the SCOUT plate. Note that the Chip boxes are numbered 1-10, but the positions in the SCOUT plate are numbered 0-9. Chip 1 corresponds to the first SCOUT plate position, 0; Chip 2 to the second position, 1; and so on. SCOUT plate positions are shown in the diagram to the right.

MassARRAY Tracking: If you have MassARRAY Tracking, do not type SpectroCHIP names in the Chip boxes. Simply check the box next to the Chip box for each SpectroCHIP you plan to run. Checking this box tells ACQUIRE to read the bar code from the SpectroCHIP.

5. Leave ACQUIRE running; do not quit it.

6. Open the load lock door of the analyzer, insert the SCOUT plate, and close the load lock door.
7. On the Sun workstation, in the Automatic Probe Introduction program, click Probe in.

![Automatic Probe Introduction program (on the Sun workstation)](image)

**Caution:** Do not start or quit ACQUIRE on the Typer Workstation while the Automatic Probe Introduction program is in the process of loading a SCOUT plate.

Also, do not start an automatic run while the Automatic Probe Introduction program is in the process of loading a SCOUT plate.

8. Once the green Ready indicator is lit, you may use ACQUIRE on the Typer Workstation to acquire spectra from the SpectroCHIPs.
Selecting the Number of Shots and Rastering Options

In ACQUIRE, on the Auto Run Set Up tab, under Acquisition Parameters, set the number of shots you want, the number of raster positions, and rastering options. See the following for detailed instructions.

To select the number of shots and rastering options

1. On the Auto Run Set Up tab, under Acquisition Parameters, type the number of shots you want in the Shots \([n]\) box.

   It is recommended you enter 20 in the Shots \([n]\) box when using Typer.

2. In the Maximum Acquisitions box, type the maximum number of raster attempts you want.

   Enter a number between 1 and 9. Entering 1 means you do not want the analyzer to raster at all—spectra is acquired from only the center of the well.

   By default, the spectra is acquired from the center of the well. In addition, rastering proceeds around eight different positions around the SpectroCHIP well. First around the corners and then around the sides. The illustration to the right shows the raster positions (the numbering indicates the order of rastering). The number you type in the Maximum Acquisitions box determines how many of the raster positions you want attempted. For instance, typing 5 means you want the center of the well plus the first four positions attempted.

   Note: Not all raster positions you specify may be attempted. You are specifying only the maximum number of raster positions you want to try. The analyzer will move on to the next SpectroCHIP well when either good spectrum is acquired or the maximum number of raster positions has been attempted. For multiplexed assays, this criteria is applied to each assay individually; i.e. the analyzer moves on when good spectrum is acquired or the maximum rasters have been attempted for each assay.

   Caution: If you are running allelotyping SpectroCHIPs, set Maximum Acquisitions to 5. This means spectra will be acquired from five positions on the well (the center plus four raster positions).

3. Type the minimum and maximum number of good spectra to acquire.

   See “Acquisition Parameters Values” on page 88 for a description of these values.

4. Check Enable Smart Raster to automatically disable rastering if too many SpectroCHIP wells are failing.

Rastering

If the initial acquisition yields an unacceptable spectrum, you may have the analyzer “raster.” When the analyzer rasters, it aims the laser a little off the center of the SpectroCHIP well and acquires another spectrum.

Recommended Values

If you are using Typer 3.1, see Table 2 on page 89 for the recommended values for the options listed under Acquisition Parameters.
Smart rastering saves time by disabling rastering when a SpectroCHIP is found to have too many wells providing bad spectra. By default (when smart rastering is enabled), after two wells in a row fail, rastering is disabled. Also, in a given well, if three raster positions in a row fail, then remaining raster positions on that well are skipped.

Use the **Smart Raster Properties** button to set the criteria that determines when rastering will be disabled. Typically, you should use the default settings of two failed wells and three failed raster positions. However, if you want to change the settings, see the following illustration.

**Acquisition Parameters Values**

The Acquisition Parameters values represent the following:
- **Shots** indicates the number of laser shots attempted during processing.
- **Maximum acquisitions** indicates that the acquisition will stop when the specified number of acquisitions is complete.
- **Minimum good spectra** means collect the specified number of spectra before starting analysis.
- **Maximum good spectra** means to stop acquisition once the specified number of spectra is collected.
- **Enable Smart Raster** applies to genotyping only. It indicates that the system will stop calling assays that fail consecutively.

Table 2 on page 89 provides recommended values for the options under Acquisition Parameters (except **Shots**, which you should determine separately).
Turning on the High Voltage

Make sure the high voltage is on. If you are leaving the analyzer to run overnight, choose to have the high voltage turned off automatically after the last SpectroCHIP is run. See the following for detailed instructions.

- **To turn on the high voltage**
  - In the **Auto Run Set Up** tab, under **Instrument**, make sure the **High Voltage** button is red.

- **To automatically turn off the high voltage after the last SpectroCHIP**
  - Check the **Turn Off HV after last chip is complete** option.

  After the last SpectroCHIP has been run, the high voltage will be shut off automatically. This is useful if you will leave the analyzer to run overnight.

Setting SpectroCHIP Geometry Options

SpectroCHIP geometry refers to the format (96- or 384-wells), whether calibrant wells are used, and the order of processing the sample wells. See the following for detailed instructions on setting SpectroCHIP geometry options.

- **To set SpectroCHIP geometry options**
  1. On the **Auto Run Set Up** tab (under **Geometry**), **Auto Teach Geometry** should be checked.

     When this option is checked, the positioning of each SpectroCHIP in the SCOUT plate is checked. ACQUIRE can correct for small variations in the positioning of each SpectroCHIP.

  2. Check the **Use Calibration Wells** option if you want the calibrant wells on the SpectroCHIPs to be used.

---

**Table 2: Recommended Values for Acquisition Parameters**

<table>
<thead>
<tr>
<th>Option</th>
<th>Genotyping Value</th>
<th>Allelotyping Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Acquisitions</td>
<td>5 (uniplex) 9 (multiplex)</td>
<td>9</td>
</tr>
<tr>
<td>Minimum Good Spectra</td>
<td>1 (uniplex) 5 (multiplex)</td>
<td>5</td>
</tr>
<tr>
<td>Maximum Good Spectra</td>
<td>5 (uniplex) 5 (multiplex)</td>
<td>5</td>
</tr>
<tr>
<td>Enable Smart Raster</td>
<td>yes (uniplex) no (multiplex)</td>
<td>no</td>
</tr>
</tbody>
</table>
If you choose to use calibration wells, make sure calibrant has been dispensed onto at least one of the calibration wells on the SpectroCHIPs. (If you check **Use Calibration Wells** and there is no calibrant on the calibration wells, **ACQUIRE** will automatically use the last good calibration values.)

To start an automatic run, click **Start Auto Run** on the **Auto Run** tab. See the following for detailed instructions.

### To start an automatic run

1. In the **Auto Run Set Up** tab, click **Barcode Report**. The **Barcode Report** dialog box appears.

   **Note:** Running a bar code report is optional. However, it is strongly recommended. It allows you to check all chip positions before starting a run. During a run, each chip position is checked only as it is processed. All chip positions are not checked at the beginning of the run. If an error-status chip position is encountered, the run is stopped and any remaining SpectroCHIPs are not processed.

   ![Auto Run Set Up tab in ACQUIRE](image)

   ![Barcode Report dialog box](image)

   Each chip position should have a “FOUND” status, which means the SpectroCHIP is properly associated with an experiment in the MassARRAY database.

   An “Error” status means the SpectroCHIP has not been properly associated with an experiment (in this illustration, Chip 4 has an “Error” status). See “Using Chip Linker to Associate Chips with Experiments” on page 81.
2. Click **CLOSE** and correct any chip positions with an “Error” status.

**Caution:** You may start a run without correcting chip positions with an “Error” status. However, once an error-status SpectroCHIP is encountered the run will stop. Any remaining SpectroCHIPs will not be run.

3. Click the **Auto Run** tab.

4. Under **Run**, click **Start Auto Run**.

The automatic run begins. Each SpectroCHIP is processed as follows:

- SpectroCHIP name is checked. There must be an experiment associated with the SpectroCHIP name. If there is none, an error message appears and the run stops. (For information, see “Using Chip Linker to Associate Chips with Experiments” on page 81.)
- Positioning of the SpectroCHIP is checked (for more information, see “Autoteaching” on page 98).
- If calibrant wells are used, calibration spectra are acquired. (It is recommended you use calibrant.)
- Spectra are acquired from the wells on the SpectroCHIP.

**Caution:** The SpectroCHIP names are not all checked at the beginning of the run. The name of each SpectroCHIP is checked individually as ACQUIRE begins to process it. If you leave an automatic run to run overnight and ACQUIRE encounters a bad SpectroCHIP name, the run will stop at that SpectroCHIP. Click **Barcode Report** (on the **Auto Run Set Up** tab) to check all SpectroCHIPs before running them.
The following illustration shows a sample ACQUIRE window during an automatic run of genotyping or genotype+area SpectroCHIPs. (The window appears slightly different for allelotyping SpectroCHIPs; see the illustration on the next page.)

**Spectrum Display**
Shows the spectrum from each well as it is acquired (if multiple shots are taken, the spectrum shown is the sum of the spectra from the shots)

**Video Display**
Shows real-time video of the SpectroCHIP surface from the analyzer’s camera (the red cross-hairs indicate where the laser is aimed)

**Well Status**
Shows the call status of each SpectroCHIP well as spectrum is acquired

**SpectroCHIP Diagram**
Shows the status of each well using color codes:
- **Light blue** Waiting to be processed
- **Dark blue** Well will not be processed
- **Green** Conservative or moderate call (In multiplexed assays, all assays must yield a moderate or better call)
- **Red** Aggressive call, no call, bad spectrum, or no spectrum (In multiplexed assays, just one assay yielding an aggressive call, no call, or bad spectrum will cause the well to be marked in red)
  - Red may also mean no allele found. Primer peaks were found, but extension products were not detected. (Negative control generally gets a red well.)

**SpectroCHIP Information**
Shows the name and mapping type for the current SpectroCHIP; also, a SCOUT plate diagram shows the status of each SpectroCHIP using color codes:
- **Yellow** Currently being processed
- **Light blue** Waiting to be processed
- **Dark blue** Chip position is empty
- **Green** Processed
- **Red** Bad SpectroCHIP name

---

Note
Once ACQUIRE is done acquiring spectra from a SpectroCHIP, you can analyze the data (in SpectroAnalyzer or analyzer). The data is automatically processed and saved to the database.

The data from a particular SpectroCHIP may be available on the MassARRAY database before the entire SCOUT plate of SpectroCHIPs has been processed. Spectral data is processed and saved to the database on a chip-by-chip basis. As soon as a SpectroCHIP is done, Typer starts to save its spectral data to the database.
The following illustration shows a sample ACQUIRE window during an automatic run of **allelotyping** SpectroCHIPS. (The window appears slightly different for genotyping or genotyping+area SpectroCHIPS; see the illustration on the preceding page.)

**Spectrum Display**
Shows the spectrum from each well as it is acquired (if multiple shots are taken, the spectrum shown is the sum of the spectra from the shots)

**Video Display**
Shows real-time video of the SpectroCHIP surface from the analyzer’s camera (the red cross-hairs indicate where the laser is aimed)

**Well Status**
Shows information about each well as a spectrum is acquired from it:
- **Well**
- **AssayId**
- **Status**
- **Frequency**

**Note**
Once ACQUIRE is done acquiring spectra from a SpectroCHIP, you can analyze the data (in SpectroAnalyzer or analyzer). The data is automatically processed and saved to the database.

The data from a particular SpectroCHIP may be available on the MassARRAY database before the entire SCOUT plate of SpectroCHIPS has been processed. Spectral data is processed and saved to the database on a chip-by-chip basis. As soon as a SpectroCHIP is done, Typer starts to save its spectral data to the database.
To unload SpectroCHIPs

Caution: Do not unload SpectroCHIPs while ACQUIRE is acquiring spectra. Wait until the acquisition run is complete. If you want to stop the run before it is done, see “Stopping an Automatic Run” on page 96.

1. On the Typer Workstation, in ACQUIRE, turn off the high voltage on the analyzer.

Turning off the high voltage
2. On the Sun workstation, in the Automatic Probe Introduction program, click **Probe out**.

   ![Automatic Probe Introduction program](image)

   **Caution:** Do not start or quit ACQUIRE on the Typer Workstation while the **Automatic Probe Introduction** program is in the process of unloading a SCOUT plate.

   Also, do not start an automatic run while the Automatic Probe Introduction program is in the process of unloading a SCOUT plate.

3. When the green **Ready** indicator is lit, open the load lock door and remove the SCOUT plate.

4. Close the load lock door.
Stopping an Automatic Run

It is recommended you allow an automatic run to complete. However, if you must stop the automatic run before it is done see the following instructions.

To stop an automatic run

1. Under Run, click Stop Auto Run.

2. If spectra has been acquired from any SpectroCHIP wells, the following dialog box appears. (If spectra has not yet been acquired for the current SpectroCHIP, this dialog box does not appear; the run stops. Do not complete the remaining steps.)

   - Continue with the automatic run
     Resumes the run from where it left off.
   - Stop and discard the data that has been collected on the currently running chip
     Stops the run. Any spectral data acquired for the current SpectroCHIP is discarded. **Important:** If you want to rerun the SpectroCHIP later and save it to the experiment currently associated with it, select this option.
   - Stop and store the data from the current chip
     Stops the run. Any spectral data acquired for the current SpectroCHIP is saved to its associated experiment in the MassARRAY database. Since data is saved to the experiment, the experiment will no longer be available to receive future data. If you want to rerun the SpectroCHIP at a later time you will have to save its spectral data to another experiment.

3. Select how you would like to proceed and click OK.
Saving Current Settings

You can save the settings used for the current auto run. The settings and results for the currently displayed well are saved to a file.

**To save current settings**

1. After completing an auto run, click the **Manual Control** tab.

![Manual Control tab in ACQUIRE](image)

2. Click **Save Current** to save what is currently shown on the screen.

The settings used for the selected run are saved to a file.

3. If desired, change the path and file name listed in the **Root File Name** box.

This box specified where to save the file.

4. Click **Automatic Save** if you want to automatically save the settings and results after each well is processed.

This option is “on” when a check mark appears in the box.

Recalling Plate Data

You can recall a processed SpectroCHIP without rerunning a new SpectroCHIP.

**Note:** This feature only applies to MassARRAY CALLER used with Typer 3.1. If you are using CALLER with a different version of Typer, you cannot recall plate data. For assistance, contact Sequenom Customer Support toll free at 1 877 4 GENOME.

**To recall plate data**

1. In the **MassARRAY Typer Chip Linker** window, click a plate in the selection window.

A plate is selected when its row in the selection table becomes highlighted.

2. Click **Recall**.
The Select Recall Chip dialog box appears.

3. Select the SpectroCHIP to be recalled.

4. Click Recall.

**Note:** If the Recall button is grayed out, MassARRAY Caller is not set to use Typer 3.1. For assistance, contact Sequenom Customer Support toll free at 1 877 4 GENOME.

The recall process may take a few moments to complete. Once the recall is completed, you can return to using Chip Linker.

**Autoteaching**

When autoteaching is turned on (recommended), the positioning of each SpectroCHIP is checked before spectra are acquired from it. ACQUIRE corrects for small variations in the positioning of SpectroCHIPS.

The positioning of each SpectroCHIP is checked by examining wells A2 to H2, forward and back. The video display, in the upper left of the ACQUIRE window, will show autoteaching cross-hairs in addition to the laser cross-hairs (see right). ACQUIRE finds the location of each well and places the auto teaching cross-hairs on it. The difference between the location of the auto teaching cross-hairs and the laser cross-hairs is found for each of the wells A2 to H2. The differences between the laser and autoteaching cross-hairs for the wells are averaged. This average difference is used as an offset to correct the positioning of the SpectroCHIP. After autoteaching, the autoteaching cross-hairs disappear.

**Note:** If ACQUIRE is unable to find one of the autoteaching wells (A2 to H2), it will skip the well. You can tell that a well is not found by watching the video display during autoteaching. The autoteaching cross-hairs will not appear when a well cannot be found.

At least four of the autoteaching wells must be found for autoteaching to work. If less than four are found, no correction is applied to the SpectroCHIP.
Saving Parameters

Unless you save parameters, the auto run settings will revert to original default values if you quit and restart ACQUIRE.

**Important**: Do not quit ACQUIRE, unless you are instructed to by SEQUENOM.

**To save parameters**

- On the **Tools** menu, select **Save Parameters**.
  The current settings are saved. If you quit ACQUIRE and restart it, the current settings will still be in place.

Tools Menu

The **Tools** menu of the ACQUIRE window contains three options: **Configure**, **Image Processing**, and **Save Parameters**.

Unless instructed to do so by SEQUENOM, do not select **Configure** or **Image Processing**. These options access configuration settings for ACQUIRE. These configuration settings should not be changed.

The **Save Parameters** option may be used to save the current auto run settings. See “Saving Parameters” above.

Quitting ACQUIRE

**To quit ACQUIRE**

- On the **File** menu, select **Exit**.

**Important**: Do not quit ACQUIRE, unless you are instructed to by SEQUENOM.
Notes:
Chapter 6

Reviewing Processed Data with TyperAnalyzer

Introduction
This chapter covers using TyperAnalyzer to view results after data is processed from the analyzer by the ACQUIRE module (on the Typer Workstation).

Similar to the Genotype Analyzer module (see “Chapter 7 Reviewing Processed Data with Genotype Analyzer” on page 127), TyperAnalyzer is used to view and analyze data from the analyzer. The TyperAnalyzer and Genotype Analyzer modules complement each other—they provide alternative ways to view the same data.

Note: Some TyperAnalyzer features apply only to genotyping, some only to allelotyping, and others to both types of analysis. Sections in this chapter applicable to only genotyping have "(Genotyping)" after their headings. Sections applicable to only allelotyping have "(Allelotyping)" after their headings. Sections applicable to both have plain headings, with no analysis type indicated.

Screen Resolution
When viewing results data in TyperAnalyzer, it is recommended you set the resolution of your computer screen to 1024 by 768. This screen resolution settings provides the best possible viewing of well data and processing results. (See the online help provided with Microsoft Windows for instructions on setting screen resolution.)

Genotyping
When genotyping, TyperAnalyzer is particularly well suited to viewing and analyzing multiplexed assays. It may also be used to view uniplex assays.
A selected plate is shown with its wells color-coded according the strength of the genotype calls made for each well. Green indicates conservative or moderate calls and red indicates aggressive or low probability calls.

Allelotyping
When allelotyping, you can quickly determine which wells are polymorphic (i.e. both alleles found) and non-polymorphic (only one allele found).

Note: To perform allelotyping you must have Typer 3.0 or later and an allelotyping license. Contact SEQUENOM, Inc. for information.
Starting TyperAnalyzer

To start TyperAnalyzer
1. In the Typer window, click TyperAnalyzer.

The TyperAnalyzer window appears.

Selecting an Experiment

On the left side of TyperAnalyzer is a tree control. Use the tree control to select the experiment under a plate from which you want to view data.

You can view an experiment using the following three ways:

- Project
- Assay
- Date

Note: While looking for an experiment, you can use the *, +, and - (asterisk, plus, and minus) keys on the numeric keypad, of the keyboard, to expand and collapse the whole tree or parts of it.
To select an experiment by project

- At the bottom of the tree control box, click the Project tab.

The illustration to the right shows the organization of the tree in the Project tab. Plates are organized by customer and project. First expand the customer containing your plate. Next, expand the project containing your plate. Under each plate are experiments and chips. To view spectra, select a chip under one of the experiments.

To select a chip by assay

- At the bottom of the tree control box, click the Assay Group tab.

The illustration to the right shows the organization of the tree in the Assay Group tab. Plates are organized by assay group and assay. Expand the assay group containing the assay you want. Under each assay are the plates to which the assay has been applied. Under each plate are experiments and chips. To view spectra, select a chip under one of the experiments.

To select a chip by date

- At the bottom of the tree control box, click the Date tab.

The illustration to the right shows the organization of the tree in the Date tab. The tree is organized by year, month, then day. Under a day are the plates run on that day. Under each plate are experiments and chips. To view spectra, select a chip under one of the experiments.
Color Codes (Genotyping)

Once you select a genotyping experiment (see “Selecting an Experiment” on page 103), its plate diagram appears with wells color-coded according to the strength of genotype calls.

<table>
<thead>
<tr>
<th>Color</th>
<th>Call Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Conservative or moderate call</td>
</tr>
<tr>
<td>Red</td>
<td>Aggressive or low probability call;</td>
</tr>
<tr>
<td></td>
<td>or bad spectrum</td>
</tr>
<tr>
<td>Blue</td>
<td>No allele</td>
</tr>
<tr>
<td>Yellow</td>
<td>None of the selected assays are</td>
</tr>
<tr>
<td></td>
<td>present</td>
</tr>
<tr>
<td>White</td>
<td>No data (i.e. spectrum) stored</td>
</tr>
<tr>
<td></td>
<td>and/or no assays applied to the well</td>
</tr>
</tbody>
</table>

Wells are color-coded according to the weakest call of all selected assays that were applied to it. A well is red if just one assay resulted in an aggressive or low-probability call (or if the well provided a bad spectrum).

Selecting Which Assays Are Shown

When you select a well in the plate diagram, the assays applied to the well appear in a table to the right (called the “assay table”).

The check boxes next to the assay names control how wells are color-coded in the plate diagram. The wells are color-coded according to all of the selected assays; selected assays are checked. If you clear the check box for one of the assays, then the wells are color-coded according to only those assays that remain checked.

Note

The coloring in the assay table is not related to the color-coding of the plate diagram. The coloring of the assay table follows the coloring convention of the results table in the Genotype Analyzer module (see Table 4, “Genotype Analyzer Color Codes for Genotyping,” on page 137).
De-select assays (by clearing the check box) to “filter” them out of the plate diagram. For instance, you may have a failed assay that results in weak calls for all wells. In that case, all wells are red. Filter out the failed assay by de-selecting it. The wells will be color-coded according to the remaining, selected assays.

Also, use the check boxes to view the strength of the calls for individual assays by de-selecting all but the assay in question. The wells will be color-coded according to only the selected assay.

**Color Codes (Allelotyping)**

Once you select an allelotyping experiment (see “Selecting an Experiment” on page 103), its plate diagram appears with wells color-coded according to assay status.

<table>
<thead>
<tr>
<th>Color Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Polymorphic (both alleles)</td>
</tr>
<tr>
<td>Blue</td>
<td>Non-Polymorphic (one allele) or No Allele</td>
</tr>
<tr>
<td>Yellow</td>
<td>Uncertain (The average frequency of one allele is less than or equal to 3 times the standard error of the frequencies before averaging.)</td>
</tr>
<tr>
<td>Red</td>
<td>Bad spectrum (a usable spectrum was not acquired from the well; the best spectrum acquired contains only noise)</td>
</tr>
<tr>
<td>White</td>
<td>No spectrum and/or no assay applied</td>
</tr>
</tbody>
</table>

Typically, yellow, red, or white wells should draw your interest. Yellow indicates it is uncertain whether the assay is polymorphic on a well. Red indicates the well provided a bad spectrum. White indicates no spectrum was stored by the analyzer for the well, or no assay was applied to the well.
Rather than viewing a color-coded plate diagram, you can view a table of all the calls for the plate (similar to the results table in the Genotype Analyzer module).

To view all calls

1. Click the MultiRow tab.

The MultiRow tab shows a results table of genotype calls for the plate wells.

![Example of a results table](image)

All calls are listed. Note that both calls and no calls are listed.

2. To view the spectrum for a call, click the call (i.e. row).

The spectrum appears in the spectrum display (upper right area of the TyperAnalyzer window).

You can manually call a genotype, i.e. you may choose the genotype yourself. Right-click the row and choose the genotype call you want to make. (See “Manually Calling a Genotype (Genotyping)” on page 116 for information.)

Note: When you manually call a genotype, the call will be noted as a “user call” even if you change it back to the original call.
Viewing a Results Table (Allelotyping)

Rather than viewing a color-coded plate diagram, you can view a table of well information (similar to the results table in the Genotype Analyzer module).

To view all well information (allelotyping)

1. Click the MultiRow tab.

The MultiRow tab shows a results table of well information.

2. To view the spectrum for a well, click its row in the results table.

The spectrum appears in the spectrum display (upper right area of the TyperAnalyzer window).
### Table 3: Results Table Contents for Allelotyping Plates

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE_ID</td>
<td>Sample name</td>
</tr>
<tr>
<td>CALL</td>
<td>Alleles present in the pool</td>
</tr>
<tr>
<td>ASSAY_ID</td>
<td>Assay name</td>
</tr>
<tr>
<td>WELL_POSITION</td>
<td>Well number</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>• Polymorphic: both alleles found&lt;br&gt;• Non-Polymorphic: one allele found&lt;br&gt;• Low Frequency: one of the alleles has a frequency of 0.06, i.e. 6%, or less and the standard error is less than 2%&lt;br&gt;• Uncertain: the average frequency of one allele is less than or equal to 3 times the standard error of the frequencies before averaging.&lt;br&gt;• Bad Spectrum: a usable spectrum was not acquired from the well; the best spectrum acquired contains only noise</td>
</tr>
<tr>
<td>CALIBRATION</td>
<td>• On: calibration spectrum was acquired and applied&lt;br&gt;• Off: calibration was not applied</td>
</tr>
<tr>
<td>MAX_SHIFT</td>
<td>Calibration offset applied to the spectrum</td>
</tr>
<tr>
<td>RASTERS</td>
<td>Number of raster positions from which spectra were acquired. An analyzer attempts to acquire spectra from five positions (raster positions) on a SpectroCHIP well, the center plus the four corners. &quot;5&quot; means spectra were acquired from all five positions. Anything less means spectra could be successfully acquired from only the indicated number of positions. Frequency estimates for an allele are generated by averaging the frequencies found from the successful raster positions.</td>
</tr>
<tr>
<td>AREA</td>
<td>Average area under the curve for the lower-mass allele. This is an average of areas found at all successful raster positions.</td>
</tr>
<tr>
<td>AREA2</td>
<td>Average area under the curve for the higher-mass allele. This is an average of areas found at all successful raster positions.</td>
</tr>
<tr>
<td>RESOLUTION</td>
<td>Mass value of the peak divided by the full width of the peak at half maximum</td>
</tr>
<tr>
<td>ALLELE_FREQUENCY</td>
<td>Weighted average frequency of the lower-mass allele. This is an average of the frequencies found at all successful raster positions.</td>
</tr>
<tr>
<td>ALLELE2_FREQUENCY</td>
<td>Weighted average frequency of the higher-mass allele. This is an average of the frequencies found at all successful raster positions.</td>
</tr>
<tr>
<td>FREQUENCY_VARIATION</td>
<td>Standard error of the frequency averages for both alleles found at all raster positions</td>
</tr>
<tr>
<td>PRIMER_PEAK_SCORE</td>
<td>Ratio of peak areas of the unextended-primer to unextended-primer+allele1+allele2</td>
</tr>
</tbody>
</table>
Viewing Spectra

The spectrum display shows the spectrum of the currently selected well, call, or assay.

Table 3: Results Table Contents for Allelotyping Plates (Continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAUSE_PEAK_SCORE</td>
<td>Ratio of peak areas of the pausing peak to pausing peak+allele1+allele2</td>
</tr>
</tbody>
</table>

Viewing the Spectrum from a Well

When you select a plate well, the spectrum display shows the spectrum acquired from the well. The spectrum is annotated with the expected location of allele peaks and the unextended-primer peak. In some cases, contaminant peaks or a pausing peak may be indicated (depending on whether you defined them in Assay Editor when creating the assay; see “Defining Assays” on page 11).

Note: When creating an assay in Assay Editor, to account for a pausing peak in spectra, you must define a contaminant named “Pause” at the appropriate mass value.

If the well is multiplexed (i.e. multiple assays are applied to it), then annotations for all assays are shown.
To view a spectrum showing all assays for a well

- In the plate diagram click a well. The spectrum appears. All assays applied to the well are shown. Each pair of alleles for each assay are shown in the same color. Each assay is shown as a different color.

Note
When viewing a spectrum showing multiple assays, the color assigned to each assay does not indicate anything. Different colors are assigned to each assay simply to differentiate it from the other assays.

![Sample spectrum display showing all assays for a well](image)

To view the spectrum for one assay (genotyping)

For multiplexed wells, a separate spectrum is saved for each assay (for more information, see the note above). Complete the following instruction to view the spectrum for a particular assay.

- In the assay table, click the assay you want to view.

Example of an assay table

<table>
<thead>
<tr>
<th>ASSAY ID</th>
<th>SAMPLE ID</th>
<th>CALL</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>00000277</td>
<td>AA</td>
<td>A, Conservative</td>
</tr>
<tr>
<td>4</td>
<td>662724</td>
<td>AA</td>
<td>A, Conservative</td>
</tr>
<tr>
<td>1</td>
<td>6627214</td>
<td>AA</td>
<td>A, Conservative</td>
</tr>
<tr>
<td>4</td>
<td>903889</td>
<td>AA</td>
<td>A, Conservative</td>
</tr>
</tbody>
</table>

Click an assay to view its spectrum

In the spectrum display, the spectrum for the selected assay is shown. To return to the view of a spectrum with annotations for all assays, click the well in the plate diagram.
Using the Spectrum Display Cross-Hairs

When you point the mouse cursor over the spectrum display it turns into cross-hairs (a cross) with lines extending across and down the display. Use the cross-hairs to find the coordinates of a point in the graph. See the following illustration.

Coordinates of the current location of the cross-hairs are listed here (mass, intensity)

Using the cross-hairs to find point coordinates

Zooming the spectrum display

You can zoom in on an area of the spectrum display.

To zoom the spectrum display

1. In the spectrum display, click the left side of the area into which you want to zoom and drag the mouse to the right.

2. When the zooming box encloses the area you want, release the mouse button.

The zoomed view remains for any subsequent spectra you view. To turn off the zoomed view, follow the instructions under “To un-zoom the spectrum display” on page 113.
To un-zoom the spectrum display

1. Right-click the spectrum and select **Undo Zoom**.

   You are returned to the top zoom level (that is, where no zooming is applied).

Viewing Calibrant Spectrum

You can display the calibrant spectrum at any time.

To view calibrant spectrum

- On the View menu, select **Display Calibrant Spectrum**.
  The spectrum display is updated with the calibrant spectrum.

Adjusting Spectrum Display

The spectra are not shown to the same scale along the y-axis (intensity). In one spectrum, the y-axis may go up to 500. In another, it may only go up to 350. Each spectrum is displayed with the y-axis scaled to best show the spectrum.

You can choose to view all spectra scaled to the same maximum y-axis value, allowing you to better judge the relative intensities of peaks in different spectra.

To adjust spectrum display

1. On the View menu, select **Spectrum Display**.
   The **Spectrum Display** dialog box appears.

   2. To specify a fixed height for the Y axis, click the **Enable Fixed Height** option so a checkmark appears. Then, in the **Height** box, specify a Y axis height.
      All spectra graphs will now use this height for the Y axis.

   3. To automatically zoom on all spectrum graphs, click the **Auto Zoom** option so a checkmark appears.
      This option may already be selected. If so, clicking it again removes the checkmark and turns off the option.

   4. Specify a mass margin in the **Left Margin** and **Right Margin** boxes.
The zoomed view will have the selected mass margin around it.

5. Click OK to save your changes.

Your settings are applied to all spectra displayed, unless you return to the Spectrum Display dialog box again to make changes.

Printing a Spectrum
You can print the spectrum display in either color or monochrome. If you are printing to a black-and-white printer, it is recommended you print in monochrome.

To print a spectrum in color
1. Click the spectrum. (Click anywhere on the spectrum display.)

2. On the File menu, select Print Spectrum.

Note: If the Print Spectrum option is not available, click the spectrum display again, and then select Print Spectrum. If the Print Spectrum option is still not available, make sure your printer is properly set up for your computer.

To print the spectrum in monochrome
1. Click the spectrum. (Click anywhere on the spectrum display.)

2. On the File menu, select Print Spectrum Monochrome.

The Printing <assay name> dialog box appears (where <assay name> is the name of the assay).

Note: If the Print Spectrum Monochrome option is not available, click the spectrum display again, and then select Print Spectrum Monochrome. If the Print Spectrum Monochrome option is still not available, make sure your printer is properly set up for your computer.

3. (Optional) Select a different printer.

4. Click OK.

Exporting a Spectrum
You can paste the spectrum to the Windows Clipboard for copying into another program such as Microsoft Word, Excel, or PowerPoint. You can also save the spectrum to a file.

To copy a spectrum to the Clipboard
1. Right-click the spectrum and select Export Dialog.

The Exporting <assay name> dialog box appears (where <assay name> is the name of the assay).

2. Under Export, select the file format in which you want to copy the spectrum to the Clipboard.
Metafile is recommended for copying to the Clipboard.

**Note:** Selecting **Text / Data Only** copies text data values defining the spectrum graph. For more information, see “To export spectrum graph data points” on page 116.

3. Under **Export Destination**, select **Clipboard**.

4. (Optional) If you need the spectrum in a specific size, specify the size under **Object Size**. Otherwise, leave Object Size at **No Specific Size**.

**Note:** Changing the size may “distort” the image if you do not change the width and height proportionally.

5. Click **Export**.

An image of the spectrum is now available on the Windows Clipboard for pasting into any program that will accept pasting of a Windows metafile.

**To save the spectrum to a file**

You can save an image of the spectrum as either a Windows metafile (.wmf) or a bitmap (.bmp) file.

1. Right-click the spectrum and select **Export Dialog**.

   The **Exporting <assay name>** dialog box appears (where <assay name> is the name of the assay).

2. Under **Export**, select a file format.

   **Note:** Selecting **Text / Data Only** saves text data values defining the spectrum graph. For more information, see “To export spectrum graph data points.”

3. Under **Export Destination**, select **File**.

4. Click **Browse**.

   A **Save As** dialog box appears.

5. Choose a folder and enter a name for the file.

   .Wmf (Windows metafile) or .bmp (bitmap) extensions are automatically added to the file name you type.

6. Click **Save**.

   You are returned to the **Exporting <assay name>** dialog box.

7. Click **Export**.
To export spectrum graph data points

You can copy the data points defining the spectrum graph as text to the Windows Clipboard or you can save them to a file. If you copy the data points to the Clipboard, you can then paste them from the Clipboard to a spreadsheet or graphing program. If you save the data points to a file, you can import them into another program.

1. Right-click the spectrum and select Export Dialog.

   The Exporting <assay name> dialog box appears (where <assay name> is the name of the assay).

2. Under Export, select Text / Data Only.

3. Under Export Destination, select File or Clipboard.

4. If you selected File as the Export Destination, click Browse.

   A Save As dialog box appears. Choose a folder and enter a name for the file. Then click Save.

5. Click Export.

   The Export <assay name> dialog box appears.

6. Select the export options you want.

7. Click Export.

MultiRow Options

Manually Calling a Genotype (Genotyping)

You can override an assay call (or no call) by manually calling a genotype. You can manually call a genotype in the results table (on the MultiRow tab).

Caution: When you manually call a genotype, the call will be noted as a “user call” even if you change it back to the original call.

To manually call a genotype in the results table

1. Click the MultiRow tab to view the results table.

2. In the results table, click the assay call you want to override.

3. Right-click the assay call again, and select the call you want to make.

Right-click menu for manually calling genotypes
Copying the Grid

You can copy the MultiRow grid to Microsoft Excel.

**To copy the grid**

1. On the MultiRow tab, click inside the grid. (Click any row.)
2. On the Edit menu, select **Copy Multirow Grid**.
3. Open Microsoft Excel.
4. Paste the grid data into Excel.

Press the CTRL and V keys simultaneously to paste the data.

Viewing Assay Details for a Well

The assay table contains information about the assays applied to a well. Under each assay are sections of detailed information about the assay. The sections are initially collapsed (i.e. hidden).

First, in the plate diagram, click the well about which you want information. The assay table lists the assays applied to the well. Click the plus (+) next to an assay to view its details.

<table>
<thead>
<tr>
<th>ASSAY ID</th>
<th>SAMPLE ID</th>
<th>CALL</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>591277</td>
<td>DNA Control 19</td>
<td>R</td>
<td>A, Conservative</td>
</tr>
<tr>
<td>546106</td>
<td>DNA Control 19</td>
<td>C</td>
<td>A, Conservative</td>
</tr>
<tr>
<td>652714</td>
<td>DNA Control 19</td>
<td>T</td>
<td>A, Conservative</td>
</tr>
<tr>
<td>90389</td>
<td>DNA Control 19</td>
<td>G</td>
<td>A, Conservative</td>
</tr>
</tbody>
</table>

Example of an assay table
Reviewing Processed Data with TyperAnalyzer
Viewing Assay Details for a Well

The following illustration shows an example of the assay details that appear.

<table>
<thead>
<tr>
<th>ASSAY_ID</th>
<th>SAMPLE_ID</th>
<th>CALL</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>22-4170</td>
<td>1</td>
<td>TA</td>
<td>2-Polymeric</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**ASSAYINFO**

Depending on the type of plate (i.e. genotyping, genotype+area, or allelotyping) only some or all of the information, illustrated here, is shown. For instance, in a genotyping plate, ASSAYINFO, CALLINFO, and PEAKINFO information is shown, but AREAINFO and FREQUENCYINFO are not present.

**ASSAYINFO**

This part lists information about analytes, MassEXTEND primer (Probe), and contaminants expected in the spectrum.
CALLINFO

This part lists calibration information.

Example of CALLINFO part of assay details

<table>
<thead>
<tr>
<th>CALIBRATION</th>
<th>PROBABILITY</th>
<th>STD</th>
<th>OFFSET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibrated</td>
<td>1.000000</td>
<td>1.144005</td>
<td>-0.177160</td>
</tr>
</tbody>
</table>

“Calibrated” means calibrant was present on the SpectroCHIP and a calibration spectrum was successfully acquired.

Level of confidence in the assay call expressed as a probability (1.0 means 100%)

Standard error of noise

Calibration offset applied to spectra

PEAKINFO

This part lists information about the peaks in the spectrum.

Example of PEAKINFO part of assay details

<table>
<thead>
<tr>
<th>PEAKINFO</th>
<th>HEIGHT</th>
<th>SNR</th>
<th>PROBABILITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>5999.00000</td>
<td>5.926484</td>
<td>2.670775</td>
<td>0.288404</td>
</tr>
<tr>
<td>6273.00000</td>
<td>115.235814</td>
<td>59.692560</td>
<td>1.000000</td>
</tr>
<tr>
<td>6030.00000</td>
<td>4.433989</td>
<td>2.203810</td>
<td>0.25970</td>
</tr>
<tr>
<td>6117.00000</td>
<td>105.225049</td>
<td>56.737394</td>
<td>1.000000</td>
</tr>
</tbody>
</table>

Note: For a bad spectrum, no PEAKINFO information is available.

Expected mass of a peak

Intensity of a peak (i.e. height along the y-axis)

Signal-to-noise ratio (ratio of peak height to local noise)

Level of confidence that a peak is the actual expected peak, expressed as a probability (1.0 means 100%)

Peaks are identified by mass. To find which analyte, contaminant, or unextended primer a peak represents, match up the mass values. For example, this peak is for the A allele.
**AREAINFO (Genotype+Area and Allelotyping only)**

This part lists information about the areas under the peaks.

### Example of AREAINFO part of assay details

- **Expected mass of a peak**
- **Area under the curve of the peak**
- **Area may be +/- this amount**
- **Peak resolution**

<table>
<thead>
<tr>
<th>ASSAY_ID</th>
<th>SAMPLE_ID</th>
<th>CALLED</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C11-46179</td>
<td>GA</td>
<td>2-Polymeric</td>
</tr>
</tbody>
</table>

### Peaks are identified by mass. To find which analyte, contaminant, or unextended primer a peak represents, match up the mass values. For example, this peak is for the G allele.

- **Mass of a peak for the G allele**
- **Area under the curve**
- **Area may be +/- this amount**
- **Peak resolution**

---

**AREAINFO (Genotype+Area and Allelotyping only)**

This part lists information about the areas under the peaks.

<table>
<thead>
<tr>
<th>AREAINFO</th>
<th>AREA</th>
<th>AREA_VARIANT</th>
<th>RESOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>5999.90000</td>
<td>66.594268</td>
<td>45.111778</td>
<td>200.735247</td>
</tr>
<tr>
<td>5673.10000</td>
<td>110.631027</td>
<td>17.961867</td>
<td>282.752259</td>
</tr>
<tr>
<td>6304.10000</td>
<td>80.410017</td>
<td>43.940198</td>
<td>276.282209</td>
</tr>
<tr>
<td>6617.00000</td>
<td>99.043021</td>
<td>17.021811</td>
<td>280.520247</td>
</tr>
</tbody>
</table>

Peaks are identified by mass. To find which analyte, contaminant, or unextended primer a peak represents, match up the mass values. For example, this peak is for the G allele.
**FREQUENCYINFO (Allelotyping only)**

This part lists allele frequency information.

### Example of FREQUENCYINFO part of assay details

<table>
<thead>
<tr>
<th>FREQUENCYINFO</th>
<th>FREQUENCY</th>
<th>FREQUENCY-UNCERTAINTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>6273.100000</td>
<td>0.526177</td>
<td>0.001241</td>
</tr>
<tr>
<td>6617.300000</td>
<td>0.473823</td>
<td>0.001241</td>
</tr>
</tbody>
</table>

**Note**: When acquiring spectra, an analyzer attempts to acquire five spectra for each sample. Relative frequency estimates are the average frequency found in the five spectra. The standard error of the frequency estimates is the standard error of the frequencies from all five spectra.

Peaks are identified by mass. To find which allele a peak represents, match up the mass values. For example, this peak is for the G allele.
Generating Reports

You may create a report of plate results as a tab-delimited file. When you create a report, the file is automatically displayed in Microsoft® Excel™. The following reports are available:

- Allelotype*
- Allelotype Correction*
- Assay Type Count
- Best Call Probability
- Call Probability
- Chip QC
- Description Count
- Gene Expression*
- Genotype Area*
- Genotype Cluster
- Plate Definition
- Plate Result
- Primer Adjustment

* To generate these reports, you must have an allelotyping license. For more information, contact SEQUENOM.

Note: The reporting functions are identical in the TyperAnalyzer and Genotype Analyzer modules.

For a description of each report, see Appendix B “Reports” on page 161.

To generate a report

1. In the tree control, select the chip on which you want a report. Then right-click the chip and select <Name> Report where <name> is the name of the report listed.

Tab-Delimited File

A file containing plain, text items separated by a tab character. Each line of data is separated by a carriage-return character.
You can generate a report on multiple chips under the same experiment or plate. The report will include data for all of the chips under the experiment or plate.

Allelotyping is typically done using four SpectroCHIPs. The SpectroCHIPs are “copies” of each other—the point of having four copies is to obtain more spectral data points on which to perform statistical analyses. The data from each SpectroCHIP is stored in a chip under the same experiment. So, an experiment should have four chips under it, one for each SpectroCHIP.

In most cases, when generating an Allelotype or Allelotype Correction report, you should generate the report on the experiment containing the four chips. Allele frequency estimates will be based on statistical analyses done on the data from all four chips. You may generate an Allelotype or Allelotype Correction report on an individual chip, but the frequency estimates will be based only on the data from one SpectroCHIP.

Generating a Genotype report on multiple chips is equivalent to generating a Genotype report individually for each chip and appending them into a single file. The data for each chip is kept separate from that for the other chips.
Note: To generate an Allelotype Correction report, there must be a skew correction file containing heterozygous skewing factors for the assays applied to your plate. Skew factors are saved to a skew correction file when you generate a Genotype Area report on genotype+area experiments. For more information, see “Skew Correction File” on page 165.

2. In the Get User Input dialog box, click the Browse button and select a skew correction file. This is the file to which heterozygous skewing factors will be appended.

Note: This dialog box appears for only Genotype Area and Allelotype Correction reports. If you are not generating either kind of report, skip to the next step.

Note: It is recommended that you have only one skew correction file (named SkewCorrectionFile, located in the ReportTemplates folder). However, you may create and use other skew correction files. To create a skew correction file select a folder, type a name for the file, and click OK. The file will be created and the skewing factors from this Genotype Area report will be saved to it.

Note: It is recommended that you have only one skew correction file (named SkewCorrectionFile, located in the ReportTemplates folder). However, you may create and use other skew correction files. To create a skew correction file select a folder, type a name for the file, and click OK. The file will be created and the skewing factors from this Genotype Area report will be saved to it.

Note: If this is the first time you are running a Genotype Area report, SkewCorrectionFile does not exist. Select the ReportTemplates folder and type “SkewCorrectionFile” in the File name box. When you click OK, a skew correction file named SkewCorrectionFile will be created. From this point on, you should use this skew correction file.
3. In the **Save As** dialog box, select a different folder, type a file name, and click **Save**.

Initially, this dialog box shows the **ReportTemplates** folder. You should not save your reports to this folder. Select or create a different folder for your reports.

A default name is supplied for your report based on the experiment, chip, or plate you selected (see right). Edit or replace the name if you wish.

![Image of the Save As dialog box](image)

**Default Name**

A default report file name is in the form: `<customer>_<project>_ <plate>_<experiment>_<chip>`

If you selected a plate, the default name only goes to `<plate>` (i.e., `<customer>_<project>_plate`). Similarly, if you selected a chip, the name goes to `<chip>`.

**Selecting a report type**

4. When you click **Save**, the report is generated. The report is displayed in Excel.

For descriptions of report contents, see Appendix B “Reports” on page 161.

---

**Recalling Plate Data**

If you find that an assay has been incorrectly applied to a plate or well of a plate, you can recall the plate data and copy it to a new plate with the correct assays applied. Use ChipLinker to recall plate data. You can recall plate data on the RT-Workstation computer or on the server. See “Recalling Plate Data” on page 97.

**Caution:** Data recall should be used on only genotyping and genotype+area data. Do not recall allelotyping data.

---

**Quitting TyperAnalyzer**

- To quit TyperAnalyzer
  - On the **File** menu, select **Exit**.
Notes:
Chapter 7

Reviewing Processed Data with Genotype Analyzer

Introduction

This chapter explains how to view the results after receiving data from a MassARRAY analyzer or MassARRAY analyzer compact (both are types of mass spectrometer). The Genotype Analyzer module displays results in both a table format and in a graph view that shows where the genotypes fall in the spectrum.

For genotyping data, you can view the successful Calls and the No Calls. You can make a judgement on the No Calls and perform a User Call if necessary.

For allelotyping data, you can view whether a sample is polymorphic or not (i.e. both alleles or just one) and the relative frequencies of each allele. You can also view additional statistical details about the spectra for each sample.

Note: There are slight differences in the way some Genotype Analyzer features work depending on whether you are viewing genotyping or allelotyping data. Sections in this chapter applicable to only genotyping have "(Genotyping)" after their headings. Sections applicable to only allelotyping have "(Allelotyping)" after their headings. Sections applicable to both have plain headings, with no analysis type indicated.
Starting Genotype Analyzer

1. From the Typer window, select the **Genotype Analyzer** button.

2. If you have not yet connected to the MassARRAY database, the **Connect to Database** dialog box opens. Enter the appropriate information. See “Connect to the Database” on page 6.

3. Once connected, Genotype Analyzer opens.

Finding and Selecting Data

Typer data in Genotype Analyzer is organized into a tree. The tree has multiple levels; each successive level is indented to the right. Each level of the tree represents a different type of item.

There are three different ways to view the Typer data in the tree: sorted by project, assay group (called “test” in Genotype Analyzer), or date. Use the tree tabs to switch between the views.

The data is the same; the three views are simply different ways to organize it. For example, use the **Date** tab to find data grouped by the date on which it was created.

**By Project**

The tree is organized into the following levels:

- Customer
- Project
- Plate
- Experiment
- Chip

Example of the tree sorted by project
By Test

The tree is organized into the following levels:

- Test (a collection of assays)
- Assay
- Plate
- Experiment
- Chip

By Date

The tree is organized into the following levels:

- Year
- Month
- Day
- Plate
- Experiment
- Chip

Selecting Data in the Tree

Regardless of whether you sort the tree by project, assay, or date, the last three levels are always the same: plate, experiment, chip.

To view data you must select a chip, the lowest level of the tree. Chips contain the data from a SpectroCHIP. Chips under a genotyping plate contain data from different MassARRAY analyzer runs on the same SpectroCHIP. Chips under an allelotyping plate contain data from MassARRAY analyzer runs on different SpectroCHIPs. Selecting a chip in the tree will display the data from the chip.

You can also choose to view data from groups of chips. If you select an experiment and choose to view its calls, then data from all chips under the experiment will be displayed. If you select a plate and choose to view its calls, then data from all chips from all experiments under the plate will be displayed.
Using the Results Table (Genotyping)

Color-Coding

Genotype Analyzer uses a three-parameter model to calculate the significance of each putative genotype. Based on the relative significance, a final genotype will be called. Different parameter settings can give rise to different results. Thus, based on internal testing and training of the model, three different sets of parameters have been developed for the model.

- **Conservative**: The most conservative set makes no error on the training and test data, but has the most uncalled genotypes.
- **Aggressive**: The most aggressive set makes the most errors (still less than 1 percent), but makes the most number of calls.
- **Moderate**: The moderate set is a compromise between the two extremes.

The non-calls are further categorized:

- **Low Probability**: Implies that the spectrum in question contains peaks that fail any criteria of significance even for the aggressive parameter set.
- **Conflict**: Implies that there is more than one read or spectrum corresponding to one well, and these reads give rise to different and conflicting genotypes.
- **Bad Spectrum**: The spectrum for the well doesn't exist above noise level.
- **Bad Assay**: Result of analyst or operator input errors in defining the assays. The most common errors are mass values of analytes or contaminants that are out of range of the spectrum, or contaminants and analytes having the same mass.
- **User Call**: The analyst or operator selects a genotype in the table and performs a manual call. See “To manually call a genotype in the table” on page 150.
The results appear in a table with color coded rows and a column titled Description. The following table matches the color to the description. Colors can be edited by your system administrator.

Table 4: Genotype Analyzer Color Codes for Genotyping

<table>
<thead>
<tr>
<th>Description</th>
<th>Default Color in Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conservative</td>
<td>Green</td>
</tr>
<tr>
<td>Moderate</td>
<td>Yellow</td>
</tr>
<tr>
<td>Aggressive</td>
<td>Pink</td>
</tr>
<tr>
<td>Low Probability</td>
<td>Rose</td>
</tr>
<tr>
<td>Conflict</td>
<td>Red</td>
</tr>
<tr>
<td>Bad Spectrum</td>
<td>White</td>
</tr>
<tr>
<td>Bad Assay</td>
<td>Red</td>
</tr>
<tr>
<td>User Call</td>
<td>Cyan</td>
</tr>
</tbody>
</table>

Genotypes and Peaks

Different genotypes result in a different peak pattern in the spectrum. The configuration of present and absent peaks is used to determine the genotype (Calls). In a good assay, most calls can be made automatically. Any genotype determinations that cannot be made (No Calls) require manual intervention. (See “To manually call a genotype in the table” on page 150.) The goal of Typer is to have close to 100% accuracy on automatic calls made with conservative criteria. It is required that you manually call the non-call spectra. Furthermore, it is advisable to examine the automatic calls based on the Aggressive criterion. The main function of Genotype Analyzer is to provide the interface to allow making these manual calls.
The following illustration shows the No Calls. Notice the table includes reasons for the No Call status.

To view only the calls, click the **Called Only** button. To view only the no calls, click the **No Call** button. Reasons for No Call status show in this field.

Use the **Called Only** and **No Call** toolbar buttons to view the data that you want to work with.

**To view only the calls**
- On the toolbar, click the **Called Only** button.

**To view the calls for all experiments on a plate**

If you have multiple experiments (that is, MassARRAY analyzer or analyzer compact reads) on a plate, you can view all the calls for all experiments on the plate. To do so, complete the following steps.

1. In the left pane (which lists customers, projects, plates, and experiments), select the plate you want. Then, right-click the selected plate and choose **Show All Calls for <plate name>** (where *plate name* is the name of the plate you right-clicked).

The results table lists all calls from all experiments on the plate. Since, all calls from all experiments are listed, you may see multiple calls for the same well position.

You can sort the results table on any column by clicking the column’s header at the top of the table. The rows of the table are sorted on the column you select in ascending order.
To view only the best call from the experiments on a plate

You can have multiple experiments (that is, MassARRAY analyzer or analyzer compact reads) on a plate. As a result, there may be multiple calls for the same well position—one from each experiment. For a specific well position, you can choose to view only the call that has the highest score for all the experiments. To do so, complete the following steps.

1. In the left pane (which lists customers, projects, plates, and experiments), select a plate. Then, right-click the selected plate and choose Show Collated Calls for <plate name> (where plate name is the name of the plate you right-clicked).

The results table lists a single call for each well position. For a given well position, the call that is listed is the one with the highest score amongst all the experiments on the plate.

Note: You may see several calls for the same well position, highlighted in red. This happens if the calls from the experiments do not correspond (that is, if there are different genotype calls for the same well position from the experiments). In this case, all calls from all experiments are listed for the well position in question.

You can sort the results table on any column by clicking the column’s header at the top of the table. The rows of the table are sorted, on the column you select, in ascending order.

To view only the no calls

- On the toolbar, click the No Calls button.

To view only the best call from the experiments on a plate

You can have multiple experiments (that is, MassARRAY analyzer or analyzer compact reads) on a plate. As a result, there may be multiple calls for the same well position—one from each experiment. For a specific well position, you can choose to view only the call that has the highest score for all the experiments. To do so, complete the following steps.

1. In the left pane (which lists customers, projects, plates, and experiments), select a plate. Then, right-click the selected plate and choose Show Collated Calls for <plate name> (where plate name is the name of the plate you right-clicked).

The results table lists a single call for each well position. For a given well position, the call that is listed is the one with the highest score amongst all the experiments on the plate.

Note: You may see several calls for the same well position, highlighted in red. This happens if the calls from the experiments do not correspond (that is, if there are different genotype calls for the same well position from the experiments). In this case, all calls from all experiments are listed for the well position in question.

You can sort the results table on any column by clicking the column’s header at the top of the table. The rows of the table are sorted, on the column you select, in ascending order.

To view only the no calls

- On the toolbar, click the No Calls button.
To view the no calls for all experiments on a plate

If you have multiple experiments (that is, MassARRAY analyzer or analyzer compact reads) on a plate, you can view all the no calls for all experiments on the plate. To do so, complete the following steps.

1. In the left pane (which lists customers, projects, plates, and experiments), select a plate. Then, right-click the selected plate and choose Show All NO Calls for <plate name> (where plate name is the name of the plate you right-clicked).

The results table lists all no calls from all experiments on the plate. Since, all no calls from all experiments are listed, you may see multiple no calls for the same well position.

You can sort the results table on any column by clicking the column’s header at the top of the table. The rows of the table are sorted, on the column you select, in ascending order.

To sort the results table

- You can sort the results table by any of its columns. Clicking a column header at the top of the results table sorts the calls in ascending order by the column.
  For example, clicking the Well_Position column sorts the calls by their well positions, in alphanumeric, ascending order. Clicking the same column header a second time sorts the calls in descending order by the column. Clicking the column header again returns to sorting in ascending order, and so on.

To view information about a call

1. On the View menu, select Call Info Dialog.

The Call Information Dialog dialog box appears.

Call Information Dialog dialog box

If necessary, move the Call Information Dialog dialog box to view the calls beneath it.
2. In the results table, click the call about which you want information.

   The **Call Information Dialog** dialog box shows information about the call you click. See the following illustration.

   ![Example of Call Information Dialog dialog box with call information](image)

   You can leave the **Call Information Dialog** dialog box open and click another call to view information about it.

3. When you are done, close the **Call Information Dialog** dialog box by clicking ![X](image) in the upper right corner.

   **To view a history of calls**
   - On the toolbar, click ![H](image) (Show History tool).
     
     A history of calls appears, indicating who made each call.

   **To view calibration and mass shift information**

   You can choose to either show or hide calibration and mass shift columns in the results table.
   - On the View menu, select **Show Calibration**.

   ![Note: If a check mark appears next to Show Calibration, calibration and mass shift columns are already currently shown. Selecting Show Calibration will hide these columns.](image)

   ![Note: If there is no check mark next to Show Calibration, calibration and mass shift columns are already currently hidden. Selecting Show Calibration will show these columns.](image)
For a genotype+area experiment, the color-coding of the rows is done on the same basis as for genotyping experiments, by the strength of calls (see “Color-Coding” on page 130). The columns in the table, however, are the same as for an allelotyping experiment. It includes data about peak areas and allele frequencies. For instructions on using the results table, see “Using the Results Table (Allelotyping)” below; skip the first section on color-coding.

### Color-Coding

The columns and color-coding in the results table for an allelotyping experiment are different from that for a genotyping experiment. Instead of color-coding by strength of genotype calls, the rows are color-coded according to whether each well is polymorphic (both alleles found) or non-polymorphic (only one allele found). The following table describes the color-coding scheme.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Polymorphic (both alleles present)</td>
</tr>
<tr>
<td>Cyan</td>
<td>Non-Polymorphic (one allele present)</td>
</tr>
<tr>
<td>Pink</td>
<td>Uncertain (the average frequency of one allele is less than or equal to 3 times the standard error of the frequencies before averaging.)</td>
</tr>
<tr>
<td>Yellow</td>
<td>Low-Frequency (one of the alleles has a frequency of 0.06, i.e. 6%, or less and the standard error is less than 2%)</td>
</tr>
<tr>
<td>White</td>
<td>Bad Spectrum (a usable spectrum was not acquired from the well; the best spectrum acquired contains only noise)</td>
</tr>
</tbody>
</table>

**Note:** Low-Probability and Bad Spectrum rows are hidden from view. To view these rows, see "Viewing Bad Spectrum Rows” on page 138.

### Data Columns

The columns of data include information about the peak areas and allele frequencies. The following table describes the data columns.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE_ID</td>
<td>Sample name</td>
</tr>
<tr>
<td>CALL</td>
<td>Alleles present in the pool</td>
</tr>
<tr>
<td>ASSAY_ID</td>
<td>Assay name</td>
</tr>
<tr>
<td>WELL_POSITION</td>
<td>Well number</td>
</tr>
</tbody>
</table>

**Filtering Columns**

You can choose to view or hide individual columns in a results table. See “Filtering the Results Table” on page 140.
### DESCRIPTION
- Polymorphic: both alleles found
- Non-Polymorphic: one allele found
- Low Frequency: one of the alleles has a frequency of 0.06, i.e. 6%, or less and the standard error is less than 2%
- Uncertain: the average frequency of one allele is less than or equal to 3 times the standard error of the frequencies before averaging.
- Bad Spectrum: a usable spectrum was not acquired from the well; the best spectrum acquired contains only noise

### ENTRY_OPERATOR
- Automatic: The call (see CALL above) was made automatically by Typer
- User Call: The call (see CALL above) was manually selected by a user

### CALIBRATION
- Yes: calibration spectrum was acquired and applied
- No: calibration was not applied

### MASS_SHIFT
Calibration offset applied to the spectrum

### RASTERS
Number of raster positions from which spectra were acquired. A MassARRAY analyzer attempts to acquire spectra from five positions (raster positions) on a SpectroCHIP well, the center plus the four corners. "5" means spectra were acquired from all five positions. Anything less means spectra could be successfully acquired from only the indicated number of positions. Frequency estimates for an allele are generated by averaging the frequencies found from the successful raster positions.

### Area 1
Average area under the curve for the lower-mass allele. This is an average of areas found at all successful raster positions.

### Delta 1
The average difference in area for the values used to calculate Area 1.

### Area 2
Average area under the curve for the higher-mass allele. This is an average of areas found at all successful raster positions.

### Delta 2
The average difference in area for the values used to calculate Area 2.

### Frequency 1
Average frequency of the lower-mass allele. This is an average of the frequencies found at all successful raster positions.

### Frequency Err 1
Standard error of the frequencies found for the lower-mass allele.

### Frequency 2
Average frequency of the higher-mass allele. This is an average of the frequencies found at all successful raster positions.

### Frequency Err 2
Standard error of the frequencies found for the higher-mass allele.
Viewing Bad Spectrum Rows

Bad Spectrum rows are usually hidden from view. To view them, click the **No Calls** tool. To view the Polymorphic/Non-Polymorphic/Uncertain rows, click the **Called Only** tool. Switch back-and-forth between the two views by using the **Called Only** and **No Calls** tools.

Viewing Data for all Experiments on a Plate

In a single results table, you can view the data for all chips on a plate. When allelotyping, a chip represents an individual SpectroCHIP. Viewing all chips for a plate shows you the data from all SpectroCHIPs run for the plate.

When viewing all chips for a plate, you can sort the results table by well position. The same well positions on all chips will be grouped together. Since the same well positions on all chips (i.e. SpectroCHIPs) contains the same sample, you can compare the individual results from each SpectroCHIP.

To view data for all experiments on a plate

- In the left pane (which lists customers, projects, plates, experiments, and chips), click a plate to select it. Then, right-click it again and choose **Show All Calls for <plate name>** (where plate name is the name of the plate you right-clicked).

The results table lists the data from all chips on the plate. You can sort the results table on any column by clicking the column’s header at the top of the table. The rows of the table are sorted, on the column you select, in ascending order.

To sort data by well position, click the WELL_POSITION column header.

**Note:** Bad Spectrum rows are hidden from view. To view these rows click the **No Calls** tool. For more information, see “Viewing Bad Spectrum Rows” above.

Viewing Detailed Assay Results

For any well, you can view detailed assay results, such as peak heights, peak areas, and signal-to-noise ratios.

To view detailed assay results

1. On the View menu, select **Call Info Dialog**.
The **Call Information Dialog** dialog box appears.

![Call Information Dialog](image)

If necessary, drag the **Call Information Dialog** dialog box to view the results table beneath it.

2. In the results table, click the row (i.e. well) about which you want information.

   The **Call Information Dialog** dialog box shows information about the well you click. See the following illustration.

   ![Example of the Call Information Dialog](image)

   - **Expected mass value of a peak**
   - **Height along the y-axis (i.e. the intensity of the peak)**
   - **Signal-to-noise ratio (ratio of peak height to local noise)**
   - **Calibration offset applied to the spectrum**
   - **Level of confidence in the assay call expressed as a probability (1.0 means 100%)**
   - **Level of confidence that a peak is the actual expected peak, expressed as a probability (1.0 means 100%)**
   - **Area under the curve of the peak**
   - **Standard error of noise in the spectrum**

   You can leave the **Call Information Dialog** dialog box open and click another well to view information about it.

3. When you are done, close the **Call Information Dialog** dialog box by clicking \(\times\) in the upper right corner.
Filtering the Results Table

You can control which columns are shown in a results table by hiding individual columns or groups of columns. When you hide a column, it is simply hidden from view. You can easily switch back to showing the column.

**To hide or show columns**

1. On the View menu, select **Display Fields Dialog**.

   The **Data Field Display** dialog box appears.

   ![Data Field Display](image_url)

   **Selecting which columns to display**

   2. Select which columns to display.
Reviewing Processed Data with Genotype Analyzer

Printing the Results Table

The information in the table can be printed.

To print an entire table

1. From the File menu, choose Print Table.

The Print dialog box opens.

2. Select the appropriate print options.

3. Click OK.

To print from the Print Preview window

1. Select the plate whose information you want to print.

2. From the File menu, choose Print Preview.

Note: The options under Frequency Analysis are not necessarily the column names; instead they are the types of data in the columns. Use the following illustration to match an option to a column.

The options under Calibration Status section are the exact column names.

- Frequency 1 and Frequency 2
- Area 1 and Area 2
- Frac UEP
- Frac Pause
- RASTERS

The options in the General section are the exact column names.

- Frequency Analysis
  - Show Specified
  - Hide All
  - Frequencies
  - Peak Areas
  - Frac UEP/ F PGA
  - Frac Pause
  - RASTERS

- Frequency Error 1 and Frequency Error 2
- Delta 1 and Delta 2

Checking an item means you want the column displayed. Clear any item you want hidden from view.

Under Calibration Status and Frequency Analysis, you can also choose to hide all items in the group. To do so, select Hide All.
A preview window appears.

3. Click the buttons at the top to **Zoom In** or **Zoom Out**, view the previous or next page, and close.

4. Click the **Print** button located at the top of the window.

**To print one row and the spectrum**

1. On the File menu, select **Print Spectrum**.

2. Select the print options you want.

3. Click **OK**.
Viewing Spectra

Once you have a results table open, you can view the spectrum for each row (i.e. well). Split the screen to view spectra.

Splitting the Screen

To split the screen

1. From the Edit menu, choose Spectrum Split, or click the Spectrum Split toolbar button. A horizontal line appears across the view, and the mouse pointer turns into a double line.

Drag this line to the point where you want to split the view and click the mouse button. The result table will be above the line; the spectrum display will appear below the line.

2. To view the spectrum for a well, click it in the results table. The spectrum appears in the spectrum display. The selected genotype is identified by its underlined yellow text.

Note: Spectra acquired using the ACQUIRE module may appear “less intense” than older spectra acquired by the XACQ software on the MassARRAY analyzer (and processed by the Data Process module in earlier versions of Typer). That is, the intensity peaks in spectra acquired by ACQUIRE may generally not be as high as those in spectra acquired by the XACQ software.

When taking multiple shots of a SpectroCHIP well using ACQUIRE, the intensities in the spectrum of each shot are accumulated and then divided by the total number of shots. The resulting spectrum that is saved to the MassARRAY database is an average of the spectra from the multiple shots.

When taking multiple shots using the XACQ software on the MassARRAY analyzer, the spectra are accumulated also, but not divided by the total number of shots. Thus, in general, the intensities in spectra acquired by the XACQ software are greater than in spectra acquired by ACQUIRE.
Unsplitting the Screen

You can hide the spectrum display by “unsplitting” the screen.

**To unsplit the screen**

1. Move the mouse pointer over the top edge of the spectra display.
   
   The pointer will turn to a double line with arrows.

2. Click and drag the border to the bottom of the window.

   The spectrum display is hidden from view; only the results table is shown.

Zooming

If you want to see more details in a spectrum, use the mouse to quickly zoom in or revert to the default size. Use the Zoom toolbar buttons to horizontally zoom the spectra view. This is handy when matching peaks to alleles.

**To vertical zoom in**

- Click the *Zoom In* toolbar button.

**To vertical zoom out**

- Click the *Zoom Out* toolbar button.

**To horizontally zoom in on an area**

1. Use the mouse to click and drag over the area in the spectrum that you want to zoom in on.

2. Repeat for more zooming.

**To revert to the default size**

- Right-click the spectrum.

   The spectrum reverts to its original size no matter how much you zoomed in.

Setting an Absolute Y-Axis Maximum

The spectra are not shown to the same scale along the y-axis (intensity). In one spectrum, the y-axis may go up to 500. In another, it may only go up to 350. Each spectrum is displayed with the y-axis scaled to best show the spectrum.

You can choose to view all spectra scaled to the same maximum y-axis value, allowing you to better judge the relative intensities of peaks in different spectra.

**To set a y-axis maximum for the spectrum display**

- On the toolbar, at the top of the Genotype Analyzer window, type a maximum value and click the check box for *Set Abs. Y Max*.

  First, type a maximum value

  Then, check this box
Reviewing Processed Data with Genotype Analyzer
Viewing the Calibration Spectrum

**Reviewing Processed Data with Genotype Analyzer**

**Viewing the Calibration Spectrum**

- **To view the calibration spectrum**
  1. If you have not done so already, split the view to see spectra.

     Use the (Split View tool) to split the view. For more information about splitting the view, see “Splitting the Screen” on page 143.

     2. On the toolbar, click (Show Calibration Spectrum tool).

     The calibration spectrum appears.

**Viewing All Spectra**

You can view all spectra in succession (similar to a slide show).

- **To view all spectra in succession**
  1. If you have not done so already, split the view to see spectra.

     Use the (Split View tool) to split the view. For more information about splitting the view, see “Splitting the Screen” on page 143.

     2. On the toolbar, click (Auto Play tool).

     The Auto Scroll Rows Dialog appears. See the following illustration.

     ![Auto Scroll Rows Dialog](image)

     3. In the **Start Row** box, type the row from which you want to start viewing the spectra.

     4. In the **End Row** box, type the last row for which you want to view spectra.

     5. In the **Time Interval** box, type the amount of time (in seconds) you want Typer to wait before displaying the next spectra.

     It is recommended that you choose a time interval between 2 to 30 seconds.
6. Click **OK**.

The spectra are displayed.

**Note:** Depending on the number of calls, it may actually take longer than the time interval you set for Typer to display each successive spectra. If there are a large number of calls, there may be a longer time interval between the spectra.

7. If you want to stop the display of the spectra before the last one is shown, click the *(Stop Auto Scroll tool)*.

The display of the spectra may not immediately stop. There is a slight “lag time” between your click of the *Stop Auto Scroll* tool and the actual stopping of the spectra display. A few more spectra may be displayed before it stops.

---

**Generating Reports**

You may create a report of plate results as a tab-delimited file. When you create a report, the file is automatically displayed in Microsoft® Excel™. The following reports are available:

- Allelotype*
- Allelotype Correction*
- Assay Type Count
- Best Call Probability
- Call Probability
- Chip QC
- Description Count
- Gene Expression*
- Genotype Area*
- Genotype Cluster
- Plate Definition
- Plate Result
- Primer Adjustment

**Note:** The reporting functions are identical in TyperAnalyzer (Traffic Lights) and Genotype Analyzer.

*To generate these reports, you must have an allelotyping license. For more information, contact SEQUENOM.*

For a description of each report, see Appendix B “Reports” on page 161.
To generate a report

1. On the Project tab, select the experiment on which you want a report. Then right-click the experiment again and select Generate Report.

Note: The organization of a tree sorted by project is illustrated here. For more information about selecting data in the tree, see “Finding and Selecting Data” on page 128.

After selecting a chip, right-click it and select Generate Report for n (where n is the chip number you selected).

Example of a tree

Note: The names used here are for illustration; you should name your plates and chips according to a consistent convention that allows you to easily identify their contents.

Generating a report on an experiment

For example, a report generated on experiment 042602-1-1 will include data from chips 1, 2, 3, and 4.

Generating a report on an experiment

Caution

Do not select anything above the plate-level. This would select experiments under different plates. Generating a report on experiments under different plates does not create valid report data.

Experiment

In a genotyping or genotype+area plate, an experiment represents a SpectroCHIP and a chip represents a MassARRAY analyzer run on the SpectroCHIP. Multiple chips represent multiple runs on the same SpectroCHIP.

In an allelotyping plate, an experiment represents a group of SpectroCHIPS. Each chip under the experiment represents a different SpectroCHIP.

You can generate a report on multiple chips under the same experiment or plate. The report will include data for all of the chips under the experiment or plate.

Allelotyping is typically done using four SpectroCHIPS. The SpectroCHIPS are “copies” of each other—the point of having four copies is to obtain more spectral data points on which to perform statistical analyses. The data from each SpectroCHIP is stored in a chip under the same experiment. So, an experiment should have four chips under it, one for each SpectroCHIP.
In most cases, when generating an Allelotype or Allelotype Correction report, you should generate the report on the experiment containing the four chips. Allele frequency estimates will be based on statistical analyses done on the data from all four chips. You may generate an Allelotype or Allelotype Correction report on an individual chip, and the frequency estimates will be based only on the data from one SpectroCHIP.

Generating a Genotype Area report on multiple chips is equivalent to generating a Genotype Area report individually for each chip and appending them into a single file. The data for each chip is kept separate from the data for the other chips.

When you select Generate Report, a Select Report Template dialog box appears.

2. Select a template, and then click Open.

If you selected a Genotype Area report or Allelotype Correction report, a Get User Input dialog box appears. (Proceed to the next step.)

For all other report types, a Save As dialog box appears. (Skip to Step 4.)

**Note:** To generate an Allelotype Correction report, there must be a skew correction file containing heterozygous skewing factors for the assays applied to your plate. Skew factors are saved to a skew correction file when you generate a Genotype Area report on genotype+area experiments. For more information, see “Skew Correction File” on page 165.
3. In the **Get User Input** dialog box, click the **Browse** button and select a skew correction file. This is the file to which heterozygous skewing factors will be appended.

![Get User Input dialog box](image)

**Note:** It is recommended that you have only one skew correction file (named SkewCorrectionFile, located in the ReportTemplates folder). However, you may create and use other skew correction files. To create a skew correction file select a folder, type a name for the file, and click **OK**. The file will be created and the skewing factors from this Genotype report will be saved to it.

![Please specify a filename dialog box](image)

If not done automatically, open the C:\MassARRAY Typer\ReportTemplates folder.

Select **SkewCorrectionFile**

After selecting SkewCorrectionFile, click **OK**

**Note:** If this is the first time you are running a Genotype report, SkewCorrectionFile does not exist. Select the **ReportTemplates** folder and type “SkewCorrectionFile” in the **File name** box. When you click **OK**, a skew correction file named SkewCorrectionFile will be created. From this point on, you should use this skew correction file.

4. In the **Save As** dialog box, select a different folder, type a file name, and click **Save**.

![Save As dialog box](image)

**Default Name**

A default report file name is in the form: `<customer>_<project>_<plate>_<experiment>_<chip>`.

If you selected a plate, the default name only goes to `<plate>` (i.e., `<customer>_<project>_<plate>`).

Similarly, if you selected a chip, the name goes to `<chip>`.

**Selecting a report type**

5. When you click **Save**, the report is generated. The report is displayed in Excel.

For descriptions of report contents, see Appendix B “Reports” on page 161.
Manually Calling a Genotype

You can override the automatic call by manually calling the genotype.

**To manually call a genotype in the table**

1. Right-click the genotype row.
   
   A menu opens with the available genotypes (see illustration).

2. Select the proper name for the genotype that you want to call.
   
   The genotype name is replaced in the table and underlined in the spectrum.
   
   Manual calls are labeled *User Call*.

Viewing a Pie Chart

View the table’s data graphically using the pie chart feature.

**To view a pie chart of selected data**

1. Select the proper plate.

2. From the View menu, choose *Pie Chart*.
   
   The *Pie* window opens.

3. From the drop-down list, select the type of data you want to view.
   
   The data appears in the dialog box.

4. If you want to print the results, click the *Print* button.

5. When finished viewing, click *OK*. 
Recalling Plate Data

If you find that an assay has been incorrectly applied to a plate or well of a plate, you can recall the plate data and copy it to a new plate with the correct assays applied. Use ChipLinker to recall plate data. You may recall plate data on the RT-Workstation computer or on the server. See “Recalling Plate Data” on page 97.

**Caution:** Data recall should be used on only genotyping and genotype+area data. Do not recall allelotyping data.
Notes:
Appendix A

Oligo Mass Calculator Algorithm

The following equations are used to calculate oligo masses.

**EXTEND Primer Mass =**

\[ \left( \left( N_a M_A \right) + \left( N_G M_G \right) + \left( N_C M_C \right) + \left( N_T M_T \right) + \left( N_I M_I \right) \right) - M_{\text{phosphate}} \]

**Analyte Mass =**

\[ \left( \left( N_a M_A \right) + \left( N_G M_G \right) + \left( N_C M_C \right) + \left( N_T M_T \right) + \left( N_I M_I \right) \right) - M_{\text{phosphate}} - 16^* \]

*Note: 3' ddN = -16

**Biotin-Primer (Contaminant) Mass =**

\[ \left( \left( N_a M_A \right) + \left( N_G M_G \right) + \left( N_C M_C \right) + \left( N_T M_T \right) + \left( N_I M_I \right) \right) + M_b \]

where:

- \( N_x \) = number of bases, where \( x \) indicates the base
  - (A = Adenine, G = Guanine, C = Cytosine, T = Thymine, and I = inosine)
- \( M_A \) = Adenine mass = 313.2
- \( M_G \) = Guanine mass = 329.2
- \( M_C \) = Cytosine mass = 289.2
- \( M_T \) = Thymine mass = 304.2
- \( M_I \) = Inosine mass = 314.2
- \( M_{\text{phosphate}} \) = phosphate mass = 62
- \( M_b \) = biotin mass = varies depending on the size of the biotin linker
  - (typically the biotin mass is 405 or 569)
Notes:
Appendix B

Reports

The reports available in TyperAnalyzer and Genotype Analyzer are identical. Reports of plate data are generated as a tab-delimited output file (.xls) that can be viewed in Microsoft Excel. This appendix provides a description of the output files for each report.

For instructions on how to run a report in TyperAnalyzer, see “To generate a report” on page 122. For instructions on how to run a report in Genotype Analyzer, see “To generate a report” on page 147.

Allelotype Report

You must have an allelotyping license to create an Allelotype report.

The Allelotype report contains allelotyping data, such as estimated relative frequencies of each allele. The following table describes the contents of an Allelotype report.

Table 7: Allelotype Report Contents

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLATE</td>
<td>Plate Name</td>
</tr>
<tr>
<td>WELL</td>
<td>Well Number</td>
</tr>
<tr>
<td>SAMPLE</td>
<td>Sample Name Sample name specified in Plate Editor when you created the plate</td>
</tr>
<tr>
<td>ASSAY</td>
<td>Assay Name Assay applied to the well</td>
</tr>
<tr>
<td>DATA_POINTS</td>
<td>Data Points Number of spectra acquired from the well. Typically, if the report is generated for a four-SpectroCHIP set, there should be 20 spectra (5 from each SpectroCHIP). Each provides a “data point” for frequency estimates. If the report is generated for a single SpectroCHIP, there should be 5 data points. Any value less than 20 (for four SpectroCHIPs) or 5 (for a single SpectroCHIP) means the full number of spectra were not successfully acquired, frequency estimates are still calculated. The estimates are based on the available data points.</td>
</tr>
<tr>
<td>NUM_CHIPS</td>
<td>Number of Chips The number of chips from which data was acquired for the well. Typically, allelotyping is done with four SpectroCHIPs. Each SpectroCHIP contains the same sample on corresponding wells. If you generated the report for a single SpectroCHIP, the number of chips should be 1.</td>
</tr>
<tr>
<td>AVE_FREQ1</td>
<td>Average Frequency of Allele 1 Weighted average relative frequency found from the data points for the lower-mass allele. 1.0 means 100%.</td>
</tr>
<tr>
<td>AVE_FREQ2</td>
<td>Average Frequency of Allele 2 Weighted average relative frequency found from the data points for the higher-mass allele. 1.0 means 100%.</td>
</tr>
</tbody>
</table>
You must have an allelotyping license to create an Allelotype Correction report. The Allelotype Correction report contains the same information as the Allelotype report plus corrections for heterozygous skewing.

In heterozygous samples, some skewing has been observed in spectra acquired by analyzers (skewing can also be caused by imbalanced PCR). When performing allelotyping, you can adjust for such skewing. Any assay you will use for allelotyping pooled samples should first be used to genotype individual DNA samples. When genotyping the individual DNA, choose `genotype+area` as the analysis type in an analyzer mass spectrometer. The relative frequencies of the alleles in heterozygous samples will be calculated for each spectrum. Then, in TyperAnalyzer or Genotype Analyzer, generate a Genotype Area report on the data. When the Genotype Area report is generated, the relative frequencies of the alleles in heterozygous samples will be averaged and saved to a skew correction file. These average heterozygous frequencies, from individual DNA, will be used as skewing factors to adjust the frequencies found in pooled DNA whenever the assay is used for allelotyping.

Once you have saved skewing factors to a skew correction file, you may view allelotyping results that are adjusted for heterozygous skewing by generating an Allelotype Correction report. The report will show allele frequencies adjusted with the skewing factors from the skew correction file.

**Table 7: Allelotype Report Contents**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREQ_ERROR</td>
<td><strong>Frequency Error</strong>&lt;br&gt;The weighted uncertainty of the frequencies for both the lower- and higher-mass alleles.</td>
</tr>
<tr>
<td>ASSAY_STATUS</td>
<td><strong>Assay Status</strong>&lt;br&gt;- Polymorphic: Both alleles found&lt;br&gt;- Non-Polymorphic: One allele found&lt;br&gt;- Uncertain: The average frequency of one allele is less than or equal to 3 times the standard error of the frequencies before averaging&lt;br&gt;- Bad Spectrum: A usable spectrum was not acquired from the well; the best spectrum acquired contains only noise&lt;br&gt;- No Spectrum: No spectrum acquired or no assay applied to the well</td>
</tr>
</tbody>
</table>
| PRIMER_FREQ  | **Primer Frequency**<br>Ratio of peak areas:<br>\[
\frac{\text{Unextended-Primer Area}}{\text{Unextended-Primer Area + Allele 1 Area + Allele 2 Area}}
\]
| PAUSE_FREQ   | **Pause Frequency**<br>Ratio of peak areas:<br>\[
\frac{\text{Pausing Peak Area}}{\text{Pausing Peak Area + Allele 1 Area + Allele 2 Area}}
\] |
**Caution:** Before generating an Allelotype Correction report, a skew correction file must contain skewing data which are applied to the allelotyping data. If your skew correction file does not have skewing data for the assays applied to the plate, you must add skewing data for those assays. Skewing data for an assay is added to a skew correction file by generating a Genotype Area report on a genotype+area plate on which the assay has been applied (see “Assay Type Count Report” on page 157).

The following table describes the additional columns of data included in an Allelotype Correction report. An Allelotype Correction report contains the same information as an Allelotype report (see Table 7 on page 155), plus these columns.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SKEW_LOWMASS</td>
<td>Skew of Lower-Mass Allele&lt;br&gt;Frequency of the lower-mass allele, found by performing genotype+area analysis on individual DNA sample; this value is used to adjust the frequency of the lower-mass allele in a pooled sample; this value is taken from the skew correction file selected when the report was generated</td>
</tr>
<tr>
<td>SKEW_HIGHMASS</td>
<td>Skew of Higher-Mass Allele&lt;br&gt;Frequency of the higher-mass allele, found by performing genotype+area analysis on individual DNA sample; this value is used to adjust the frequency of the higher-mass allele in a pooled sample; this value is taken from the skew correction file selected when the report was generated</td>
</tr>
<tr>
<td>CORR_FREQ1</td>
<td>Corrected Average Frequency of Allele 1&lt;br&gt;Average relative frequency found for the lower-mass allele, adjusted for heterozygous skewing (using the SKEW_LOWMASS value)</td>
</tr>
<tr>
<td>CORR_FREQ2</td>
<td>Corrected Average Frequency of Allele 2&lt;br&gt;Average relative frequency found for the higher-mass allele, adjusted for heterozygous skewing (using the SKEW_HIGHMASS value)</td>
</tr>
</tbody>
</table>

**Assay Type Count Report**

An Assay Type Count report lists the number of assays for the selected data.

**Best Call Probability Report**

The Best Call Probability report looks at all the data results and provides the best score result for the same sample and assay from among several results. The Score column in the output file indicates how good the call was, on a scale from 0 to 1.

**Call Probability Report**

The Call Probability report provides the same information as the Plate Result report, but with additional scoring information. (See “Plate Result Report” on page 160 for information.) The Score column in the Call Probability output file provides a record of how good the call was, based on a scale of 0 to 1.

**Description Count Report**

The Description Count report provides a count of each call status (Conservative, Moderate, etc.) for the selected data.
Gene Expression Report

You must have an allelotyping license to create a Gene Expression report.

The Gene Expression report plots the results from a Gene Expression Analysis experiment. (For information on this type of experiment, see the application note Gene Expression Analysis using MassARRAY available at www.sequenom.com.) This report creates an Excel spreadsheet (.xls) containing the final results from the experiment (one line per Sample/Assay combination). It also creates a PDF file displaying a graph for each Sample/Assay combination in the plate showing the C<sub>50</sub> intercept.

When creating plate definitions for Gene Expression Analysis, the following conventions are required:

- Any control wells in the plate must have the SAMPLE.DESCRIPTION field as either Pos. or Neg. for them to be excluded from the analysis. (This default can be changed by editing the GeneExpression.xml report template file.)
- The concentration of the competitor must be given in the SAMPLE.DESCRIPTION field of the SAMPLE table enclosed in square brackets. (For example, [1fM], [100pM].)

Genotype Area Report

You must have an allelotyping license to create a Genotype Area report.

This report contains genotyping data for the selected experiment or set of experiments. The following table describes the contents of a Genotype Area report.

<table>
<thead>
<tr>
<th>Table 9: Genotype Area report Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column</strong></td>
</tr>
<tr>
<td>CUSTOMER</td>
</tr>
<tr>
<td>PROJECT</td>
</tr>
<tr>
<td>PLATE</td>
</tr>
<tr>
<td>EXPERIMENT</td>
</tr>
<tr>
<td>CHIP</td>
</tr>
<tr>
<td>WELL</td>
</tr>
<tr>
<td>SAMPLE</td>
</tr>
<tr>
<td>ASSAY GROUP</td>
</tr>
<tr>
<td>ASSAY</td>
</tr>
<tr>
<td>GENOTYPE</td>
</tr>
</tbody>
</table>
In addition to the contents described in the table above, the Genotype Area report contains summary information at the bottom. See the following illustration.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>G</th>
<th>GA</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOTAL</td>
<td>6d</td>
<td>1</td>
<td>27</td>
</tr>
<tr>
<td>FREQ.</td>
<td>0.8424</td>
<td>0.1576</td>
<td></td>
</tr>
<tr>
<td>AVE HETERO RATIO</td>
<td>0.5346</td>
<td>0.4654</td>
<td></td>
</tr>
<tr>
<td>EVEN</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STABLE</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HETERO</td>
<td>29.35%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example of the summary information appearing at the bottom of a Genotype Area report

**Note:** For genotyping data (with no area information) AVE HETERO RATIO, EVEN, and STABLE will be "0." These values are based on peak-area data, which is not available on plain genotyping data.

Creating a Skew Correction File

When you generate a Genotype Area report on a genotype+area experiment, heterozygous skewing data is automatically saved to a skew correction file (see below). The skewing data is used in an Allelotype Correction report to adjust the frequency estimates for alleles.

Skew Correction File

A skew correction file contains heterozygous skewing data for assays. It serves as a “repository” of skewing data for various assays; any new data is appended (added) to the existing data. For each assay, the relative frequencies of the lower- and higher-mass alleles are stored. When an Allelotype Correction report is generated, skewing data (from a skew correction file) for the applied assays are used to correct allele frequency estimates. It is recommended that you create and maintain only one skew correction file. Whenever, you generate new skewing data (by generating a Genotype Area report on genotype+area data), you should save it to the same file. This way, you are assured you are applying the most up-to-date skewing correction for an assay.

Note: For genotyping data (with no area information) AVE HETERO RATIO, EVEN, and STABLE will be "0." These values are based on peak-area data, which is not available on plain genotyping data.

Genotype+Area Experiment

A genotyping experiment in Typer whose data includes peak-area data. You choose to capture such data when setting up the analyzer mass spectrometry run for a SpectroCHIP. For more information, see “Using Chip Linker to Associate Chips with Experiments” on page 81.

Genotype Cluster Report

The Genotype Cluster report provides a summary of signal-to-noise ratios (SNRs) used in the real-time genotype call, as well as other aids that can be useful in assessing the quality of each assay across all samples within a chip. Because this report provides statistical information, the results are improved by larger sample populations of DNA. The Genotype Cluster report produces two output files, a PDF file and a tab-delimited Excel file (.xls).

The PDF file provides one graph for each assay on each chip, plotting the observed low mass SNR against the corresponding high mass SNR on a logarithmic scale (log₁₀(SNR + 1)). Genotype calls are color coded. The call status is annotated with four symbol styles. Results without genotype calls (Low Probability) are plotted as blue...
crosses. The interpretations of these colors and symbols are given in the graph legend. The graph title is composed of the assay name on the first line, with the plate name on the second line, followed by the number of assays tested on that plate (e.g., MP8 to indicate 8 assays tested on the plate). If all wells of the plate measure the same assays, this value is the multiplexing level.

Below the title, summary statistics are provided. N is the number of observations for the assay on the plate in question. D is the percent (and count) of low probability calls. I is the percent (and count) of failed calls. The number of assays with a “No Call” result is the sum of D plus I.

A test for fit of the observed genotype frequencies to the expectations under Hardy-Weinberg equilibrium (HWE) is listed at the bottom of each graph. For larger samples, this test provides a useful tool to identify problematic assays. Extreme deviation from Hardy-Weinberg expectations indicates that either particular genotypes have been preferentially sampled (which may occur in many settings) or that one or more genotypes are not being called correctly (e.g., contaminants leading to incorrect heterozygote calls). The HWE statistics provided below the graph are the estimate of disequilibrium (D), the chi square test statistic, and the corresponding p-value.

The tab-delimited Excel file contains one row for each graph presented in the PDF. For each assay within the plate, the Excel file lists some of the summary statistics that are displayed in the PDF.

Plate Definition Report
The Plate Definition report is useful when you want to see what assays and samples are applied to the wells. This report lists the contents of each well.

Plate Result Report
The Plate Result report lists the call for each well.

Primer Adjustment Report
To get optimal results, run the Primer Adjustment report before preparing and processing the hME reaction. This report indicates which primers require volume adjustment. The peaks in the mass spectrum for a multiplexed reaction may not have comparable heights. Variations in peak height may stem from 1) inconsistent oligonucleotide quality, 2) inconsistent oligonucleotide concentration, and 3) different desorption/ionization behavior in MALDI.

The Primer Adjustment report creates an Excel file (.xls) that indicates how to adjust the volume of the primer mixture for each assay in a multiplex. (For information on multiplexing, see the application note Multiplexing the homogeneous MassEXTEND Assay available at www.sequenom.com.)

For all the assays in a well, the one with the highest signal-to-noise ratio (SNR) receives a score of 1. Scores for the other assays in the multiplex are calculated relative to this score. For any assays in the well that fall below 45% (0.45), the primer volume needs to be adjusted. The FRAC_ADD column in the Excel file lists the amount of oligonucleotide to add to the mixture.

Adjusting MassEXTEND Primer Mixes
For best multiplexing results, the concentrations of hME primers should be adjusted to even out peak heights (intensities) in the mass spectrum. This adjustment must be done prior to preparing the hME reaction cocktail and processing the hME reaction.
Note: Adjusting MassEXTEND primer mixes requires the use of a SpectroCHIP® bioarray. Adjusting MassEXTEND primer mixes is critical to successful multiplexing. An assay with a very low primer peak will systematically fail when applied to samples as part of a multiplex.

To adjust MassEXTEND primer mixes

1. For each multiplex, prepare a mixture of the required MassEXTEND primers (referred to as a primer mix). The final concentration of each primer in the primer mix must be 9 µM.

Consider how much primer mix you will need. Each single hME reaction (i.e. a single well in a 384-well microplate) requires 1 µL primer mix.

Note: When ordering MassEXTEND primers from your oligonucleotide supplier it may be useful to consider at what plex-level you will use the primers and ask for the primers to be supplied at a certain concentration. For example, ordering primers for a 12-plex at 108 µM makes preparing primer mixes much easier. You can simply mix equal volumes of each 108 µM primer. Each primer will have a concentration of 9 µM in the final primer mix. Similarly, for a 10-plex, order MassEXTEND primers at 90 µM.

2. Pipette 1 µL of the primer mix into a well of a microplate and add 24 µL nanopure water to obtain a 360 nM dilution of the primer mix (referred to as a primer mix sample).

3. Repeat steps 1 and 2 for each multiplex, to generate a microplate containing primer mix samples for all of the multiplexes.

4. Add 3 mg Clean Resin to each well of the microtiter plate (MTP) using the dimple plate.

Note: Do not add any water. The existing dilutions of the primer mix samples are appropriate.

5. Dispense the primer mix samples to a SpectroCHIP using standard dispensing conditions for hME reaction products.

It is recommended you dispense to two pads per primer mix.

For instructions on operating the Nanodispenser, see the “Dispensing MassEXTEND Reaction Products onto SpectroCHIPs” chapter in MassARRAY Nanodispenser User's Guide.

Note: If the entire SpectroCHIP is not used, you may keep it for future use in adjusting MassEXTEND primer mixes. Use only those pads on the SpectroCHIP that have not been used before; you cannot reuse previously spotted pads. Store SpectroCHIPs—in their original packaging—in a desiccator. SpectroCHIPs may be stored for one week maximum.
6. Acquire spectra from the SpectroCHIP.

For instructions on acquiring spectra, see “Chapter 5 Acquiring Spectra” on page 75.

Use the assay definitions (in Typer) for the actual multiplexes. Each well on the SpectroCHIP will yield no-calls because there is no analyte, only unextended MassEXTEND primers. A peak should appear at the expected mass for each MassEXTEND primer in the mix.

**Note:** At this point, you should “quality-check” the MassEXTEND primers and the primer mixes by reviewing the spectra. There should be a peak at the expected mass of each primer. A missing peak generally indicates poor primer quality or a primer missing from the mix. An unexpected peak generally indicates poor primer quality or the addition of an unnecessary primer to the mix.

7. Now run the Primer Adjustment report to determine if the primer mix should be adjusted.

If all peaks are at least 45% the height of the highest peak, they are acceptable. If any peak is less than 45% the height of the highest peak, add more of that primer. The FRAC_ADD column in the Primer Adjustment report indicates the amount to add (as a fraction of the given primer’s original volume).

**Note:** Adjust the original *primer mix*, not the primer mix sample in the microplate.
Appendix C

Deleting and Changing Database Items

The deletion of MassARRAY database (database) items is of vital importance to two different requirements - first, the requirement to keep the database up-to-date with correct non-redundant data, and second, the requirement to maintain the integrity of the data in the database. These two requirements are sometimes in competition, and the balance can shift depending upon the environment of the user (academic or industrial, research or diagnostic). Our goal is to protect the data completely, but allow the user to correct or eliminate errors that occur during the design phase of particular assays. Different levels of permissions are built into the database schema for change management.

For the purposes of the following discussion, a plate that is described as “having data” means that data has been transferred from the Typer Workstation to a Typer Server, and calls or no-calls have been made on the samples.

The following rules are provided for deleting and editing data; these rules are enforced in the database schema and permissions:

**Ordinary Users**  
**Ordinary Users Can:**  
- Change the name of a Plate or Assay  
- Move a Plate to a different Customer\Project  
- Move an Assay to a different Test  
- Delete samples (only if you are logged in as Typer schema owner)

**Ordinary Users Cannot:**  
- Delete Assays that are used in Plates (workaround - edit the plate to remove the assays first)  
- Edit Assays that are used in Plates that have data (workaround - copy the assay to a new revision of the assay and use it instead)  
- Delete Plates that have data (workaround - copy the plate to a new plate, and move the old plate to a new Customer\Project that is used only for discarded Plates)  
- Edit Plates that have data (workaround - copy the plate to a new plate, and move the old plate to a new Customer\Project that is used only for discarded Plates)
**Database Administrators**

Database administrators are users with SEQ_ADMINISTRATOR privilege. For more information, see the “SpectroTYPER Server System Administration Guide.”

**Database Administrators Can:**
- Delete plates with or without data

**Database Administrators Cannot:**
- Delete Assays that are used in Plates with data, because this would lead to an inconsistent database (to workaround, delete the Plates first, then delete the Assays).
Appendix D

MassARRAY Nanodispenser
Plate-to-SpectroCHIP Mappings

Due to its tip head design, the MassARRAY nanodispenser (nanodispenser) does not directly map sample plate wells to corresponding SpectroCHIP pads (or “wells”). For example, when transferring from a 384-well plate to a 384-well SpectroCHIP, sample from plate well A3 is dispensed onto SpectroCHIP pad A9.

Typer automatically accounts for the way the nanodispenser maps plate wells to SpectroCHIP wells.

However, when manually processing data, you must be careful to correctly match a plate well with a data file from the MassARRAY genotype analyzer. The name of a data file indicates the SpectroCHIP well for which it contains spectral data. Use the following tables to match plate wells to the correct SpectroCHIP well.

The following table shows the 384-well plate to 384-well SpectroCHIP mapping.

<table>
<thead>
<tr>
<th>384-Well Plate to 384-Well SpectroCHIP</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>384 Plate Well</strong></td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>A1</td>
</tr>
<tr>
<td>A2</td>
</tr>
<tr>
<td>A3</td>
</tr>
<tr>
<td>A4</td>
</tr>
<tr>
<td>A5</td>
</tr>
<tr>
<td>A6</td>
</tr>
<tr>
<td>A7</td>
</tr>
<tr>
<td>A8</td>
</tr>
<tr>
<td>A9</td>
</tr>
<tr>
<td>A10</td>
</tr>
<tr>
<td>A11</td>
</tr>
<tr>
<td>A12</td>
</tr>
<tr>
<td>A13</td>
</tr>
<tr>
<td>A14</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>384 Plate Well</th>
<th>384 CHIP Well</th>
</tr>
</thead>
<tbody>
<tr>
<td>A15</td>
<td>A11</td>
</tr>
<tr>
<td>A16</td>
<td>A15</td>
</tr>
<tr>
<td>A17</td>
<td>A19</td>
</tr>
<tr>
<td>A18</td>
<td>A23</td>
</tr>
<tr>
<td>A19</td>
<td>A4</td>
</tr>
<tr>
<td>A20</td>
<td>A8</td>
</tr>
<tr>
<td>A21</td>
<td>A12</td>
</tr>
<tr>
<td>A22</td>
<td>A16</td>
</tr>
<tr>
<td>A23</td>
<td>A20</td>
</tr>
<tr>
<td>A24</td>
<td>A24</td>
</tr>
<tr>
<td>B1</td>
<td>E1</td>
</tr>
<tr>
<td>B2</td>
<td>E5</td>
</tr>
<tr>
<td>B3</td>
<td>E9</td>
</tr>
<tr>
<td>B4</td>
<td>E13</td>
</tr>
<tr>
<td>B5</td>
<td>E17</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>384 Plate Well</th>
<th>384 CHIP Well</th>
</tr>
</thead>
<tbody>
<tr>
<td>B6</td>
<td>E21</td>
</tr>
<tr>
<td>B7</td>
<td>E2</td>
</tr>
<tr>
<td>B8</td>
<td>E6</td>
</tr>
<tr>
<td>B9</td>
<td>E10</td>
</tr>
<tr>
<td>B10</td>
<td>E14</td>
</tr>
<tr>
<td>B11</td>
<td>E18</td>
</tr>
<tr>
<td>B12</td>
<td>E22</td>
</tr>
<tr>
<td>B13</td>
<td>E3</td>
</tr>
<tr>
<td>B14</td>
<td>E7</td>
</tr>
<tr>
<td>B15</td>
<td>E11</td>
</tr>
<tr>
<td>B16</td>
<td>E15</td>
</tr>
<tr>
<td>B17</td>
<td>E19</td>
</tr>
<tr>
<td>B18</td>
<td>E23</td>
</tr>
<tr>
<td>B19</td>
<td>E4</td>
</tr>
<tr>
<td>B20</td>
<td>E8</td>
</tr>
<tr>
<td>384 Plate Well</td>
<td>384 CHIP Well</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>B21</td>
<td>E12</td>
</tr>
<tr>
<td>B22</td>
<td>E16</td>
</tr>
<tr>
<td>B23</td>
<td>E20</td>
</tr>
<tr>
<td>B24</td>
<td>E24</td>
</tr>
<tr>
<td>C1</td>
<td>I1</td>
</tr>
<tr>
<td>C2</td>
<td>I5</td>
</tr>
<tr>
<td>C3</td>
<td>I9</td>
</tr>
<tr>
<td>C4</td>
<td>I13</td>
</tr>
<tr>
<td>C5</td>
<td>I17</td>
</tr>
<tr>
<td>C6</td>
<td>I21</td>
</tr>
<tr>
<td>C7</td>
<td>I2</td>
</tr>
<tr>
<td>C8</td>
<td>I6</td>
</tr>
<tr>
<td>C9</td>
<td>I10</td>
</tr>
<tr>
<td>C10</td>
<td>I14</td>
</tr>
<tr>
<td>C11</td>
<td>I18</td>
</tr>
<tr>
<td>C12</td>
<td>I22</td>
</tr>
<tr>
<td>C13</td>
<td>I3</td>
</tr>
<tr>
<td>C14</td>
<td>I7</td>
</tr>
<tr>
<td>C15</td>
<td>I11</td>
</tr>
<tr>
<td>C16</td>
<td>I15</td>
</tr>
<tr>
<td>C17</td>
<td>I19</td>
</tr>
<tr>
<td>C18</td>
<td>I23</td>
</tr>
<tr>
<td>C19</td>
<td>I4</td>
</tr>
<tr>
<td>C20</td>
<td>I8</td>
</tr>
<tr>
<td>C21</td>
<td>I12</td>
</tr>
<tr>
<td>C22</td>
<td>I16</td>
</tr>
<tr>
<td>C23</td>
<td>I20</td>
</tr>
<tr>
<td>C24</td>
<td>I24</td>
</tr>
<tr>
<td>D1</td>
<td>M1</td>
</tr>
<tr>
<td>D2</td>
<td>M5</td>
</tr>
<tr>
<td>D3</td>
<td>M9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>384 Plate Well</th>
<th>384 CHIP Well</th>
</tr>
</thead>
<tbody>
<tr>
<td>D4</td>
<td>M13</td>
</tr>
<tr>
<td>D5</td>
<td>M17</td>
</tr>
<tr>
<td>D6</td>
<td>M21</td>
</tr>
<tr>
<td>D7</td>
<td>M2</td>
</tr>
<tr>
<td>D8</td>
<td>M6</td>
</tr>
<tr>
<td>D9</td>
<td>M10</td>
</tr>
<tr>
<td>D10</td>
<td>M14</td>
</tr>
<tr>
<td>D11</td>
<td>M18</td>
</tr>
<tr>
<td>D12</td>
<td>M22</td>
</tr>
<tr>
<td>D13</td>
<td>M3</td>
</tr>
<tr>
<td>D14</td>
<td>M7</td>
</tr>
<tr>
<td>D15</td>
<td>M11</td>
</tr>
<tr>
<td>D16</td>
<td>M15</td>
</tr>
<tr>
<td>D17</td>
<td>M19</td>
</tr>
<tr>
<td>D18</td>
<td>M23</td>
</tr>
<tr>
<td>D19</td>
<td>M4</td>
</tr>
<tr>
<td>D20</td>
<td>M8</td>
</tr>
<tr>
<td>D21</td>
<td>M12</td>
</tr>
<tr>
<td>D22</td>
<td>M16</td>
</tr>
<tr>
<td>D23</td>
<td>M20</td>
</tr>
<tr>
<td>D24</td>
<td>M24</td>
</tr>
<tr>
<td>E1</td>
<td>B1</td>
</tr>
<tr>
<td>E2</td>
<td>B5</td>
</tr>
<tr>
<td>E3</td>
<td>B9</td>
</tr>
<tr>
<td>E4</td>
<td>B13</td>
</tr>
<tr>
<td>E5</td>
<td>B17</td>
</tr>
<tr>
<td>E6</td>
<td>B21</td>
</tr>
<tr>
<td>E7</td>
<td>B2</td>
</tr>
<tr>
<td>E8</td>
<td>B6</td>
</tr>
<tr>
<td>E9</td>
<td>B10</td>
</tr>
<tr>
<td>E10</td>
<td>B14</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>384 Plate Well</th>
<th>384 CHIP Well</th>
</tr>
</thead>
<tbody>
<tr>
<td>E11</td>
<td>B18</td>
</tr>
<tr>
<td>E12</td>
<td>B22</td>
</tr>
<tr>
<td>E13</td>
<td>B3</td>
</tr>
<tr>
<td>E14</td>
<td>B7</td>
</tr>
<tr>
<td>E15</td>
<td>B11</td>
</tr>
<tr>
<td>E16</td>
<td>B15</td>
</tr>
<tr>
<td>E17</td>
<td>B19</td>
</tr>
<tr>
<td>E18</td>
<td>B23</td>
</tr>
<tr>
<td>E19</td>
<td>B4</td>
</tr>
<tr>
<td>E20</td>
<td>B8</td>
</tr>
<tr>
<td>E21</td>
<td>B12</td>
</tr>
<tr>
<td>E22</td>
<td>B16</td>
</tr>
<tr>
<td>E23</td>
<td>B20</td>
</tr>
<tr>
<td>E24</td>
<td>B24</td>
</tr>
<tr>
<td>F1</td>
<td>F1</td>
</tr>
<tr>
<td>F2</td>
<td>F5</td>
</tr>
<tr>
<td>F3</td>
<td>F9</td>
</tr>
<tr>
<td>F4</td>
<td>F13</td>
</tr>
<tr>
<td>F5</td>
<td>F17</td>
</tr>
<tr>
<td>F6</td>
<td>F21</td>
</tr>
<tr>
<td>F7</td>
<td>F2</td>
</tr>
<tr>
<td>F8</td>
<td>F6</td>
</tr>
<tr>
<td>F9</td>
<td>F10</td>
</tr>
<tr>
<td>F10</td>
<td>F14</td>
</tr>
<tr>
<td>F11</td>
<td>F18</td>
</tr>
<tr>
<td>F12</td>
<td>F22</td>
</tr>
<tr>
<td>F13</td>
<td>F3</td>
</tr>
<tr>
<td>F14</td>
<td>F7</td>
</tr>
<tr>
<td>F15</td>
<td>F11</td>
</tr>
<tr>
<td>F16</td>
<td>F15</td>
</tr>
<tr>
<td>F17</td>
<td>F19</td>
</tr>
<tr>
<td>384 Plate Well</td>
<td>384 CHIP Well</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>F18</td>
<td>F23</td>
</tr>
<tr>
<td>F19</td>
<td>F4</td>
</tr>
<tr>
<td>F20</td>
<td>F8</td>
</tr>
<tr>
<td>F21</td>
<td>F12</td>
</tr>
<tr>
<td>F22</td>
<td>F16</td>
</tr>
<tr>
<td>F23</td>
<td>F20</td>
</tr>
<tr>
<td>F24</td>
<td>F24</td>
</tr>
<tr>
<td>G1</td>
<td>J1</td>
</tr>
<tr>
<td>G2</td>
<td>J5</td>
</tr>
<tr>
<td>G3</td>
<td>J9</td>
</tr>
<tr>
<td>G4</td>
<td>J13</td>
</tr>
<tr>
<td>G5</td>
<td>J17</td>
</tr>
<tr>
<td>G6</td>
<td>J21</td>
</tr>
<tr>
<td>G7</td>
<td>J2</td>
</tr>
<tr>
<td>G8</td>
<td>J6</td>
</tr>
<tr>
<td>G9</td>
<td>J10</td>
</tr>
<tr>
<td>G10</td>
<td>J14</td>
</tr>
<tr>
<td>G11</td>
<td>J18</td>
</tr>
<tr>
<td>G12</td>
<td>J22</td>
</tr>
<tr>
<td>G13</td>
<td>J3</td>
</tr>
<tr>
<td>G14</td>
<td>J7</td>
</tr>
<tr>
<td>G15</td>
<td>J11</td>
</tr>
<tr>
<td>G16</td>
<td>J15</td>
</tr>
<tr>
<td>G17</td>
<td>J19</td>
</tr>
<tr>
<td>G18</td>
<td>J23</td>
</tr>
<tr>
<td>G19</td>
<td>J4</td>
</tr>
<tr>
<td>G20</td>
<td>J8</td>
</tr>
<tr>
<td>G21</td>
<td>J12</td>
</tr>
<tr>
<td>G22</td>
<td>J16</td>
</tr>
<tr>
<td>G23</td>
<td>J20</td>
</tr>
<tr>
<td>G24</td>
<td>J24</td>
</tr>
<tr>
<td>384 Plate Well</td>
<td>384 CHIP Well</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>J15</td>
<td>G11</td>
</tr>
<tr>
<td>J16</td>
<td>G15</td>
</tr>
<tr>
<td>J17</td>
<td>G19</td>
</tr>
<tr>
<td>J18</td>
<td>G23</td>
</tr>
<tr>
<td>J19</td>
<td>G4</td>
</tr>
<tr>
<td>J20</td>
<td>G8</td>
</tr>
<tr>
<td>J21</td>
<td>G12</td>
</tr>
<tr>
<td>J22</td>
<td>G16</td>
</tr>
<tr>
<td>J23</td>
<td>G20</td>
</tr>
<tr>
<td>J24</td>
<td>G24</td>
</tr>
<tr>
<td>K1</td>
<td>K1</td>
</tr>
<tr>
<td>K2</td>
<td>K5</td>
</tr>
<tr>
<td>K3</td>
<td>K9</td>
</tr>
<tr>
<td>K4</td>
<td>K13</td>
</tr>
<tr>
<td>K5</td>
<td>K17</td>
</tr>
<tr>
<td>K6</td>
<td>K21</td>
</tr>
<tr>
<td>K7</td>
<td>K2</td>
</tr>
<tr>
<td>K8</td>
<td>K6</td>
</tr>
<tr>
<td>K9</td>
<td>K10</td>
</tr>
<tr>
<td>K10</td>
<td>K14</td>
</tr>
<tr>
<td>K11</td>
<td>K18</td>
</tr>
<tr>
<td>K12</td>
<td>K22</td>
</tr>
<tr>
<td>K13</td>
<td>K3</td>
</tr>
<tr>
<td>K14</td>
<td>K7</td>
</tr>
<tr>
<td>K15</td>
<td>K11</td>
</tr>
<tr>
<td>K16</td>
<td>K15</td>
</tr>
<tr>
<td>K17</td>
<td>K19</td>
</tr>
<tr>
<td>K18</td>
<td>K23</td>
</tr>
<tr>
<td>K19</td>
<td>K4</td>
</tr>
<tr>
<td>K20</td>
<td>K8</td>
</tr>
<tr>
<td>K21</td>
<td>K12</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>384 Plate Well</th>
<th>384 CHIP Well</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>O1</td>
</tr>
<tr>
<td>L2</td>
<td>O5</td>
</tr>
<tr>
<td>L3</td>
<td>O9</td>
</tr>
<tr>
<td>L4</td>
<td>O13</td>
</tr>
<tr>
<td>L5</td>
<td>O17</td>
</tr>
<tr>
<td>L6</td>
<td>O21</td>
</tr>
<tr>
<td>L7</td>
<td>O2</td>
</tr>
<tr>
<td>L8</td>
<td>O6</td>
</tr>
<tr>
<td>L9</td>
<td>O10</td>
</tr>
<tr>
<td>L10</td>
<td>O14</td>
</tr>
<tr>
<td>L11</td>
<td>O18</td>
</tr>
<tr>
<td>L12</td>
<td>O22</td>
</tr>
<tr>
<td>L13</td>
<td>O3</td>
</tr>
<tr>
<td>L14</td>
<td>O7</td>
</tr>
<tr>
<td>L15</td>
<td>O11</td>
</tr>
<tr>
<td>L16</td>
<td>O15</td>
</tr>
<tr>
<td>L17</td>
<td>O19</td>
</tr>
<tr>
<td>L18</td>
<td>O23</td>
</tr>
<tr>
<td>L19</td>
<td>O4</td>
</tr>
<tr>
<td>L20</td>
<td>O8</td>
</tr>
<tr>
<td>L21</td>
<td>O12</td>
</tr>
<tr>
<td>L22</td>
<td>O16</td>
</tr>
<tr>
<td>L23</td>
<td>O20</td>
</tr>
<tr>
<td>L24</td>
<td>O24</td>
</tr>
<tr>
<td>M1</td>
<td>D1</td>
</tr>
<tr>
<td>M2</td>
<td>D5</td>
</tr>
<tr>
<td>M3</td>
<td>D9</td>
</tr>
<tr>
<td>M4</td>
<td>D13</td>
</tr>
<tr>
<td>M5</td>
<td>D17</td>
</tr>
<tr>
<td>M6</td>
<td>D21</td>
</tr>
<tr>
<td>M7</td>
<td>D2</td>
</tr>
<tr>
<td>M8</td>
<td>D6</td>
</tr>
<tr>
<td>M9</td>
<td>D10</td>
</tr>
<tr>
<td>M10</td>
<td>D14</td>
</tr>
<tr>
<td>M11</td>
<td>D18</td>
</tr>
<tr>
<td>M12</td>
<td>D22</td>
</tr>
<tr>
<td>M13</td>
<td>D3</td>
</tr>
<tr>
<td>M14</td>
<td>D7</td>
</tr>
<tr>
<td>M15</td>
<td>D11</td>
</tr>
<tr>
<td>M16</td>
<td>D15</td>
</tr>
<tr>
<td>M17</td>
<td>D19</td>
</tr>
<tr>
<td>M18</td>
<td>D23</td>
</tr>
<tr>
<td>M19</td>
<td>D4</td>
</tr>
<tr>
<td>M20</td>
<td>D8</td>
</tr>
<tr>
<td>M21</td>
<td>D12</td>
</tr>
<tr>
<td>M22</td>
<td>D16</td>
</tr>
<tr>
<td>M23</td>
<td>D20</td>
</tr>
<tr>
<td>M24</td>
<td>D24</td>
</tr>
<tr>
<td>N1</td>
<td>H1</td>
</tr>
<tr>
<td>N2</td>
<td>H5</td>
</tr>
<tr>
<td>N3</td>
<td>H9</td>
</tr>
<tr>
<td>N4</td>
<td>H13</td>
</tr>
<tr>
<td>N5</td>
<td>H17</td>
</tr>
<tr>
<td>N6</td>
<td>H21</td>
</tr>
<tr>
<td>N7</td>
<td>H2</td>
</tr>
<tr>
<td>N8</td>
<td>H6</td>
</tr>
<tr>
<td>N9</td>
<td>H10</td>
</tr>
<tr>
<td>N10</td>
<td>H14</td>
</tr>
<tr>
<td>N11</td>
<td>H18</td>
</tr>
<tr>
<td>384 Plate Well</td>
<td>384 CHIP Well</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>N12</td>
<td>H22</td>
</tr>
<tr>
<td>N13</td>
<td>H3</td>
</tr>
<tr>
<td>N14</td>
<td>H7</td>
</tr>
<tr>
<td>N15</td>
<td>H11</td>
</tr>
<tr>
<td>N16</td>
<td>H15</td>
</tr>
<tr>
<td>N17</td>
<td>H19</td>
</tr>
<tr>
<td>N18</td>
<td>H23</td>
</tr>
<tr>
<td>N19</td>
<td>H4</td>
</tr>
<tr>
<td>N20</td>
<td>H8</td>
</tr>
<tr>
<td>N21</td>
<td>H12</td>
</tr>
<tr>
<td>N22</td>
<td>H16</td>
</tr>
<tr>
<td>N23</td>
<td>H20</td>
</tr>
<tr>
<td>N24</td>
<td>H24</td>
</tr>
<tr>
<td>O1</td>
<td>L1</td>
</tr>
<tr>
<td>O2</td>
<td>L5</td>
</tr>
<tr>
<td>O3</td>
<td>L9</td>
</tr>
<tr>
<td>O4</td>
<td>L13</td>
</tr>
<tr>
<td>O5</td>
<td>L17</td>
</tr>
<tr>
<td>O6</td>
<td>L21</td>
</tr>
<tr>
<td>O7</td>
<td>L2</td>
</tr>
<tr>
<td>O8</td>
<td>L6</td>
</tr>
<tr>
<td>O9</td>
<td>L10</td>
</tr>
<tr>
<td>O10</td>
<td>L14</td>
</tr>
<tr>
<td>O11</td>
<td>L18</td>
</tr>
<tr>
<td>O12</td>
<td>L22</td>
</tr>
<tr>
<td>O13</td>
<td>L3</td>
</tr>
<tr>
<td>O14</td>
<td>L7</td>
</tr>
<tr>
<td>O15</td>
<td>L11</td>
</tr>
<tr>
<td>O16</td>
<td>L15</td>
</tr>
<tr>
<td>O17</td>
<td>L19</td>
</tr>
<tr>
<td>O18</td>
<td>L23</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>384 Plate Well</th>
<th>384 CHIP Well</th>
</tr>
</thead>
<tbody>
<tr>
<td>O19</td>
<td>L4</td>
</tr>
<tr>
<td>O20</td>
<td>L8</td>
</tr>
<tr>
<td>O21</td>
<td>L12</td>
</tr>
<tr>
<td>O22</td>
<td>L16</td>
</tr>
<tr>
<td>O23</td>
<td>L20</td>
</tr>
<tr>
<td>O24</td>
<td>L24</td>
</tr>
<tr>
<td>P1</td>
<td>P1</td>
</tr>
<tr>
<td>P2</td>
<td>P5</td>
</tr>
<tr>
<td>P3</td>
<td>P9</td>
</tr>
<tr>
<td>P4</td>
<td>P13</td>
</tr>
<tr>
<td>P5</td>
<td>P17</td>
</tr>
<tr>
<td>P6</td>
<td>P21</td>
</tr>
<tr>
<td>P7</td>
<td>P2</td>
</tr>
<tr>
<td>P8</td>
<td>P6</td>
</tr>
<tr>
<td>P9</td>
<td>P10</td>
</tr>
<tr>
<td>P10</td>
<td>P14</td>
</tr>
<tr>
<td>P11</td>
<td>P18</td>
</tr>
<tr>
<td>P12</td>
<td>P22</td>
</tr>
<tr>
<td>P13</td>
<td>P3</td>
</tr>
<tr>
<td>P14</td>
<td>P7</td>
</tr>
<tr>
<td>P15</td>
<td>P11</td>
</tr>
<tr>
<td>P16</td>
<td>P15</td>
</tr>
<tr>
<td>P17</td>
<td>P19</td>
</tr>
<tr>
<td>P18</td>
<td>P23</td>
</tr>
<tr>
<td>P19</td>
<td>P4</td>
</tr>
<tr>
<td>P20</td>
<td>P8</td>
</tr>
<tr>
<td>P21</td>
<td>P12</td>
</tr>
<tr>
<td>P22</td>
<td>P16</td>
</tr>
<tr>
<td>P23</td>
<td>P20</td>
</tr>
<tr>
<td>P24</td>
<td>P24</td>
</tr>
</tbody>
</table>
Notes:
LIMITED LIABILITY

SEQUENOM shall not be liable, to any extent whatsoever, for any damages resulting from or arising out of the use or performance of this system and related documentation or the procedures specified in this manual, regardless of foreseeability or the form of action, whether in contract, tort (including negligence), breach of warranty, strict liability or otherwise, and including but not limited to, damages resulting from loss of data, loss of anticipated profits, or any special, indirect, incidental or consequential damages. In no event shall SEQUENOM’s liability to the user exceed the amount paid by the user to SEQUENOM hereunder. The USER assumes full responsibility for the results obtained from the use of this system and related documentation and for application of such results. This system is for research use only and is not to be used for diagnostic purposes.

THE USER IS HEREBY PUT ON NOTICE THAT SEQUENOM’S MASSARRAY PRODUCTS AND MassEXTEND™ METHODS AND PROCESSES HAVE NOT BEEN SUBMITTED TO REGULATORY REVIEW OR APPROVED BY THE FEDERAL FOOD AND DRUG ADMINISTRATION OR ANY OTHER UNITED STATES GOVERNMENTAL AGENCY OR ENTITY, AND HAVE NOT BEEN APPROVED FOR CLIA COMPLIANCE, OR OTHERWISE APPROVED UNDER ANY STATUTE, RULE, LAW, OR REGULATION, FOR ANY PURPOSE, RESEARCH, COMMERCIAL, DIAGNOSTIC, OR OTHERWISE.

LIMITED WARRANTY

Limited Warranty Relating to MassARRAY Products. SEQUENOM warrants that the MassARRAY System will be free from defects in materials and workmanship and will conform to SEQUENOM’s current specifications, and perform accordingly, from the time of installation and for a period of one (1) year thereafter, so long as the MassARRAY System remains unchanged and in the original condition supplied by SEQUENOM. SEQUENOM warrants that the MassARRAY Kits will be free from defects in materials and workmanship and will conform to SEQUENOM’s specifications and perform accordingly up to the expiration date specified on the MassARRAY Kit packaging, so long as the MassARRAY Kits are stored according to specifications, and remain unchanged and in the original condition supplied by SEQUENOM. The foregoing warranty does not include periodic maintenance or calibration recommended for some MassARRAY Products. This warranty does not apply to defects resulting from improper or inadequate maintenance or calibration by the USER; defects resulting from hardware, software, interfacing, or supplies provided by parties other than SEQUENOM; defects resulting from unauthorized modification, maintenance, or repair, or improper use or operation outside of SEQUENOM’s specifications for the MassARRAY Products or by personnel not authorized by SEQUENOM, and; defects resulting from abuse, negligence, accident, loss or damage in transit. In addition, this warranty does not apply to damage due to (1) environmental conditions at the site of installation; (2) operator failure to perform standard operating procedures and routine maintenance as prescribed in the operator manuals; (3) moving (by other than SEQUENOM authorized personnel) the MassARRAY System from its installed location; (4) exposure of the MassARRAY Products to Bio-Safety Level 3 or 4 (as defined by the United States Occupational Health and Safety Administration) agents; or (5) exposure to radioactivity.

SEQUENOM’s sole obligation and liability for any breach of the limited warranty set forth herein shall be at SEQUENOM’s sole discretion and option: (1) to replace the MassARRAY Products, in whole or in part, provided that the USER notifies SEQUENOM of the defects, SEQUENOM directs the USER to return the defective MassARRAY Products to SEQUENOM and the USER returns the MassARRAY
Products as directed, at SEQUENOM’s expense; or (2) to repair (and recalibrate as necessitated by repair) the MassARRAY Products in whole or in part. MassARRAY Products may not be returned to SEQUENOM under any circumstances without SEQUENOM's prior authorization. SEQUENOM shall not be liable, to any extent whatsoever, for any damages resulting from or arising out of the use or performance of the MassARRAY Products provided regardless of foreseeability or the form of the cause of action, whether in contract, breach of warranty, tort (including negligence, strict liability, or otherwise), and including but not limited to damages resulting from loss of data, loss of anticipated profits or revenue, or any special, direct, indirect, incidental or consequential damages.

The limited warranty sets forth SEQUENOM’s sole and exclusive responsibility with respect to any alleged breach of this limited warranty. Except as provided herein, the MassARRAY Products are provided without warranty of any kind or nature. SEQUENOM does not warrant, guarantee, or make any representations regarding the use or the results of the use, of the MassARRAY Products in terms of correctness, accuracy, reliability, or otherwise. The USER assumes the entire risk as to the results and performance of the MassARRAY Products. The foregoing warranty is exclusive and is made in lieu of and to the exclusion of any other warranties, whether oral or written, express or implied, direct, indirect, by estoppel or otherwise, or created by the Uniform Commercial Code or the usage in the industry or the course of dealings of the parties, as to any matter whatsoever, including but not limited to those concerning merchantability or fitness for a particular purpose.